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Client Suite
CSM provides multiple clients to access the system.
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CSM Desktop Client
The CSM Desktop Client is the main application in the CSM suite. The Client runs under Microsoft®
Windows®, and provides all the features and default Business Objects/processes for service desk
professionals to effectively and proactively manage their support desks.
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About the CSM Desktop Client
Desktop Client features include:

• Record Logging: Log and manage records (ex: Incident, Problem, Change, Customer, CMDB,
etc.).

• Dashboards and Widgets: Use Dashboards to view critical metrics, analyze and predict trends,
drill-down into data, execute Actions, or just display a hodge-podge of information that might be
relevant to a group of Users/Customers.

• One-Step Actions: Run One-Step Actions to initiate one or more defined Actions, automating
common or repetitive tasks.

• Searching: Run Quick Searches or Saved Searches to efficiently and thoroughly search/filter your
CSM data, locating one record or a set of records.

• Customer: Use the Contact Manager to view and manage Customer records.

• Reporting: Use a host of powerful reporting tools (defined Reports and report writing tools, Search
Groups, Dashboards/Widgets, and Visualizations) to gather and measure data, analyze metrics, and
predict trends.

• Knowledge: Search for Knowledge from configured Knowledge Sources (ex: Knowledge Articles,
records, attachments, web, etc.).

• Additional Features: Approvals, Attachments, Calendars, E-mail, Journals, Tasks, Queues,
Settings, Visualization, etc.
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Log in to the CSM Desktop Client or CSM
Administrator

To log in to the CSM Desktop Client:

1. Double-click the Cherwell Service Management icon  or CSM Administrator icon  on the
desktop, or click Start>All Programs>Cherwell Service Management or Cherwell Administrator.

Note: If the Automatically Use Connection Without Asking check box was previously
selected or if the system administrator already set up a permanent database connection, the
database connection window will not open.

2. Select a database connection:

Note: Typically, Users connect using an Application Server (3-tier connection), identified by

the Application Server icon .

a. Click the All Users tab to view database connections available to All Users or the User tab to
view database connections available to only to the User logging in.

b. Click a database connection.

Note: To create a database connection, click Add to launch the Connection Wizard. To modify
an existing database connection, click the database connection, then click Edit. To delete an
existing database connection, click the database connection, then click Delete.

c. Select the Automatically Use Connection Without Asking check box to automatically use
this database connection each time CSM is launched. Afterward, the prompt is no longer
available to select a connection.

d. Click OK.
3. Provide the CSM login credentials:

a. User ID: Provide the CSM login ID (this could be domain name/network Username or just
Username).

b. Password: Provide the CSM password. Passwords are case-sensitive.

Tip: By default, there is a User ID called CSDAdmin with a password of CSDAdmin in the
Demo and Starter databases.

c. Automatically Login Without Asking: Select this check box to automatically use the above
information at the next log in. This avoids a login prompt.

d. Click OK.

e. If a User is assigned to more than one CSM Role (and have not previously selected the
Automatically Use Selected Role check box), the Choose Role window opens.
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4. Select the login Role for the session:
a. Click the appropriate Role.

b. Always Use Selected Role: Select this check box to automatically use the selected Role at the
next log in. This avoids the Role prompt.
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Tour the CSM Desktop Client
The CSM Desktop Client is personal, dynamic, and highly configurable. Typically, the main window
displays the following items:

• Menu bar

• Search Control

• Toolbar

• Task Pane

• Main Pane

• Knowledge Pane

Each User has a personal interface that is controlled by login Role, security rights, and personal settings.
For example, your default Dashboard (displayed in the Main Pane when you log in or click the Home
button) might display real-time Incidents, Twitter Feeds, or metrics for your Team. Your default Calendar
(displayed when you click the Calendar button) might display your active Tasks. Your Task Pane might
display your Queues or your common operations, such as Reports or One-Step Actions. The toolbars and
panes are dynamic, so they change to accommodate active content. Toolbars and panes are also
configurable, collapsible, and dockable so that you can display what you want and put it where you need
it.

CSM provides a default Desktop Client interface; however, the system administrator typically tailors this to
meet your organization's requirements (ex: The system administrator can configure what to display in the
Task Pane, Knowledge Pane, Search Control, etc.). With security rights, you can also personalize the
interface to meet your personal needs.

The following figure shows two sample main windows:
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1. A sample Dashboard in the Main Pane.

2. A sample Incident record, along with its Arrangement, in the Main Pane. Notice that the Task Pane
and Knowledge Pane can be collapsed to allow more area for the record. Also, notice that the Task
Pane and CSM Desktop Client toolbar change to display information and buttons specific to the
active record.

Related concepts
Log in to the CSM Desktop Client or CSM Administrator
Personalize the Desktop Client User Interface
About the CSM Desktop Client
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CSM Desktop Client Main Window
The CSM Desktop Client Main window is configurable and puts information at your fingertips. You decide
what to display and where to put it. By default, the main window contains the following:

1. Menu bar: Dynamic row of drop-down menus that are used for common operations.

2. Toolbars: Dynamic row of buttons that are used for common operations.

3. Search Control: Search box to find specific words or phrases.

4. Culture selector: Switch cultures to change the language for platform and content strings. Available
only when globalization features are enabled.

5. Task Pane: Highly configurable and dynamic tool used to quickly access operations.

6. Main Pane: Primary interface that displays the Records, Forms, etc. that you are working on.

7. Knowledge Pane: Highly configurable and dynamic tool used to quickly access Knowledge Sources
in your Knowledge Base.
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CSM Desktop Client Menu Bar
Use the CSM Desktop Client menu bar to access common CSM operations.

The CSM Desktop Client menu bar is located at the top of the CSM Desktop Client Main Window.

The Actions menu option is displayed only if it is configured in CSM Administrator.

File Menu

Action Description

New Creates a new record (example: Incident).

Save Saves the active record.

Abandon Abandons changes to the active record.

Delete Deletes the active record.

Print Prints the active pane.

Print Grid Prints the active Grid.

Export Grid

Exports the active Grid to the following formats:

• .csv

• .html

• .txt

• .rtf

• .xml

Send E-mail Creates an email to send.

E-mail Current Customer Creates an email to send to the active Customer.

New Window Launches a new CSM window.

Logout Logs you out of the CSM Desktop Client.

Close Closes the CSM Desktop Client.

Edit Menu

Action Description

Undo Cancels the last operation.

Redo Repeats the last operation.

Cut Moves the selected item to the clipboard, where you can paste the item into a new
location.
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Action Description

Copy Copies the selected item to the clipboard, where you can paste the item to a new
location.

Paste Inserts an item from the clipboard.

Show Legal
Values Displays a list of legal values (for Lookup Fields only).

Refresh Refreshes the active record.

Zoom Zoom the Field into a larger window.

Unlock Releases the lock (unlocks) the active record.

User Locks Opens the Record Locking Manager, where you can view and release any/all
locked records.

View Menu

Action Description

Task Pane
Displays/hides the Task Pane.

For more information, see CSM Desktop Client Task Pane.

Knowledge
Displays/hides the Knowledge Pane.

For more information, see CSM Desktop Client Knowledge Pane.

Navigation (window) Displays the default (Home) Dashboard and navigates back/forward through the
session history.

Record (Navigation) Navigates through the current record set.

Searching Menu

Action Description

Search Manager Opens the Search Manager, where you can run and manage Saved
Searches.

Quick Search Builder Opens the Quick Search window, where you can build a Quick Search.

Edit Current Search Opens the Edit Search window, where you can change the parameters of the
active search.

Save Current Search
As Saves the active search as a saved search that you can use again later.

MRU list
Lists the MRU (Most Recently Used) items.

For more information, see Configure User General Settings.

16

CSM 10.0.0 Client Suite

CSM 10.0.0 Client Suite

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_desktop_client_task_pane
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=knowledge_pane
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=configure_user_general_settings


Action Description

Install PowerBI Data
Connector

Installs the Power BI Data Connector to use with third-party reporting tools.

For more information, see Using Search Data with Third-Party Reporting
Tools.

One-Step Action Menu

Action Description

One-Step Action Manager Opens the One-Step Manager, where you can run and manage One-Step
Actions.

MRU list Lists the most recently used (MRU) One-Step Actions.

Customer Menu

Action Description

Contact Manager Opens the Contact Manager, where you can view and manage Customer Records.

Current Info Displays the current Customer's information.

Config Items
Displays the current Customer's Configuration Items.

For more information, see About the Configuration Management Database (CMDB).

Dashboards Menu

Action Description

Dashboard Manager Opens the Dashboard Manager, where you can view and manage
Dashboards.

Edit <current Dashboard>
Opens the Dashboard Editor, where you can edit the current Dashboard.

For more information, see Dashboard Editor.

Set <current Dashboard>
as default Changes the current Dashboard to be the User default.

Focus on Dashboard Sets focus on the current Dashboard view.

Widget Manager Opens the Widget Manager, where you can manage Widgets.

Metric Manager Opens the Metric Manager, where you can manage Metrics.

Color Palette Manager Opens the Color Palette Manager, where you can manage color palettes.

Heads-up Display
Opens the Heads-Up Display (HUD) in a new window.

For more information, see Heads-Up Display (HUD).
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Action Description

MRU list Lists the most recently used (MRU) Dashboards.

Tools Menu

Action Description

CMDB
Opens the CMDB Interface, where you can manage Configuration Items (CIs).

For more information, see CMDB Interface.

Queues Opens the Queue Manager, where you can manage Queues.

Knowledge

Opens the Knowledge Pane, where you can search configured Knowledge
Sources.

For more information, see CSM Desktop Client Knowledge Pane.

Reports Opens the Report Manager, where you can run and manage Reports.

Calendars Displays the default (Main) Calendar. Also displays an option to open the
Calendar Manager, where you can view and manage Calendars.

Visualizations Displays the default Visualization. Also displays an option to open the
Visualization Manager, where you can view and manage Visualizations.

Attachments Opens the Attachment Manager, where you can view and manage Attachments.

Current Record
Automation
Processes

Displays Automation Processes for the current record.

For more information, see View Automation Processes for a Single Record.

Table Management

Opens the Table Management interface, where you can manage Lookup Table
values.

For more information, see Table Management Interface.

Options

Opens the Options window, where you can configure personal settings (example:
General, Display, Task Pane/Search Control, Dashboard/HUD/Calendar, User
information, and Email).

For more information, see Configure User Settings.

Actions Menu
If configured, an additional Actions menu is available when a record is displayed in the Main Pane
(example: The Incident Actions menu item displays when an Incident is active). The Actions are defined
as part of the Business Object definition in CSM Administrator.

Action Description

Quick Templates Displays a list of available Quick Templates (example: Reset Password).
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Localization Menu

Action Description

Culture Quick Swap (CTRL+W) Switch between the preferred culture and the last
selected culture.

Preferred Culture (CTRL+D) Switch to the preferred culture.

Previous Culture (CTRL+P) Switch to the last culture you selected.

Help Menu

Action Description

Contents Opens the online help.

Reload Definitions Reloads all definitions.

Current Field
Information

Displays properties for the active Field (example: Name, type, description,
search properties, required or not, validation, and Field ID).

Report Error Opens the Report Error window so you can report an error to Cherwell
Software.

System Analyzer Opens the System Analyzer, where you can track behind-the-scenes
operations in a live environment directly from the CSM Desktop Client.

About Display information about CSM (version, copyright, licensing details, and
contact information).
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CSM Desktop Client Quick Search Widget
Use the CSM Desktop Client Quick Search Widget to search records for all Business Objects or records
for a specific Business Object. See Quick Searches Good to Know for additional details about this feature.

The CSM Desktop Client Quick Search Widget is located in the top-right corner of the window.

Table 1. CSM Desktop Client Quick Search Widget Options

Action Description

Choose Items to
Search (drop-down
list)

Drops down so that you can select Quick Search or a specific Business Object
to search:

• Quick Search: Searches all records that contain a specific word or phrase.

• Specific Business Object Search: Only searches records for the selected
Business Object (Example: Incident).

See Quick Search and Quick Search Good to Know for more information.

See Configuring Search Defaults for specific information on enabling/disabling
Business Objects for search.

Quick Search (text
field)

Type or select the search word or phrase. The most recently used searches
appear in a drop list. See Quick Search and Quick Search Good to Know for
more information.

Go (magnifying
glass icon)

Runs the search. Search results are displayed in a Grid (if they are of the same
type) or a List (if they are of different types). By default, the Search Results
display according to their Relevancy ranking, which means the records most
likely to be relevant to your search string display at the top of the results. See
Quick Search Results for more information.

Search Options
(wrench icon)

When searching a specific Business Object, click the wrench icon to define
options to refine the search: Changed, Open records only, Relationships,
Attachments, Sort By, etc.
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Action Description

Changed Limits the search to records that have changed during a specific timeframe.

Open (records)
only

Limits the search to records that have not reached their final state (example: not
closed). If the Business Object does not have a "final" or closed state, this option
does not appear.

Note: The lifecycle and terminology vary depending on the Business Object and
scenario (examples: Unapproved Changes only might appear when searching
Changes, Non-Retired only might appear when searching Knowledge Articles).

Relationships
Includes related Business Objects in the search (example: If the search word
appears in a Journal entry, the Incident to which it is attached will be included in
the search results).

Attachments When selected, the search returns results that match the text within .txt, .doc,
and .xls files and will return any file type with a matching file name.

Sort by

Selects the Business Object field (column) to use to sort the search results. By
default, the Search Results display according to their Relevancy ranking, which
means the records most likely to be relevant to your search string display at the
top of the results.

See Quick Search Results for additional information.

Descending Sort
Order Sorts the results in descending order instead of ascending order.

Search Manager Opens the Search Manager where you can create a Saved Search.

Close Closes the Search options drop-down box.

21

CSM 10.0.0 Client Suite

CSM 10.0.0 Client Suite

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=quick_search_results
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=about_search_groups


CSM Desktop Client Toolbar
Use the CSM Desktop Client toolbar to quickly access common CSM operations. The toolbar is made up
of several smaller toolbars:

• Main toolbar: Displays buttons for performing common CSM operations.

• Navigation toolbar: Displays buttons for navigating between records (ex: Incident, Problem, etc.).

• Action toolbars: Display buttons specific to the type of record displayed in the Main Pane (ex: The
Incident toolbar displays when an Incident is active). These toolbars are created as part of the
Business Object definition in CSM Administrator.

• User toolbars: Display personal toolbars that Users create.

• Arrangement/Relationship toolbars: Display buttons for working with Form Arrangement records
(child records in a relationship with a parent record).

By default, all toolbars are located under the menu bar in the main window; however you can
independently display/hide and move/dock each toolbar so that you can display them when and where
you want. Buttons are dynamic (ex: The Lock button appears only when a record is displayed in the Main
window; the Save button is grayed out until CSM detects that there is content to save, etc.).

The default toolbars contain the following items.

Main Toolbar

Button Action Description

Back/Forward Navigates backward or forward in the content pane sequence.

Home Displays the CSM Home page with the default Dashboard
active.

Calendar Displays the default Calendar.

New Displays item options (you choose the type). The icon on the
button indicates the type of record.

Save Saves changes in the active window.

Abandon Abandons changes to the current item.
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Button Action Description

Lock Record

Unlock Record

Record is
locked by
another User

Locks the active record.

Unlocks the active record.

Record is locked by another User.

Note: This button toggles depending on the current
status of the active record and who has the record
locked. This button appears only if record locking is
enabled and only when a record is active in the CSM
Main Window.

Cut Moves the selected item to the clipboard, so you can then
paste the item into a new location.

Copy
Creates a new item whose properties are the same as the
copied item. The new item can then be named and
customized.

Paste Inserts an item from the clipboard to a new location.

Attach Attaches a file, Web page, image or shortcut. Also, has an
option for displaying/hiding the Attachment Bar.

Show Legal
Values
(Lookup)

Displays a list of legal values (for lookup fields only).

Print Prints the active pane.

Search
Manager

Opens the Search Manager, where you can run and manage
Saved Searches.

Navigation Toolbar

Button Action Description

Show results Displays a set of records meeting a specific criteria.

Show current record Displays the currently selected record.

Go to first record Jumps to the first record in set.

Go to previous record Jumps to the previous record in set.
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Go to next record Jumps to the next record in set.

Go to last record Jumps to the last record in the set.

Action Toolbar

The Action toolbars are created as part of a Business Object definition, vary by Record Type (ex: Incident
is different than Problem), and appear only when a record is open.

Form Arrangement/Relationship Toolbar

The Relationship toolbars are created as part of the Form Arrangement definition, vary by Relationship,
and appear only when a child tab is displayed in an Arrangement. The following figure shows an example
of a Configuration Item (CI) toolbar displayed in an Incident's Arrangement.

Button Action Description

Link Adds/links additional items.

Unlink Unlinks the selected item.

Go To (Quick View) Goes to the source record.

Save Saves changes in the active window.

Quick View Opens the item in a second window so you can take a quick look
at the details.

Go to first record Jumps to the first record in the set.

Go to previous record Jumps to the previous record in the set.

Go to next record Jumps to the next record in the set.

Go to last record Jumps to the last record in the set.

Filter Filter items in the Grid.

Print Prints the active Grid.

Export Export Grid to a file.
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View

Displays items as:

• Form

• Grid

• Split screen (both Form and Grid): horizontal or vertical.
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CSM Desktop Client Task Pane
The CSM Desktop Client Task Pane is highly configurable and is used to quickly access tasks. The tasks
in the Task Pane vary depending on the active item in the Main Pane (ex: If an Incident is active, the tasks
will be Incident-specific).

By default, the Task Pane is located on the left side of the main window; however, you can display it/hide
it, collapse/pin it, and move/dock it so that you can display it when and where you want.

The system administrator initially chooses which items appear by default for each Role; however, if you
have security rights, you can select which items appear on your own Task Pane.
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Table 1. CSM Desktop Client Task Pane Options

• Quick Search: Displays the Quick Search
options.

• Common Tasks: Displays tasks you
frequently do.

• Actions: Displays common actions for the
active record. This area changes based on the
record (Business Object) you are working with.

• Queues: Displays the current record and a list
of specific grouped records.

Note: For more information, refer to
About Queues.

• Process & Terminology: Displays helpful text
for the active record.

• Customer Info: Displays a mini Customer
summary for any active record that allows you
to select a Customer (example: Incident).
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CSM Desktop Client Main Pane
Use the CSM Desktop Client Main Pane to view data and to perform the majority of your CSM operations.
Upon logging in, the Main Pane displays the Home Dashboard.

Depending on the operation, the Main Pane can also display:

• Records: Incident, Problem, Knowledge Article, etc.

• Search Results: Quick Search, Knowledge Search, etc.

• Default Calendar.

• Contact Manager.

• Configuration Management Database (CMDB).

• Table Management.
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CSM Desktop Client Knowledge Pane
Use the CSM Desktop Client Knowledge Pane to quickly access the Knowledge Sources in your
Knowledge Base (example: Knowledge Articles, Business Objects, web, etc.). The available Knowledge
Sources vary depending on which Business Object is displayed in the CSM Main Pane.

By default, the Knowledge Pane is located on the right side of the main window; however you can display/
hide it, collapse/pin it, and move/dock it so that you can display it when and where you want.

When you run a Knowledge Search, the results appear at the bottom of the pane. Results display in order
of Relevancy ranking. This means the records most likely to be relevant to your search string display at
the top of the results by default.

See CSM Desktop Client Knowledge Pane for more information.
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CSM Desktop Client Quick Search
The CSM Desktop Client provides multiple ways to search for information and records. The Quick Search
feature can be viewed in two locations in the main window:

1. Task Pane

2. Quick Search Widget
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Personalize the Desktop Client User Interface
The CSM Desktop Client interface is highly configurable. You can:

• Configure User settings: General, Display, Task Pane/Search Control, Dashboard/HUD/Calendar,
User information, and E-mail.

• Display/hide a toolbar or pane.

• Pin/collapse a pane.

• Move/dock a pane.

• Move/dock a toolbar.

• Create a personal User toolbar.
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Configure User Settings
Global and User settings are initially configured in CSM Administrator. Personal settings/defaults control
how CSM looks and behaves for you, a User. Use the CSM Options window (Tools>Options) to configure
the following User settings:

• User General settings: Restore, Searching, MRU (Most Recently Used), IME (Input Method
Editor), Catalog, and Logging settings.

• User Display settings: Default Theme, and Windows titles, DPI/Scaling, and Multiple Monitor
settings.

• User Task Pane and Search settings: Which default items appear in the Task Pane and which
Search Control is used on the CSM menu bar.

• User Dashboard and Calendar settings: Personal default Dashboard, Heads-Up Display (HUD),
Calendar, and Mobile Dashboard. You can also configure personal Web Proxies for Web Requests
(RSS, Twitter, etc.).

• User Information settings: Personal login credentials, authentication, User Profile information.

• User E-mail settings: Personal e-mail accounts.
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Configure User General Settings
Use the General page in the Options window User options, such as restoring Grids and Prompts to their
default settings, defining the number of MRU (Most Recently Used) Items, and setting logging options.

To configure User General settings:

1. From CSM Desktop Client the menu bar, select Tools>Options.

2. Select the General page.

3. Select the following options as they apply.

Option Description

Restore All Dismissed Message Prompts
Select this check box to restore any previously
dismissed message prompts so that they appear
again.

Restore All Customized Grids to Admin Defaults Select this check box to restore all customized Grids
back to their default definitions.

If Only One Record is Found in a Search,
Automatically Go To That Record

Select this check box to be directed straight to the
only search result, instead of first viewing the single
item in a Grid List.

MRU (Most Recently Used) Items

Use the up and down arrows to increase or
decrease the number of CSM Items that display in
the item's MRU list (in the CSM Desktop Client
menu bar). Ten items display by default.

Use IME Compatible Multi-line Text Controls

Select this check box to allow Input Method Editor
(IME) capabilities so that Users can enter
characters and symbols (example: Chinese,
Japanese, or Korean language symbols) not found
on the input device (example: Keyboard).

Definition Catalog

Select an option for storing primary system
definitions in a local catalog file.

◦ Use System Setting: Select this option to
adhere to the Administrator definitions of
catalog usage.

◦ Use a Local Definition Catalog: Select this
option to ensure the usage of a catalog,
regardless of Administrator definitions.

◦ Don't Use a Local Definition Catalog: Select
this option to ensure a catalog is not used,
regardless of Administrator definitions.

This option is only available if your administrator has
enabled it.

Configure Logging Select the Configure button to open the Logging
options window. See Logging Options.
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4. Select OK.

Related concepts
Configure Global Catalog Settings
Logging Options
Configure Logging to a Splunk Server
Related tasks
Reset to the System Grid Definition

36

CSM 10.0.0 Client Suite

CSM 10.0.0 Client Suite

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=configure_global_catalog_settings
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_logging_options
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=configure_logging_to_a_splunk_server
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=reset_to_the_system_grid_definition


Configure User Display Settings
You can configure display settings specific to the logged-in user. These user display settings override
some global display settings.

To configure user display settings, in the CSM Browser Client select Tools > Options, and in the
Cherwell Service Management Options window select Display.

Make any necessary changes, then select OK to save your configured settings.

Application Skin
To control the appearance of the Desktop Client and CSM Administrator shells, select an application Skin.

Window Titles
To configure window title settings, select the Display connection information check box, then select an
option from the drop-down list. The available window title types are:

• Connection: Displays as <connection name> connection.

• Database: Displays as <database name> database.

• Environment (Production, Development, or Test): Displays as <environment name>
environment.

• Connection and database: Displays as <connection name> connection, <database name>
database.

• Connection and environment: Displays as <connection name>, <environment> name.

• Connection, database, and environment: Displays as <connection name> connection, <database
name> database, <environment name> environment.

If no environment value is selected, the content displays as Unknown environment.

Note: This setting applies to all CSM databases (example: CSM Administrator) on your current
computer.

Multiple Monitors
If you have multiple monitors, you can specify where to open/restore CSM application windows. Not all
Cherwell windows persist their location. For those windows, the standard behavior depends on Microsoft
Windows.

Select the Override system window restore settings check box, then select an option from the drop-
down list:

• Original Monitor
Window opens in the same location on the same monitor where it was last closed.

• Application Main Window Monitor
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Window opens in the same location on the same monitor as the application Main window (the
upper-left of the main application is the control point if the application straddles multiple monitors).

• Mouse Pointer Monitor
Window opens in the same location on the same monitor as the mouse pointer. This option only
differs from the Application Main Window Monitor option when the User uses the keyboard to open
windows in CSM, and the mouse pointer is located on a different monitor from the one where the
application Main window is located. For example, if you have the CSM Main application on monitor
2, but bring up the One-Step Action Manager and drag it to monitor 1, when you edit an existing
One-Step Action, the Manager will appear on monitor 1, even though the main application is still on
monitor 2.

Note: This setting applies to all CSM databases (example: CSM Administrator) on your
current computer. Windows that always open fully on the screen are not governed by these
changes. If a window is too large to physically fit on the monitor, it will be snapped to the left
and/or top edges depending on if it is too big in just one or both dimensions. You might
notice this if you consistently drags windows partially off of the screen and expect them to
open that way the next time.

Accessibility
By default, Forms display with high-contrast colors.

To assists users with accessibility needs, select the Override Business Object form themes with
Windows colors (for high-contrast users) check box.

Windows colors are now used instead of the Form's defined Theme.

Related concepts
Configure Global Display Settings
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Configure User Task Pane and Search Control
Settings

Use the Task Pane and Search page in the CSM Options window to configure which default items appear
in the Task Pane and which Search Control is used on the CSM menu bar.

To configure User Task Pane and Search Control settings:

1. From the menu bar, select Tools>Options.

2. Click the Task Pane and Search page.

3. Configure Task Pane settings:
◦ View or hide sections.

◦ Add new sections.

◦ Configure sections (only applicable to new sections).

◦ Delete sections (only applicable to new sections).

◦ Organize sections.

4. Check or uncheck the corresponding check box to view or hide the following sections in the Task
Pane:

◦ Quick Search

◦ Common Tasks

◦ Actions

◦ Queues

◦ Process and Terminology

◦ Customer Information

5. Add items to the Task Pane (if not using the Default Task Pane Setup):
a. Uncheck Default Task Pane Setup check box.

b. Click Add to open the Task Pane Section window.

c. Specify a name for the Task pane section.

d. Click Add to open the Action Manager.

e. Select the items you want to appear in the Task Pane (example: Calendars).

6. Customize the CSM Search Control in the menu bar Search Options:
◦ Use Default: Use the Default Search Menu Search Widget, which allows Users to run a Quick

Search on multiple Business Objects simultaneously (example: Knowledge Article and Change
Request). Users can also select a Business Object in the drop-down to search one item at a
time (Specific Search).

◦ Use Search Widget: Click the Ellipses button to open the Widget Manager and select an
existing Search Widget or create your own.

◦ No Menu Bar Search: Remove the option to search from the menu bar.
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7. Select OK.
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Configure User Dashboard and Calendar Settings
Use the Dashboards & Calendars page in the CSM Options window to configure the following User
Dashboard and Calendar settings:

• Default Dashboard (Home Dashboard).

• Default Heads Up Display (HUD).

• Default Calendar.

• Default Mobile settings: Configure how Cherwell Mobile looks and behaves on your personal mobile
device.

Note: The Cherwell Mobile applications for iOS and Android were deprecated in March 2019
and are no longer available in their respective application stores. Cherwell Mobile
applications that are already installed should continue to work as expected, however.

• Allow Web Proxies for Web Requests (RSS, Twitter, etc.).

• Clear the local Metric Cache.

To configure User Dashboard and Calendar settings:

1. From the menu bar, select Tools>Options.

2. Click the Dashboards & Calendars page.

3. Select a default Dashboard:
a. Use default: Select this radio button to use the global default Dashboard.

b. Dashboard: Select this radio button to use select your own Dashboard instead of the default
Dashboard.

c. Click the Dashboard button  to open the Dashboard Manager, and then select an existing
Dashboard or create a new Dashboard.

4. Select a default HUD:
a. Use default: Select this radio button to use the global default HUD.

b. Heads-up Display: Select this radio button to select your own HUD instead of the default HUD.

5. Select a default Calendar:
a. Use default: Select this radio button to use the global default Calendar.

b. Calendar: Select this radio button to select your own Calendar instead of the default Calendar.

c. Click the Calendar button  to open the Calendar Manager, and then select an existing
Calendar or create a new Calendar to use as the default.

6. Configure default Mobile Settings:
a. Customize Mobile Settings: Select this check box to override the default Cherwell Mobile

Dashboards configured in CSM Administrator.
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b. Click the Mobile Dashboards button to open the Default Mobile Access Setup window, and
then define how Cherwell Mobile looks and behaves on your personal mobile device.

7. Configure whether or not to allow Web Proxy for RSS, Twitter, and other Web requests:
a. Allow Web Proxy for RSS, Twitter, and Other Web Requests: Select this check box to

receive CSM RSS Feeds.

Note: CSM RSS Feeds allow Customers of an RSS reader to subscribe to CSM data
(such as newly created Incidents) based on a Saved Search or other criteria. Note that
for RSS Feeds to operate, the Cherwell Web Service must be installed. RSS Feeds
are disabled in the Browser Application settings in CSM Administrator.

8. Clear the Local Metric Cache: Click this button to clear all the Metric values that are stored on your
local machine.

9. Select OK.
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Define Personal User Information
Use the User Information page in the CSM Options window to configure User Login Credentials,
Authentication options, and User details.

To configure User Information settings:

1. From the menu bar, select Tools>Options.

2. Click the User Info page.

3. View or change the information for the current User.

4. Select OK.
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Configure User E-mail Settings
Use the E-mail page in the CSM Options window to configure the following User e-mail settings:

• Adding a new e-mail account.

• Editing or copying an existing account.

• Deleting an account.

• Designating an account as the default account for sending e-mails from within CSM.

• Finding dependencies.

To configure User e-mail settings:

1. From the menu bar, select Tools>Options.

2. Click the E-mail page.

3. Configure a personal e-mail account or customize a Global e-mail account:
◦ Add button: Click to configure a new personal e-mail account (POP, IMAP, or Exchange).

◦ Edit button: Click to edit the settings for an existing account.

◦ Delete button: Click to delete an existing account.

◦ Revert: Click to remove your personal settings and revert to the default settings for a global e-
mail account.

◦ Copy: Click to copy the settings for an existing account, and then edit the settings as
necessary.

4. Define e-mail account settings:
a. Define personal POP or IMAP Account settings.

b. Define personal Microsoft Exchange Account settings.

5. Spell check e-mail: Select this check box to have CSM spell-check e-mails before they are sent.

6. Make default account: Makes the selected account the default account for sending e-mails within
CSM.

7. Find dependencies: Displays other CSM Items using the selected e-mail account (example: An E-
mail and Event Monitor).

8. Select OK.

Note: For more information about e-mail accounts and how to use e-mail in CSM, refer to
the E-mail documentation.
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Configure User Cherwell Mobile Settings
Use the Default Mobile Access window (accessed from the Dashboards & Calendars page in the CSM
Desktop Client Options window) to configure how Cherwell Mobile looks and behaves on your personal
mobile device. You can configure which:

• Mobile Home Dashboard to display by default.

• Mobile Alert Dashboard to display by default.

• Business Objects to make available. Associated Saved Searches will also be available.

• Actions/One-Step Actions to make available for each Business Object.

Good to know:

• The Cherwell Mobile applications for iOS and Android were deprecated in March 2019 and are no
longer available in their respective application stores. Cherwell Mobile applications that are already
installed should continue to work as expected, however.

• Users must have Cherwell Mobile security rights to configure User Cherwell Mobile settings.

To configure User Cherwell Mobile settings:

1. From the CSM Desktop Client toolbar, click Tools>Options.

2. Click the Dashboards and Calendars page.
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3. Select the Customize Mobile Settings check box.

Note: If you do not have rights, this check box does not show up in the window. If you clear
this check box, the Cherwell Mobile settings revert to the Global or Role default.
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4. Select default Mobile Dashboards (Home and Alert)

Tip: If you do not want to display any Dashboards, remove the Dashboard item from the List of
Objects to Display on Mobile Device list.

a. Home Page: Select a default Mobile Home Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards.

◦ Click the Mobile Dashboard button  to open the Mobile Dashboard Manager, and
then select an existing Mobile Dashboard or create a new Mobile Dashboard.

b. Alerts Page: Select a default Mobile Alert Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards

◦ Click the Mobile Dashboard button  to open the Mobile Dashboard Manager,and
then select an existing Mobile Alert Dashboard or create a new Mobile Alert Dashboard..

5. Select the Business Objects to make available in Cherwell Mobile:

Note: In order for a Business Object to be available, it must have the Show in Search
Manager property set (in the Business Object properties within a Blueprint).

a. Override List of Objects to Display on Mobile Device: Select this check box to override the
current default list of available Business Objects (Global or Role, set in CSM Administrator).

b. Click Add, and then select the Business Object to make available on mobile devices.
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Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from the list.

c. Define how to display the Business Object in Cherwell Mobile:
◦ Custom Name: Provide a display name to use in Cherwell Mobile. If this is left blank,

the Business Object name will be displayed.

◦ Custom Image:

Select the Image to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

If you do not select an image (None), the default image for the Business Object is
displayed.

Android: Android devices use standard color images. For the best results, use the
images in the BusObs>32x32 folder in the Image Manager. If you are setting up a mobile
configuration for use on both Android™ and iOS® devices, use the iOS-specific images.
They are automatically mapped to equivalent standard images for non-iOS® devices.

d. Select the Actions/One-Step Actions to make available in Cherwell Mobile:
i. Click Add to add a new Action/One-Step Action to the list.
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Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from

the list. Use the Up/Down arrows   to change the order of the Actions/One-Step
Actions when displayed in Cherwell Mobile (ex: In the Actions list).

ii. Define additional options for the list of Actions.
◦ Also Show Default Business Object Actions: Select this check box to make

available any default Actions for the Business Object. This option is only available if
the Business Object has default Actions available (ex: Approvals have built-in
functionality to approve, deny, and abstain).

◦ Also Show Role Actions: Select this check box to make available any Actions that
were configured for the Business Object as part of the User’s default Role settings.
If no defaults were configured for the Role, then Global defaults are used.

6. Configure the order of the Actions when displayed in Cherwell Mobile (ex: On the Actions popup
list):

a. Use the Up/Down arrows to order the Actions.

Note: You can change the order for all custom Actions/One-Step Actions, but you
cannot change the order of the Barcode scan, camera, and Location Awareness
Actions/One-Step Actions.

7. Select OK.

49

CSM 10.0.0 Client Suite

CSM 10.0.0 Client Suite

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=configure_global-role_cherwell_mobile_settings


Display/Hide a Toolbar or Pane
The CSM toolbars and Knowledge Pane can be displayed or hidden.

To display/hide a toolbar or pane:

1. Right-click anywhere on a CSM menu bar, toolbar, or pane.

A drop-down appears, listing the items that can be displayed/hidden. Currently displayed items have
a check next to them.

2. Select an item to display it. Clear a checked item to hide it.

50

CSM 10.0.0 Client Suite

CSM 10.0.0 Client Suite



Pin/Collapse a Pane
The Task Pane and Knowledge pane can be temporarily viewed, or permanently pinned in the CSM Main
window.

To pin/collapse a pane:

• Click the Pin button  in the upper right corner of a pane to collapse it. The pane displays as a tab
on the left side of the CSM Main window.

• Click the tab to temporarily view a collapsed pane. The pane displays until the cursor is removed
from inside the pane.

• Click the horizontal Pin icon  to permanently display the pane.
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Move/Dock a Pane
The Task Pane and Knowledge Pane can be moved anywhere within the CSM Main window or docked to
their default locations.

To move a pane:

1. Click the banner title until a Four-Arrow Plus Sign  appears.

2. Drag the pane to any location in the CSM Main window. After the pane is removed from the original
location, it becomes a small window that can be resized.

The following image shows the Task Pane moved into the Main Pane.

Tip: To dock the pane back to its default location, double-click the banner title.
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Move/Dock a Toolbar

Use the Grab bars  on a CSM toolbar to move, dock, and re-dock a toolbar.

To move a toolbar within the menu bar and toolbar area:

1. There are two ways to move a toolbar:

◦ Double-click the Grab bar  on the left side of the toolbar, and then drag the toolbar to a new
location within the toolbar area.

Note: If the toolbar is moved from the toolbar area, it becomes an independent window that
can be resized.

◦ Click the Grab bar until the Four-Arrow Plus Sign  appears, and then drag the toolbar to
a new location within the toolbar area.

The following figure shows the Navigation toolbar moved to the line below where it was initially
pinned.

2. Let go of the cursor to dock the toolbar.

To move a toolbar outside the menu bar and toolbar area:

1. There are two ways to move a toolbar:

◦ Double-click the Grab bar  on the left side of the toolbar, and then drag the toolbar to a new
location in the CSM window.

Note: If the toolbar is moved from the toolbar area, it becomes an independent window that
can be resized.

◦ Click the Grab bar until the Four-Arrow Plus Sign  appears, and then drag the toolbar to
a new location within the CSM window.

The following figure shows the Navigation toolbar moved to the Main pane.

Tip: Double-click the header banner of an undocked toolbar to re-dock the toolbar back to its
default location.
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Create a User Toolbar
Create one or more personal toolbars (called a User toolbar) to initiate important Actions. For example,
create a User toolbar to:

• Run a One-Step Action.

• Run a command (Zoom, Attach, Undo, etc.).

• Display a Dashboard, Calendar, or Visualization.

• Run a Report or Saved Search.

A User toolbar displays with the other CSM toolbars in the CSM Main window.

To create a User toolbar:

1. Right-click anywhere in the CSM toolbar area, and then select Customize.

The toolbars for User window opens.

2. Click the Add button.

The New Toolbar window opens, listing Actions that are applicable for a toolbar.

3. Click the Add Action button , and then select the type of Action to add to the toolbar (ex: Add
Command Action).

A CSM Item Manager opens (varies by type of Action selected in the previous step) to select/create
the CSM Item to initiate through the Action.

4. Select a CSM Item (ex: a specific Dashboard).

5. Define properties for a new Action:
a. Action: Displays the name of the Action as it is recognized by CSM (ex: Name of the

Dashboard or Report). It is recommended that you do not change this.

b. Display text: Type the text to display on the toolbar button if the "Show text on button check
box" (below) is checked.

c. Image button:

Select the Image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

d. Help text: Type a tooltip to display when the cursor is on the menu item.

e. Begin group: Select this check box to display a horizontal line before the menu item,
separating it from other menu items.

f. Show text on button: Select this check box to display the Display Text on the toolbar button.

6. Add additional actions to the toolbar.
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7. Select OK.
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Keyboard Shortcuts

Key Action

F1 Help

F2 Rename current item

F3 Show the legal values for a Field

F4 Heads Up Display

F5 Refresh

F6 Displays the current User's information

F7 Displays the current User's configuration items

F8 Zooms the current Field (if a large text Field)

F10 Select Menu

CTRL+C Copy current text to the clipboard

CTRL+D Switch to the preferred culture.

CTRL+K Paste the text from the current Field into Knowledge Search pane

CTRL+P Switch to the last culture you selected.

CTRL+S Save the current record

CTRL+T Toggle between form and list views

CTRL+V Paste text from the clipboard

CTRL+W Switch between the preferred culture and the last selected culture.

CTRL+X Cut current text to the clipboard

CTRL+Y Redo last operation that was undone

CTRL+Z Undo last operation

ALT+DOWN ARROW
Drop-down a combo-box

Move down in a list of records

ALT+LEFT ARROW Move back to previous location

ALT+RIGHT ARROW Move forward

ALT+F1–F8 Select tab in the current Form Arrangement
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Key Action

CTRL+F4 Go to Home Page

CTRL+F5
Displays Self-Service settings (Self-Service setup must be configured on your
machine and you must be on a customer type that is set up to be exposed via
Self-Service)

CTRL+SCROLL Zoom in/out in Editors

CTRL+SHIFT+E Email current customer

CTRL+SHIFT+K Paste the text from the current Field into Knowledge Search pane and searches

SHIFT+DRAG Ignore snapping in an Editor

Defined in our database, but can be changed by the User:

CTRL+SHIFT+I New Incident

SHIFT+ALT+C Go to Quick Search for Customer
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CSM Web Applications
CSM includes two web applications: the CSM Browser Client and the Customer Portal.
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Browser Client
The CSM Browser Client is a web application that enables Users to access most of the features available
from the CSM Windows-based Desktop Client using a browser. The CSM Browser Client supports most
major modern browsers on desktop machines and tablets.
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About the CSM Browser Client
CSM Browser Client features include:

• Record Logging: Log and manage records (Incident, Problem, Change, Customer, etc.).

• Searching: Run Quick Searches or Search Groups (saved searches) to efficiently and thoroughly
search/filter CSM data, locating one record or a set of records.

• One-Step Actions: Run One-Step Actions to initiate one or more defined Actions, automating
common or repetitive tasks.

• E-mail: Define and send messages to a single recipient or a group of recipients using
comprehensive e-mail functionality.

• Dashboards and Widgets: Use Dashboards to view critical metrics, analyze and predict trends, drill
down into data, execute Actions, or display a collection of information that might be relevant to a
group of Users/Customers.

• Reporting: Use a host of powerful reporting tools (defined Reports and report writing tools, Saved
Search, Dashboards/Widgets, and Visualizations) to gather and measure data, analyze metrics, and
predict trends.

• Visualizations: View Visualizations to see the relationships between records in a variety of layouts.

• Calendars: View Calendars to keep track of ongoing or upcoming tasks.

• Tools: Access the Contact Manager, Table Management, and CMDB.

• Additional Features: Access HTML Pages, Knowledge Articles, and Queues.
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The main Business Objects available in the Desktop Client are also available in the Browser Client. The
majority of the differences in functionality are in configuring and administrative functions within the
Browser Client. The configurations and settings for the Browser Client are determined in the CSM
Desktop Client and CSM Administrator. Many functions behave differently in the Browser Client than they
do in the Desktop Client. To see the differences in functionality between the Browser Client and the
Desktop Client, see Browser Client Features.

Before Users can access the Browser Client, it must be configured by a system administrator.
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Tour the Browser Client
The Browser Client provides access to CSM through most common web browsers. The main window
displays the following items:

• Account information

• Menu bar

• Toolbar

• Main Pane

• Search Control

Each User has a personal interface that is controlled by login Role and security rights. For example, the
default Dashboard (displayed in the main pane upon log in or by clicking the Home button) might display
real-time Incidents, Twitter Feeds, or metrics for a Team.

The Browser Client menu bar collapses into a hamburger menu on mobile screens and browser windows
sized below 768 pixels. It cannot be configured, but the CSM Items accessed from the menu bar are
driven by configurations and personal settings in the Desktop Client. For example, a Saved Search can
be created and saved in the Desktop Client and then used in the Browser Client by using the Browser
Client Managers.

Note: The Navigation toolbar opens when a record is active in the main pane.

Related concepts
About the CSM Browser Client
Using the Browser Client
Log in to the Browser Client
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Browser Client Main Window
The Browser Client main window is simplified compared to the dynamic capabilities of the CSM Desktop
Client, but the look-and-feel is similar.

1. Account Information: Displays login and User/company information.

2. Menu bar: Displays drop-down menus for features and functions within the Browser Client. The
Browser Client menu bar collapses into a hamburger menu on mobile screens and browser windows
sized below 768 pixels.

3. Search Control: Allows Users to run Quick Searches and specific record Searches.

4. Toolbar: Displays available actions and operations within the main pane and within records.

5. Main pane: Displays Dashboards, records, Reports, and Search Results.

Browser Client Item Managers are opened from the menu bar. To open a Manager, click the desired
menu (example: Dashboards) and then select [Item] Manager.
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Browser Client Account Information
Options in the Browser Client account information section are described below.

Table 1. User Information

Action Description

Languages Allows Users to switch cultures to change the language for platform
and content strings.

New Browser Window Opens the page in a new browser window.

My Profile
Allows Users to view their personal information (Contact information,
manager information, etc.). The form is populated using information
from the User Profile.

Logout Logs the User out of the current session.

Table 2. Help Icon / Company Information

Action Description

Help Icon Allows Users to access a defined Help System/site. For information on
configuring a Help site, see Configure Global Help Settings.

Report Error

Allows Users to submit information about an error they receive while
working in Cherwell Service Management to the Cherwell Software
Support Team. If desired, configure a custom e-mail address in Global
System Settings (CSM Administrator > Settings > Edit System
Settings > Help Settings).

(719) 386-7000
Cherwell Software company phone number. If desired, configure a
custom phone number in Global System Settings (CSM Administrator
> Settings > Edit System Settings > Help Settings).

<Version Number> Current version of Cherwell Service Management.

<Environment Type> Environment Current system environment (Development, Production, or Test). If an
environment is not selected, the text does not display.

Cherwell Copyright Cherwell Service Management copyright information.
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Browser Client Menu Bar
Options in the Browser Client menu bar are described below.

Table 1. Home

Action Description

Home Opens the default home Dashboard.

Table 2. New

Action Description

New Creates a new record (example: New Config - Mobile Device).

Table 3. Searches

Action Description

Search Manager Opens the Search Manager, where you can run Saved Searches.

Quick Search Builder Opens the Quick Search Builder, where you can create a Quick
Search.

Queues Opens the Queues menu, including the Queue Manager and Most
Recently Used (MRU) Queues.

Table 4. One-Steps

Action Description

One-Step Manager Opens the One-Step Action Manager, where you can run One-Step
Actions.

Recent Unassociated One-Steps Runs the Most Recently Used (MRU) One-Step Actions.

Table 5. E-mail

Action Description

Send E-mail

Opens the E-mail Message window to create and send e-mails directly
from the CSM Browser Client.

Note: An e-mail account must first be set up and given
security rights in order to send an e-mail. See Send an E-mail
from Within CSM.

E-mail Current Customer

Opens the E-mail Message window to create and send e-mails to a
Customer's e-mail address from your current page (An Incident record,
Problem record, etc.). The To line is automatically populated with this
address, and an error will open if there is no active Customer on the
record.
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Table 6. Dashboards

Action Description

Home Directs you back to the default Home Dashboard.

Dashboard Manager Opens the Dashboard Manager, where you can view Dashboards.

MRU Lists the Most Recently Used (MRU) Dashboards.

Table 7. Pages

Action Description

Pages Manager Opens the HTML Page Manager, where you can view HTML Pages.

MRU Lists the Most Recently Used (MRU) Pages.

Table 8. Reports

Action Description

Report Manager Opens the Report Manager, where you can run Reports.

MRU Lists the Most Recently Used (MRU) Reports.

Table 9. Visualizations

Action Description

Visualization Manager Opens the Visualization Manager, where you can run Visualizations.

Config Visualization Opens the Configuration Map Visualization.

MRU Lists the Most Recently Used (MRU) Visualizations.

Table 10. Calendars

Action Description

Calendar Manager Opens the Calendar Manager, where you can run Calendars.

Main Calendar

Opens the Main Calendar.

Note: This is configured in CSM Administrator. For more
information, refer to the Calendars documentation.

MRU Lists the Most Recently Used (MRU) Calendars.

Table 11. Tools

Action Description

Contact Manager Opens the Contact Manager, where you can view and manage
Customer Records.

Table Management Opens the Table Management interface, where you can manage
Lookup Table values.
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Action Description

CMDB Opens the CMDB interface, where you can manage Configuration
Items (CIs).

Note: The Browser Client menu bar collapses into a hamburger menu on mobile screens and
browser windows sized below 768 pixels.
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CSM Browser Client Quick Search Widget
Use the CSM Browser Client Quick Search Widget to search records for all Business Objects or records
for a specific Business Object. See Quick Searches Good to Know for additional details about this feature.

The CSM Browser Client Quick Search Widget is located in the top-right corner of the window.

Table 1. CSM Browser Client Quick Search Widget Options

Item Description

Quick Search (drop-down list)

Drops down so that you can select Quick Search or a specific Business
Object to search:

• Quick Search: Searches all records that contain a specific word or
phrase.

• Specific Business Object Search: Only searches records for the
selected Business Object (Example: Incident).

See Quick Search and Quick Search Good to Know for more information.

See Configuring Search Defaults for specific information on enabling/
disabling Business Objects for search.

Quick Search (text field)
Type or select the search word or phrase. The most recently used
searches appear in a drop list. See Quick Search and Quick Search
Good to Know for more information.

Go (magnifying glass icon)

Runs the search. Search results are displayed in a Grid (if they are of the
same type) or a List (if they are of different types). By default, the Search
Results display according to their Relevancy ranking, which means the
records most likely to be relevant to your search string display at the top
of the results. See Quick Search Results for more information.

Search Options (wrench icon)
When searching a specific Business Object, click the wrench icon to
define options to refine the search: Changed, Open records only,
Relationships, Attachments, Sort By, etc.

Changed
Limits the search to records that have changed during a specific
timeframe.

Open (records) only

Limits the search to records that have not reached their final state
(example: not closed). If the Business Object does not have a "final" or
closed state, this option does not appear.

Note: The lifecycle and terminology vary depending on the Business
Object and scenario (examples: Unapproved Changes only might
appear when searching Changes, Non-Retired only might appear when
searching Knowledge Articles).
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Item Description

Search Related Items
Includes related Business Objects in the search (example: If the search
word appears in a Journal entry, the Incident to which it is attached will be
included in the search results).

Search Attachments
When selected, the search returns results that match the text
within .txt, .doc, and .xls files and will return any file type with a matching
file name.

Sort by

Selects the Business Object field (column) to use to sort the search
results. By default, the Search Results display according to their
Relevancy ranking, which means the records most likely to be relevant to
your search string display at the top of the results.
See Quick Search Results for additional information.

Ascending/Descending Sorts the results in descending order instead of ascending order.

Search Manager Opens the Search Manager where you can create a Saved Search.
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Browser Client Toolbars
The Browser Client toolbars include the Dashboard Theme Toolbar and the Record Toolbar.

Dashboard Theme Toolbar
The Dashboard Theme Toolbar allows you to select a Dashboard Theme and refresh the current
Dashboard.

Button Action Description

Select a Theme Applies a new Theme to the current
Dashboard.

Refresh the Dashboard Refreshes the current Dashboard.

Record Toolbar
The Record Toolbar provides all of the actions you may want to perform when viewing records.

Action Description

Save Saves changes in the active window.

Cancel Cancels changes to the current record.

Refresh Refreshes the data for the current record.

Delete Deletes the current record.

Legal values Displays a list of legal values (for lookup fields only).

Unlocked
Locked by [user]

The record is unlocked.
The record is locked by [user].

Attach Attach (Import) Files to a Record.

Go to first record Navigate to the first record.

Go to previous record Navigate to the previous record.

Go to next record Navigate to the next record.

Go to last record Navigate to the last record.
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Action Description

Not queued
Add to queue

On [queue]

Check out

Check in

Remove from queue

The current record is not in a queue.
Add the current record to a queue.

The current record is added to [queue].

Check the current record out of the queue.

Check the current record back into the queue.

Remove the current record from the queue.

Current record View the current record.

List View records in a list.

Grid View records in a grid.

71

CSM 10.0.0 Client Suite

CSM 10.0.0 Client Suite



Browser Client Main Pane
The CSM Browser Client main pane is located in the center of the main window and displays content
relevant to the current operation. When you log in, the main pane displays the Home Dashboard.
Depending on the operation, the main pane can also display the following:

• Records (Incident, Problem, Knowledge Article, etc.).

• Search Results (Quick Search, Knowledge Article Search, etc.).

• Reports, Calendars, Visualizations, Grids, and more.
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Browser Client Managers
CSM Item Managers help manage CSM items (Dashboards, Saved Searches, One-Step Actions, etc.). In
the Browser Client Managers, Users can:

• Run/Display: Runs/displays the selected item (example: Run a Saved Search, One-Step™ Action,
or Report; display a Dashboard).

• Filter (Association or Status): Filters items by record type (Incident, Problem, Change, etc.) or Status
(for the Queue Manager).

Note: Filtering by record type is only available in the Saved Search, One-Step™ Action,
Dashboard, and Report Managers.

• View: View a list of available items in either List view or Icon view.

• Search: Searches the Item Manager for the provided word or phrase. Use the drop-down list for
recent searches. Clear the search by clicking on any tab under the Item's Home.

To open Managers in the CSM Browser Client:

1. From the Browser Client menu bar, click the desired menu (example: Dashboards), and then click
the [Item] Manager.

Rather than utilizing the folder structure of the CSM Desktop Client and Administrator Managers, Browser
Client Managers use tabs to navigate the areas where CSM items are located within the Manager. The
tabs correspond to folders in the Desktop Client and contain the same CSM items. Clicking a tab takes
you to the items located in that file. Clicking an Item's Home takes you to the base file structure (example:
Dashboards>Pinboard, User, Role, Team, Global).
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CSM Client Feature Parities and Differences
Learn about the feature parities and differences between CSM Desktop Client and CSM Browser Client.

Features CSM Desktop Client CSM Browser Client Differences

Actions Yes Partial In CSM Browser Client, run only.

Attachments Yes Extended

In CSM Browser Client, users can
download multiple attachments at
once and use drag-and-drop to add
attachments to records. The
Attachments tab of the Related Items
pane is only available in the Browser
Client.

Automation
Processes Yes Partial

Run based on conditions met in any
client. Ability to view Automation
Processes for a current record
available in CSM Desktop Client.

Business Hours Yes Partial In CSM Browser Client, view only.

Business Object
records Yes Yes View, create, edit, and delete

Business Object records.

Calendars Yes Partial In CSM Browser Client, view only; in
separate tab (not Tools).

Contact
Manager Yes Partial In CSM Browser Client, view and

export only.

Counters Yes Partial In CSM Browser Client, view only.

Dashboards Yes Partial In CSM Browser Client, view only.

Email Yes Yes

In CSM Browser Client, see Related
Items Email, send e-mail, and with
attachments. Configuration must be
done in CSM Administrator.

Expressions Yes Partial In CSM Browser Client, view only.

Forms Yes Yes

Grids Yes Yes
In CSM Browser Client, Actions,
columns, and export found in toolbar
instead of context menus.

HTML Pages Yes Partial In CSM Browser Client, view only.

Journals Yes Yes

Knowledge Yes Yes

Metrics Yes Partial In CSM Browser Client, view only.

One-Step
Actions Yes Partial In CSM Browser Client, run only.
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Features CSM Desktop Client CSM Browser Client Differences

Prompts Yes Partial In CSM Browser Client, run only.

Queues Yes Partial
In CSM Browser Client, view only;
Queue Manager in Searches (not
Tools).

Record Locking Yes Yes  

Related Items
• Chat

• Communication

• Attachments

• Chat

• Communication

• Solution Search

In CSM Desktop Client, Chat and
Communication only.

Reports Yes Partial In CSM Browser Client, run only; in
separate tab (not Tools).

Rich Text Yes Yes  

Searching Yes Yes

System
Analyzer Yes No In CSM Browser Client, not currently

supported.

Table
Management Yes Partial In CSM Browser Client, view and

export only.

Task Pane Yes Alternative
In CSM Browser Client, use Related
Items Solution Search for similar
search functionality.

Toolbars Yes Partial

In CSM Browser Client, no ability to
create a custom toolbar or use the
toolbar created in CSM Desktop
Client.

Visualizations Yes Partial In CSM Browser Client, view only.

Widgets Yes Partial

In CSM Browser Client, view and drill-
down only.

Note: Actions on Twitter
widgets are not supported in
the CSM Browser Client.
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Browser Client Forms
Forms are supported in the CSM Browser Client. In addition to records, forms contain a Form
Arrangement area (as they do in the CSM Desktop Client). The Form Arrangement contains child objects
and supporting tabs (Journal, Queues, Tasks, etc.). Use form splitters and the Text Editor to enhance the
way you work with forms.

Using forms in the Browser Client, you can:

• View existing records.

• Log a record.

• View child objects for records in the Form Arrangement.

Forms are accessed using the New drop-down on the Browser Client menu bar to log a new record or by
drilling down into a Widget and then opening an existing record via a Grid.
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Form Splitters
In the Browser Client and Portal, Forms contain splitters that help Users resize the Form Arrangement
using both horizontal and vertical splitters.

Good to know:

• In an open record, the horizontal splitter above the Form Arrangement (child object tabs) adjusts the
overall height of the Form Arrangement. The vertical splitter in the middle of the Form Arrangement
adjusts the overall width of the Form Arrangement if the tab features more than one section.

• Adjust the Form Arrangement by clicking anywhere on the splitters except for the Show/Hide Form
Arrangement arrows and the Show/Hide Child Object Details arrows.

• The splitter location defaults to the setting for that Form, as defined in the Business Object Form
Arrangement Editor. After adjusting the splitter location, the new location will be saved and used for
that Business Object until the browser tab or window closes. After opening the site and logging in
again, the splitter location will default back to the placement settings for the Form for that Business
Object. This setting does not persist across browsers.

There are several buttons and icons featured in the Form splitters.

Button/Icon Action Description

Or Show or Hide Form
Arrangement

Shows a currently hidden Form Arrangement or hides a
currently visible Form Arrangement.

Or
Separators Indicates that the splitter bars can be dragged-and-dropped

where needed.

Or Show or Hide Child
Object Details

Shows the child object, including details or additional Forms,
or hides the child object details or additional Forms so only
the child object Grid is visible.

To show or hide the Form Arrangement:
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• Click the Show Form Arrangement arrows to show a currently hidden Form Arrangement.

To expand the Form Arrangement so that it fills the full area of the record, click the Show Form
Arrangement arrows a second time.

• Click the Hide Form Arrangement arrows to hide a currently displayed Form Arrangement.

To hide the Form Arrangement after expanding it to fill the entire area of the record, click the Hide
Form Arrangement arrows twice: once to return the Form Arrangement to its original size, and then
again to hide it completely.

To adjust the overall height of the Form Arrangement:

• Click and hold the horizontal splitter above the Form Arrangement and then move the horizontal
splitter up or down until the Form Arrangement is the desired height.

To show or hide a child object's details or additional Forms:

• Click the Show Child Object Details arrows to show both the child object (example: Task) and its
additional details or Forms (example: Task form).

To expand the child object's additional details or Forms on the right-hand side of the Form
Arrangement space, click the Show Child Object Details arrows a second time.

• Click the Hide Child Object Details arrows to hide the additional details or Forms.

To hide the additional details or Forms after expanding them to fill the entire area of the Form
Arrangement, click the Hide Child Object Details arrows twice: once to return it to its original size,
and then again to hide it completely and only display the child object's Grid.

To adjust the overall width of the child objects and their details or additional forms:

• Click and hold the vertical splitter in the middle of the Form Arrangement and then move the
vertical splitter left or right until the child object and its details are the desired width.

79

CSM 10.0.0 Client Suite

CSM 10.0.0 Client Suite



Browser Client Text Editors
The Browser Client offers comprehensive plain text and Rich Text editor functionality.

The Rich Text Editor provides the following features:

• Text formatting: Create content using text formatting (font, size, text color, and background color),
list styling, and paragraph styling.

• Image upload: Upload a related image to provide additional context. Rich Text supports drag-and-
drop image functionality (including a thumbnail preview), image sizing (small, medium, large, or full),
and view options (zoom in on an individual image or open the image in a new browser tab).

• Hyperlink usage: Insert a web page link to provide supplementary information. You can also add
display text and a tool tip, if necessary.

Open the Rich Text Editor by clicking the Text Editor button  in the upper right corner of a supported
field (example: Incident Description field).
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Browser Client Grids
Grids in the CSM Browser Client and CSM Portal look very similar to CSM Desktop Client Grids, except
that Export, Run Action, and Add/Remove Grid column options are available on a Grid toolbar rather than
from a context menu or menu bar. Grid grouping is not currently available.

View a Grid using one of the following features:

• Search Results: List of records located through a Quick Search or Search Group.

• Search Results List Widget: List of results on a Dashboard.

• Form Arrangement: List of related records on a tab.

• Contact Manager: List of Customer Records.

• CMDB interface: List of Configuration Item records.

• Table Management interface: List of Lookup values.

• CSM Item Managers: List of CSM Items (example: List of Dashboards in the Dashboard Manager).

• Creating/editing a Business Object Grid (in CSM Administrator).

1. Grid menu bar: Displays actions available for the Grid, including navigation, Actions, export,
number of items selected, and available columns.

2. Title: Displays the title of the Grid. This might or might not match the name of the Business Object
that the Grid represents. Also, a Business Object might have multiple Grids, so each might have its
own name.

3. Sort icon: Arrow indicates the column currently sorting the Grid and if it is in ascending or
descending order. Select the icon to toggle sorting. By default, the Browser Client sorts Grids using
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single-column sorting. To sort the Grid using multiple columns, click the Multi-column sort button in
the Grid menu bar. If you need to resize a column, use the sizing handles to drag the column to the
width you want.

4. Filter icon: Indicates the column data can be filtered. Select the icon to show filtering options
(possible filter values appear in the column's Filter list).

5. Grid item: Each item within a Grid contains its own line of information. Clicking the item opens the
record in the main pane.

6. Selection check boxes: Check boxes allow you to select mulitple items for exporting records or
running One-Step Actions.

There are several actions available when working with Grids in the Browser Client:

Note: The Actions menu is disabled when more than one item is selected in a Search Results
Grid.

Grid
Capability Description

Export

Export a Grid to use CSM data in other applications for reporting or display purposes.
For example, export a list of Customers to a .csv file so you can use a spreadsheet tool
to manage a mass mail communication. You can export to CSV (.csv) and Excel (.xlsx)
formats.

Run an
Action

Run a defined Business Object context menu Action directly from a Business Object
Grid (record Grid) to quickly initiate common operations. Context Menu Actions are
defined as part of a Business Object's definition.

Sort

Sort a Grid in alphabetical or numerical order, in ascending (1-10 or A-Z) or descending
order (10-1 or Z-A).

Grids in the Browser Client can also be sorted using single-column sorting (the default
setting for Browser Client Grids) or multi-column sorting, allowing Users to sort the Grid
using multiple columns at a time.

Filter

Filter a Grid by a column value so that the Grid shows only the data you want (example:
Show only New Incidents). To show even more specific data, multi-filter a Grid, either
by using multiple values in a single column (example: Show Incidents with a status of
Assigned, In Progress, or Pending) or by using multiple column values (example: Filter
by owner, and then by status).

Size Size a Grid column to a specific width to see as much or as little data as you want.

Move/reorder Rearrange a Grid by moving (reordering) a Grid column to a different location in a Grid.

Add/remove
columns

Business Object Grids are created and managed by a system administrator in CSM
Administrator; however, you can add and remove columns (Fields) from your instance
of the Grid to display only Fields that are important to you (example: Add the Owned By
field to the Incident grid to view record owners). If configured, you can also add Fields
from other Business Object.
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Related concepts
Browser Client Grid Functions
Define Business Object Actions
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Browser Client Grid Functions
When working with CSM Browser Client Grids, you can perform several actions, including viewing and
filtering a Grid, running an Action from a Grid, and adding or removing columns from a Grid.

When working with Browser Client Grids, you can:

• View a Grid

• Filter a Grid

• Group a Grid

• Run an Action from a Grid

• Add/Remove a Grid column

Good to know:

• Exportable Fields are organized by category; uncategorized Fields are listed at the top, and are
likely listed in the menu. Relationships Fields are listed below the Relationship node (example:
Incident Links Problem Fields).

• Grids are limited to 100,000 rows of data in the Browser Client.

• If a column has a filter applied to it, the Filter icon displays a highlighted square around it to indicate
that a filter has been applied.

• Grid changes are remembered until the Grid is reset in the CSM Desktop Client or CSM
Administrator, the settings are cleared (Tools > Options > General > Restore all Customized
Grids to the Admin Defaults, or File > Clear Settings in the Role or User Manager, or a new
System Grid definition is automatically pushed out. If a new System Grid definition is pushed out, a
Personal Grid definition can be reverted manually, but the changes in the new definition are lost.

To view a Grid:

1. A Grid can be viewed several ways:
◦ Search Results: List of records located through a Quick Search or Saved Search.

◦ Search Results List Widget: List of results on a Dashboard.

◦ Form Arrangement: List of related records on a tab.

◦ Contact Manager: List of Customer records.

◦ CMDB interface: List of Configuration Item records.

◦ Table Management interface: List of Lookup values.

◦ CSM Item Managers: List of CSM Items (example: List of Dashboards in the Dashboard
Manager).

To run an Action from a Grid in the Browser Client or CSM Customer Portal:
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Note: The Actions menu is disabled when more than one item is selected in a Search
Results Grid.

1. In a Grid, select a record by selecting the radio button or check box next to the row.

2. In the Actions list, select an Action (example: Print).

3. In the Actions menu, select an Action (example: Print).

To filter a Grid in the Browser Client or Customer Portal:

1. In a Grid, select the Filter icon in the header of the column to filter.

2. Select the Filter box to open the menu.

The menu shows filtering options. Options vary according to the type of data in the column
(example: Number, Text, etc.).

3. Select a filtering option.

4. Select Filter.
5. To continue filtering by another column, select the Filter icon over another column, and select

another filtering option.

The Grid filters the data again and displays the filtered results.

To clear the filtering criteria, select the Filter icon on the filtered column, and then select Clear in the
Filter menu.

Related concepts
About Grids
Grid Persistence
Revert to a Personal Grid Definition
Group a Grid
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CSM Browser Client Searches
The Searches option in the CSM Browser Client main menu behaves very similarly to those in the CSM
Desktop Client.

These search behaviors include:

• Searches edited or saved in the CSM Browser Client carry over to the CSM Desktop Client.
Depending on Role and the scope (folder) of the Search, others may be able to see and use created
Searches (example: If you create an All Tasks Search and save it to the Team folder, only members
of your Team will have access the Search).

• Use the Search Manager to create, edit, and delete Saved Searches or use the Quick Search
Builder to create and run a one-time Search. Both are accessed via the Searches drop-down on the
menu bar.

• The Search Manager behaves differently in the CSM Browser Client than it does in the CSM
Desktop Client. For more information, see Browser Client Managers.

• Queues can be run from the Queue Manager in the CSM Browser Client, but cannot be created,
edited, or deleted. The Queue Manager and MRU Queues are accessed via the Search drop-down
on the menu bar.

To run a Search:

1. From the CSM Browser Client main menu (for more information, see Browser Client Menu Bar),
select the Searches drop-down menu.

2. Select an option from the drop-down menu:
◦ Search Manager: Create and/or run a defined Search.

◦ Quick Search Builder: Create and run a Quick Search.

◦ Queues: Select and run a Queue from the Queue Manager.

◦ Download Power BI Data Connector: Download the Power BI Data Connector to use with
third-party reporting tools. For more information, see Using Search Data with Third-Party
Reporting Tools.

The results display in the Main Pane.

If card view is enabled for a Business Object, Search results are displayed as medium or large
cards. To view a specific record in card view, select an item from the results list or the title link in a
card.

In card view, you can access:
◦ Navigation: Use page numbers and arrow buttons that allow you to navigate between pages of

results.

◦ Side menu: Access options, such as showing the currently selected record or showing results
in a Grid view, sorting results by a Field in ascending or descending order, and changing card
size.
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Note: To ensure that card size selections persist and do not revert to the default,
uninstall WebDAV in IIS.

3. Ellipses: Access a menu of actions available for the Business Object. Actions can be run directly
from the card view without drilling down into a record.

When viewing the Search results, more options become available in the Search menu drop-down that
allow Users to edit the current Search and save the current Search.

Related concepts
About Roles
Scope
Browser Client Quick Search Builder
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Browser Client Quick Search Builder
The Browser Client Quick Search Builder is very similar in behavior to that of the Desktop Client Quick
Search Builder.

Searches saved in the Browser Client carry over to the Desktop Client. Depending on Role and the scope
of the search, others might be able to see and use created Searches (example: If you create an All Tasks
Search and save it to the Team folder, members of your Team will be able to access the All Tasks
Search).
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Browser Client Queues
Access Queues from the Queues drop-down in the Searches menu or work with Queues from the
Business Object toolbar. Queues cannot be created or edited in the Browser Client and they can only be
viewed with the proper security rights and Role defined in CSM Administrator.

To open a Queue:

1. Click Queues in the Searches drop-down.

2. To find a Queue that is not listed in the Queues MRU menu, click Queue Manager.

Note: The Queue Manager behaves differently in the Browser Client than in the Desktop
Client. See Browser Client Managers for more information.

Queue results appear in the same list format as other Browser Search results.

To work with Queues:

1. Open a Business Object record.

2. On the Business Object toolbar, click the Queue drop-down.

If the record is not currently in a Queue, the only enabled button in the Queue Status drop-down is
Add to Queue.

3. Add a record to a Queue:
a. In the Queue drop-down, click Add to Queue.

b. From the Queue Manager, select a Queue (ex: Network Support).

The name of the Queue displays in the Queues section of the toolbar.

4. Check out/check in a record from the Queue:
a. In the Queue drop-down, click On <Name of Queue> Queue and select Check Out.
b. On the Queue Status toolbar, click Check Out.

When a record is checked out of the Queue, the record cannot be checked out by another
User until the User working with the record checks it in.

c. In the Queue drop-down, click On <Name of Queue> Queue and select Check In or Check
In and Remove (checks in the record and removes it from the Queue).

After the record is checked in, it can be checked out by another User.

5. Remove a record from a Queue:
a. In the Queue drop-down, click On <Name of Queue> Queue and then select Remove from

Queue.
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Browser Client One-Step Actions
Browser Client One-Step Actions look and behave similarly to One-Step Actions in the Desktop Client.

In the Browser Client, Users can run One-Step Actions from:

• The Browser Client menu bar (run from the One-Step Action Manager or the list of Most Recently
Used (MRU) One-Step Actions).

• Buttons, links, and Widgets on Dashboards.

• Business Object records (as buttons or links). Some One-Step Actions might also run as Automatic
Actions that are executed when a Business Object is saved.

• The One-Step Action Manager (accessed from the Browser Client menu bar).

• An Actions menu on a Grid.

Good to know:

• The One-Step Actions accessed and run in the Browser Client are created in the CSM Desktop
Client or in CSM Administrator. One-Step Actions cannot be created, edited, or deleted in the
Browser Client.

• When One-Step Actions execute in the Browser Client, the interface appears as disabled until the
One-Step Actions complete.

• Print Actions are supported in the CSM Browser Client and Portal when Trusted Agents are used to
run the Actions. This includes Run a Report Actions that are configured to print a Report. Cherwell
SaaS customers can configure a Trusted Agent to use printers on their remote network; on-
premises customers can configure a Trusted Agent to use printers on their local network or on a
remote network. If you do not configure Trusted Agents, Users receive an error indicating that Print
Actions are not supported when the One-Step Actions is run on the Browser Client or Portal.

• When One-Step Actions that contain multiple Actions are executed in a CSM web application, the
end result of the One-Step Action is shown to Users when execution is complete. Users are
prompted for input as needed, but if the Save Business Object After Action check box is cleared
for a particular Action, changes made by the Action are not saved.

• There is currently no option in the Browser Client to run a One-Step Action for a group. You can,
however, configure a One-Step Action to run against a specific Saved Search. In this case, the One-
Step Action runs against the defined group of records, regardless of the client used to run the One-
Step Action. For more information, see Define the Conditions for a One-Step Action.

• Write file, read file, run program, and transfer Attachments (to or from a file system) One-Step
Actions generally works for the CSM Browser Client, but the One-Step Action must be designed to
write an accessible file on the server, and then execute a program on the server using the contents
of that file. This requires configuring IIS security rights specifically to handle this capability.
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Browser Client E-mail
The Browser Client offers comprehensive e-mail functionality, including:

• Rich Text and plain text: Define messages using either multiple format options or a plain text
format. Rich Text supports drag and drop image upload functionality (including a thumbnail preview)
and the ability to insert a hyperlink with display text and a tool tip, if necessary.

• Attachments: Add attachments to e-mail.

• Importance: Indicate to the recipient that the e-mail is high priority.

• Address Book: Search, filter, and sort Customers, Users, Teams, and Workgroups and then add
them as recipients to the e-mail. Access the Address Book by clicking either the To or CC button.

• Recipient attachment options: Define which Customer records should include an attached e-mail
as a Journal - Mail History Record after the e-mail is sent.

Note: You must have the appropriate security rights to access various features and functionality.

You can send an e-mail from the Browser Client multiple ways:

• Select E-mail > Send E-mail in the menu bar from anywhere in the Browser Client. You select the
recipients when using this option.

• Select E-mail > Current Customer in the menu bar when a Business Object record is active.

• Select a Customer's e-mail address on a Business Object record.

Note: The Customer must have a defined e-mail address on record.

• Run a One-Step Action configured with an e-mail Action directly from the One-Step Action Manager.

Note: E-mails are sent from a defined default account. If you have not configured e-mail for CSM,
refer to the e-mail accounts documentation for more information.
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Browser Client Dashboards
Browser Client Dashboards are very similar in appearance and functionality to Dashboards in the CSM
Desktop Client.

When working with Dashboards in the CSM Browser Client, Users can:

• View a Dashboard:
◦ View your default Home Dashboard by clicking the Home button on the Browser Client menu

bar.

◦ View all your Dashboards Using the Dashboard Manager (Dashboards>Dashboard Manager).

• Manually refresh a Dashboard.

• Select a User Theme on a Dashboard.

• Set the current Dashboard to be the default.

• Drill down into Dashboard data.

• Initiate a One-Step Action/Action from a Dashboard (example: Run a report, run a search, etc.).

Good to know:
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• Dashboards can be viewed and used in the Browser Client; however, Dashboards are managed
(created, edited, deleted, etc.) and configured (security rights and defaults) only in the CSM Desktop
Client and CSM Administrator.

• Browser Client Themes are accessed differently in the Browser Client than they are in the CSM
Desktop Client. See Browser Client Dashboard Functions for more information.

• Browser Client Widgets behave differently in the Browser Client than they do in the CSM Desktop
Client. See Browser Client Widgets for more information.

• The Dashboard Manager behaves differently in the Browser Client than it does in the CSM Desktop
Client. See Browser Client Managers for more information.
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Browser Client Widgets
Widgets behave similarly in both the Browser and CSM Desktop Client. You can click a Widget to open
records, reports, tables, or graphs relevant to the Widget's statistics. However, you cannot create, edit, or
delete Widgets from the Browser Client.

The ability to refresh the Dashboard aids in generating new data more quickly in the Browser Client. The
ability to set the priority of Widgets for refresh helps see the selected data faster, allowing one Widget to
refresh before another in a decided order.
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Browser Client Dashboard Functions
With the CSM Browser Client Dashboard Functions, Users can change the Dashboard Theme and
refresh the Dashboard so your Browser Client Widgets display the latest data.

The Theme drop-down can change the Dashboard Theme. The Themes available in the drop-down are
the Most Recently Used (MRU) Theme. Access more Themes by clicking More to open the Theme
Manager. Refresh the Dashboard by clicking the Refresh button to the right of the Themes drop-down.

Note: The Dashboard refresh is separate from the web browser (example: Internet Explorer®,
Firefox®, Chrome™, or Safari®) refresh. The Dashboard refresh only applies to the Dashboard
and its Widgets, not the entire web browser.
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Browser Client HTML Pages
Browser Client HTML Pages are used to display an external website (via a link) and an internal website
(that you design and code).

In the Browser Client, HTML Pages functionality is accessed using the Pages drop-down on the Browser
Client menu bar. From the Pages drop-down, Users can access the HTML Manager and most recently
used (MRU) pages.

Good to know:

• HTML Pages can be viewed and used in the Browser Client; however, HTML Pages are managed
(created, edited, deleted, etc.) and configured (security rights) only in the CSM Desktop Client and
CSM Administrator.

• The HTML Manager behaves differently in the Browser Client than it does in the CSM Desktop
Client. See Browser Client Managers for more information.
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Browser Client Reports
Browser Client Reports look and behave similarly to Reports in the Desktop Client. Reports can be
viewed and used in the Browser Client; however, Reports are managed (created, edited, deleted, etc.)
and configured in the CSM Desktop Client and CSM Administrator.

Reports can be run from:

• The Browser Client menu bar (run from the Report Manager or the list of Most Recently Used
(MRU) Reports).

• The Report Manager (accessed from the Browser Client menu bar).

• Specific links and Widgets on a Dashboard.

The Report Manager behaves differently in the Browser Client than it does in the CSM Desktop Client.
See Browser Client Managers for more information.
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Browser Client Visualizations
Browser Client Visualizations look and behave similarly to Visualizations in the Desktop Client. You can
view all your Visualizations using the Visualization Manager (Visualizations>Visualization Manager) or
view a record's Visualizations by clicking the Visualization icon (example: View impacted CIs on an
Incident Record).

In the Browser Client, Visualization functionality is accessed using the Visualizations drop-down menu on
the Browser Client menu bar. From the Visualizations drop-down, Users can access the Visualizations
Manager and configure Visualizations.

Good to know:

• Visualizations can be viewed and used in the Browser Client; however, Visualizations are managed
(created, edited, deleted, etc.) and configured (security rights and defaults) only in the CSM Desktop
Client and CSM Administrator.

• The Browser Client Visualization window provides much of the same functionality as the Desktop
Visualization window and includes the toolbar, Main pane, Aerial pane, and Legend; however, the
Browser Client Visualization window does not include a menu bar.

• The Visualization Manager behaves differently in the Browser Client than it does in the CSM
Desktop Client. See Browser Client Managers for more information.
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Browser Client Calendars
The CSM Browser Client has Calendar capabilities that are nearly in parity with the Calendars in the
Desktop Client. While there are some layout differences between the two (example: The three month
navigator is located to the left of the main Calendar pane in the Browser Client), the Browser Client
Calendar appears very similar to the Calendar in the CSM Desktop Client.

You can view the default Calendar by selecting a Calendar from the Calendars drop-down or view other
Calendars using the Calendar Manager (Calendars>Calendar Manager).

From the Calendars drop-down on the Browser Client menu bar, Users can access the default Calendar,
the Calendar Manager, and most recently used (MRU) Calendars.

Good to know:

• Calendars can be viewed and used in the Browser Client; however, Calendars are managed
(created, edited, deleted, etc.) and configured (security rights and defaults) only in the CSM Desktop
Client and CSM Administrator.

• The Calendar Manager behaves differently in the Browser Client than it does in the CSM Desktop
Client. See Browser Client Managers for more information.
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Browser Client Knowledge
Browser Client Knowledge functionality is limited to Knowledge Articles. Users can create Knowledge
Articles, search for Knowledge Articles, and use internal Knowledge sources to solve issues.

Managing and mapping Knowledge is currently unavailable in the CSM Browser Client.
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CSM Browser Client Search for Knowledge from a
Record

Users can search Knowledge Articles from an open record and place found solutions within the record for
future reference.

To search for Knowledge from an open record:

1. Open the record for which you want to find a solution.

2. Click the Knowledge button on the toolbar.

3. Select the Source of the Knowledge Article (Known Errors, Open Incidents, Knowledge Articles, or
Attachments). For Attachments, the search returns results that match the text within .txt, .doc,
and .xls files and will return any file type with a matching file name.

Note: These are internal sources for the CSM Browser Client, meaning the search is limited
to Knowledge Articles within the system, whereas the CSM Desktop Client can search
outside sources such as Google or Yahoo.

4. Specify a word or phrase to search.

5. Click Search.

6. Select a Knowledge Article to view.

7. Click the Use Solution button to place the Knowledge Article information into the record.
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Browser Client Contact Manager, Table
Management, and CMDB

The Browser Client provides access to the following CSM tools:

• Contact Manager: Use this tool to view Customer records.

• Table Management interface: Use this tool to view Lookup Object values.

• CMDB interface: Use this tool to view Configuration Item (CI) records.

In the Browser Client, Tools are accessed using the Tools drop-down or from Related Item Pickers on
Business Object records.

Related Item Pickers are configurable, can be added to any Form, and include:

• The Customer Selector that provides access to the:
◦ Contact Manager to quickly log who initiated a record.

◦ Customer Record to quickly view detailed information about the Customer.

• The CMDB Selector that provides access to the:
◦ CI database to quickly log the affected asset.

◦ CI Record to quickly view detailed information about the affected asset.

Good to know:

• Lookup Object values can be viewed and used in the Browser Client; however, values are managed
(created, edited, deleted, etc.) and configured only in the CSM Desktop Client.

• Customer records and CI records can be viewed in their respective interfaces; however, records are
created and deleted using the options on the Browser Client menu bar.

• The Contact Manager, Table Management interface, and CMDB interface utilize a Grid interface.
Use the Grid capabilities (example: Print, export, run an Action, sort, filter, size, move/reorder, and
add/remove columns) to display only the data you want and in a way that is meaningful to you.
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Browser Client Good to Know
Use these tips for helpful information on the CSM Browser Client.

• The CSM Browser Client consumes a CSM license. Licensing controls how many users can log into
CSM. CSM uses a concurrent or "floating" licensing model. This means that a fixed number of
licenses are shared among a group of users/customers, and that a fixed number of people can
simultaneously access the product. License codes determine the number of people who can log in
at any given time.

• Some features behave differently in the Browser Client than they do in the Desktop Client. See
Browser Client Features for more information.

• Browser Client Knowledge supports Knowledge Articles, Search, and Sources. However, Search
and Sources are limited to internal sources only for the Browser Client.

• While Dashboards cannot be created or edited in the Browser Client, they can be viewed.
Dashboard Widgets can be drilled into to pull up Reports or metrics related to it. Browser Client
Dashboards reflect personal settings made in the Desktop Client and in CSM Administrator.

• Some forms have a special browser view. This means some information in a form is displayed (such
as client name), while other sensitive or secure information (such as social security number) is
blocked out. While this is predominantly the case with the CSM Portal and Mobile Clients, the
Browser Client can be configured to do this through CSM Administrator.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Configure Browser and Mobile Device Security Rights.
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Using the Browser Client
When working with the Browser Client, you can:

• Log in to the Browser Client.

• Log a record.

• Scan a Barcode

• Search for a Barcode

• View and run Searches and access Queues.

• View and run One-Step Actions.

• Send E-mails.

• View Dashboards and Widgets.

• View HTML Pages.

• View and run Reports.

• View Visualizations.

• View Calendars.

• Access Knowledge Articles.

• Use tools: Contact Manager, Table Management interface, and CMDB interface.
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Log in to the Browser Client
Before accessing the Browser Client, the appropriate credentials must be assigned. Credentials are
managed on the User's Profile in CSM Administrator.

To log in to the Browser Client:

1. Provide the URL: http://server/CherwellClient where server is the location where CSM is installed
(either locally on the machine or on a specific server outside the local machine).

2. Provide the login credentials (User ID and Password). These should have been assigned by the
implementer or system administrator.

Note: If Windows/LDAP login is enabled, provide the Windows credentials used to log in to
the system.

3. Click Login.

If assigned to more than one CSM Role (and have not previously selected the Automatically Use
Selected Role check box), the Choose your Role window opens.

Note: A Role is a User/Customer's current function/responsibility in CSM, and controls how
data is presented in that person's CSM environment. For example, a Role determines which
Home Dashboard is displayed and how the Incident form looks (example: Which fields are
exposed, required, etc.). A Role is assigned to a Security Group and can be assigned to
more than one Security Group at a time. A User/Customer can access any of the Roles in
his Security Group, but can only log in using one Role at a time. Examples of Roles include
Service Desk Manager and Portal Customer.

4. Select the login Role for the session:
a. Role: Click the appropriate Role.

b. Always Use Selected Role: Select this check box to automatically use the selected Role at the
next log in. This bypasses the Role prompt.

5. Click Submit.
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Log a Record in the Browser Client
Browser Client records are very similar in appearance and functionality to Desktop Client records. For
more information, see Browser Client Forms.

To log a record in the CSM Browser Client:

1. Log in to the Browser Client.

2. On the Browser Client menu bar, click the New menu.

3. Select the type of record from the drop-down (example: New Incident). The record opens in the
main pane.

4. Complete using the appropriate workflow and save the record.
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Add and Remove Columns from a Grid in the
Browser Client

Use the Column Selector in the Browser Client to add or remove columns from the Grid.

1. Open a Grid using an applicable feature.
2. Click the Columns button on the Browser Client toolbar.

The Column Selector opens displaying the Business Object's relationships and associated fields.
Relationships and fields currently displayed in the Grid are indicated by a check mark. Close the
Column Selector at any time by clicking the Cancel button.

3. Add columns to the Grid by selecting one of the following:
◦ The check box next to one or more Relationships in the top level of the tree (example:

Incident Links Customer) to add all fields associated with the Relationship as columns in the
Grid.

◦ The check box next to one or more fields in the second level of the tree (example:
Department, Manager) to add only the field(s) you select as columns in the Grid.
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4. Remove columns from the Grid by deselecting one or more check boxes in either the top level or
second level of the tree.

5. Click the Submit button.
If you added columns, the associated field(s) display on the right side of the Grid and can be moved
anywhere in the Grid by dragging-and-dropping the column to the desired location.
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Export a Grid in the Browser Client
Export a Grid from the CSM Browser Client using .csv and .xlsx formats.

Note: Grids that are displayed in the Browser Client (except those in the Form Arrangement) are
limited to a maximum of 20,000 rows even though there may be many more rows of data
available. In the Form Arrangement, Grids are not limited when displaying data, exporting, or
printing.

Note: Search Results Grids allow you to select multiple records at one time and export the
contents or run a One-Step Action on those selected records. On all other types of Grids,
exporting or printing a Grid will print or export all rows of data.

1. Open a Grid using an applicable feature (example: Search Results List Widget, Quick Search, Form
Arrangement, etc.).

2. (Optional) Filter the Grid so the content is organized the way you want.
3. (Optional) Use the Column Chooser to edit Grid columns. When the Grid is exported, all columns in

the Grid are exported to the file.
4. Select the Export drop-down menu on the Browser Client toolbar.

Note: To export Grids, the user must have the appropriate Application Security Rights.

5. Select the format to use for export:
◦ CSV (.csv)
◦ Excel (.xlsx)

The file immediately begins to download. The download process varies based on the browser and
associated settings.

6. Save the file to your device.

Related concepts
Browser Client Grids
Related information
Application Security Rights
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Scan a Barcode

Note: It's important to have good lighting in order to properly capture the barcode.

1. Launch the BarcodeScan command on a Business Object form or from the CMDB.
Your mobile device camera will be activated.

Note: If you click Don't Allow, you will be returned to the Business Object form.

2. Scan the barcode with your mobile device camera.
Instead of scanning the barcode, you can manually enter it in the Value field of the BarcodeScan
attribute.

3. Complete the required fields and click Save.

Related concepts
Configure the Browser Client to Scan Barcodes
Related tasks
Search for a Barcode
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Search for a Barcode
You can search for a barcodes in CSM's Configuration Management Database (CMDB). The barcode can
either be manually entered in the search field, or from the barcode scanner. Launch the barcode scanner
by clicking Scan Barcode.

Related concepts
Configure the Browser Client to Scan Barcodes
Related tasks
Scan a Barcode
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Configuring the Browser Client
Complete the following procedures to configure the CSM Browser Client. Configuration procedures are
completed in CSM Administrator.
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Configure Browser Application Settings (URLs,
Timeouts, RSS Feeds)

Use the Browser Settings window in CSM Administrator to configure the following Browser Application
settings:

• URLs: To the Browser Client and Portal.

• Session Timeout.

• RSS Feeds: Enable Feeds/Anonymous Feeds from the Cherwell Service.

• Security: Enable or disable embedded frames, detailed error information, linked Attachments
(Attachments via links instead of direct file attachment), and password auto-complete.

To configure Browser Application settings:

1. Open the Browser Settings window (CSM Administrator>Browser and Mobile>Browser Application
Settings).
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2. Configure URLs for the Cherwell Browser applications (Portal for Customers; Browser Client for
Users).

Note: These are used when the application needs to generate a URL for launching one of
the Browser applications (example: When sending out Approvals).

a. Portal (Customer browser): Specify the base URL for the Cherwell Portal (example: http://
MyServer/CherwellPortal).

b. Browser Client (User browser): Specify the base URL for the Cherwell Browser Client
(example: http://MyServer/CherwellClient).

3. Configure session timeouts:
a. Session Timeout: Specify the number of idle minutes the system should wait before timing

out inactive sessions.
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Note: If you change this from the default of 20 minutes, you also need to configure the
application pool in IIS to have a value of at least 5 minutes greater than the session timeout.
CSM cannot make this change directly.

4. Enable RSS Feeds:

Note: CSM RSS Feeds allow Customers of an RSS reader to subscribe to CSM data (such
as newly created Incidents) based on a Saved Search or other criteria. Note that for RSS
Feeds to operate, the Cherwell Web Service must be installed. RSS Feeds are disabled by
default because they could potentially provide inappropriate access to data.

a. Enable RSS Feeds from Cherwell Service: Select this check box to allow RSS Feeds.

b. Enable Anonymous RSS Feeds from Cherwell Service: Select this check box to allow
anonymous RSS Feeds. If not selected, the URL requesting RSS data must contain User
identification information. Anonymous Feeds allow data based on the rights of the CSM's
Anonymous Security Group.

5. Configure browser application security settings:
a. Do not allow the browser applications to be embedded in a frame: Select this check box to

disable browser applications from being embedded in a frame (example: Embedding a CSM
application within the frame of another web page).

b. Do not send detailed error information to client: Select this check box to keep the browser
applications from sending detailed error information when errors occur.

c. Disable linked attachments in the browser applications: Select this check box to disable linked
Attachments (Attachments created via links instead of direct attachment) in the browser
applications.

d. Disable password auto-complete on login page: Select this check box to disable auto-
complete for passwords during login. This requires Users and Customers to type their full
passwords every time they try to log in to the browser applications.

6. Select OK.
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Define the Default Domain and Anonymous Login
Settings

By default, if using Windows or Active Directory, Users must specify the domain as part of the login
credentials (example: Applications\Bob).

Specifying the domain is how CSM identifies the fact that Users are specifying Windows/LDAP credentials
vs. internal Cherwell credentials. However, if all Cherwell Users are generally on the same domain,
specify that as the default domain. The Cherwell Portal automatically assumes that any credentials
detailed without a specific domain are Customers of the default domain.

Use the General page in the Security Settings window (in CSM Administrator) to define the following
general system security settings for the CSM Browser Client and Customer Portal:

• Default domain

• Anonymous login settings

Configure the default domain and anonymous login settings:

1. In the CSM Administrator main window, select Security > Edit security settings.

2. Select General.
3. Specify a default domain for the network:

a. Default domain: Specify the default domain name for the network. The domain is used in any
place where a domain is needed but not otherwise provided, such as automatically assigning
credentials to Customers.

Note: Select Arrow ( ) to have CSM auto-populate the name.

4. Configure anonymous login settings:
a. Allow Anonymous Login: Select this check box to allow CSM Web Applications to read basic

setup information from the system without User login and to enable the Anonymous Security
Group access to items specifically configured for Anonymous view.

b. Security group when not logged in: Select the Anonymous Security Group (OOTB:
Anonymous Browser) that should be used by CSM Web Applications before any User/
Customer has logged in.

5. Select OK.
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Configure Login, Authentication, and Inactivity
Settings for the Portal and Browser Client

By default, the CSM Web Applications (CSM Browser Client and Customer Portal) use the same login
mode and authentication settings as those configured for the Desktop Client; however, Users can define
different settings if needed.

To configure login, authentication, and inactivity settings for the CSM Browser Client and
Customer Portal:

1. In CSM Administrator, select Security > Edit security settings.

2. Select Browser Client or Browser Portal.
3. Clear the Use Same Settings as Desktop Client check box.

4. In the Supported login modes section, select the login modes that you want to support:

Note: Users can enable multiple login modes so that if one authentication fails or the User/
Customer cancels the process, the next configured login method is invoked (SAML, then
external authentication server, then LDAP, then Windows, then Internal). Not all of these
options will necessarily appear in the system if they have not been configured.

Note: When using a secure login configuration (SAML, LDAP, or Windows), Cherwell
strongly recommends that you activate the RedirectHttpToHttps flag in the CSM Portal and
CSM Browser Client web.config files for better security. The flag forces requests sent over
HTTP protocol to use HTTPS instead.

◦ Internal: Allows CSM authentication. CSM authenticates the CSM Login ID and Password
defined in the CSM Administrator User Profile (Security > Edit Users) or Customer
Credentials (Customer > Portal Settings).

Note: To use internal login credentials on a default domain, Users must type
CHERWELL\ in front of the user name (example: CHERWELL\Bob) in order to be able
to log in. For more information, refer to Define the Default Domain and Anonymous
Login Settings.

◦ LDAP: Allows Directory Service authentication. CSM authenticates login credentials using a
Directory Service such as LDAP or Active Directory. Depending on configuration, User/
Customer data can be imported based on LDAP data. For more information, refer to
Configuring the Integration with Directory Services.

◦ SAML: Allows Security Assertion Markup Language (SAML) authentication. For more
information, refer to the SAML documentation.

◦ Windows: Allows Windows Authentication. CSM authenticates the Windows login credentials if
set in the CSM Administrator User Profile (Security > Edit Users) or Customer Credentials
(Customer > Portal Settings). For more information about Windows Authentication, refer to
the Windows Login documentation.
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5. Configure general login options:
a. Validate Windows/LDAP credentials on server: If this check box is not selected, Windows

credentials are validated on the client, which is not as secure unless you have full control of
your network. If selected, the system cannot automatically log in the User/Customer without
asking (that is, the person will have to type their credentials) but it is much more secure. For
this feature to work, the server must have access to the Windows Domain or LDAP server.

Note: For best results, configure your server to use encrypted communication before
enabling this feature so that credentials are not passed to the server in a potentially
sniffable format.

b. Allow logging of authentication code (for troubleshooting): Select this check box to enable
logging of authentication calls in order to troubleshoot configuration (example: When
configuring LDAP setup). Then, use the Server Manager to enable logging in the CSM Portal
and CSM Browser Client.

6. Configure external authentication server option:

Note: This option makes use of the Cherwell Authentication Server, which must be installed
on your network such that it has access to your domain and is also callable by the Cherwell
Application Server. This option is distinct from SAML, although shares some concepts.

a. Validate credentials via external authentication server: Select this check box to validate User/
Customer credentials against an external authentication server.

b. Require user to enter credentials: Select this check box to require Users/Customers to enter
their credentials each time they log in.

Note: If this check box is not selected, and Users/Customers are on the same domain
as the Cherwell Authentication Server, then the User’s/Customer's current Windows
credentials are used to determine the person's identity. Otherwise, the User/Customer
must provide his Windows domain/user ID and password into the login window.

c. Authentication server Uniform Resource Identifier (URI): Specify the URI (location) of the
external authentication server.

Note: Both Client applications and the Cherwell Application Server must have access
to this URL.

7. Select OK.
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Prevent Browsing HTTP from HTTPS
Browse HTTP from HTTPS is a vulnerability allowing HTTPS pages to be accessed via HTTP, thus
disclosing potentially sensitive information. We strongly suggest editing web.config files to enforce
redirecting HTTP requests to HTTPS.

1. Edit the web.config file for the Portal and/or the WebClient.
◦ For the Portal, edit the WebConfig file in C:\Program Files (x86)\Cherwell Browser Applications

\Portal
◦ For the Web Client, edit the WebConfig file inC:\Program Files (x86)\Cherwell Browser

Applications\BrowserClient
2. Under the AppSetting section, uncomment the following Key:

·add key="RedirectHttpToHttps" value="True" />

3. Reset IIS.
4. Review the configuration of any applications you have installed to ensure proper permissions are in

place to prohibit forceful browsing of HTTPS resources.
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Configure Anonymous Login Settings for CSM
Web Applications

Use the CSM Administrator Security Settings General page to configure the anonymous login settings for
CSM Web Applications.

To allow CSM Web Applications to read basic setup information from the system and to enable
Anonymous Security Group access to items specifically configured for Anonymous view:

1. Open CSM Administrator and select Security > Edit security settings.

2. Select General.
3. Configure anonymous login settings:

a. Allow Anonymous Login: Select this check box to allow CSM Web Applications to read basic
setup information from the system without User login and to enable the Anonymous Security
Group access to items specifically configured for Anonymous view.

b. Security group when not logged in: Select the Anonymous Security Group (OOTB:
Anonymous Browser) that should be used by CSM Web Applications before any User/
Customer has logged in.

4. Select OK.
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Configure Browser Client (User) Login Credentials
CSM uses a User's login credentials to log them into the Browser Client. Login credentials are stored in
the User Profile. This must be configured through CSM Administrator and cannot be done from the
Browser Client.
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Configure Miscellaneous Settings for Web
Applications

You can use web.config files to configure certain settings for the CSM Web Applications, including the
Browser Client, Portal, and, in some cases, the Cherwell® REST API.

These web.config files can be found in the Cherwell directory on the server where you installed the web
applications. For example, the web.config file for the Portal is located in Cherwell Browser Applications
\Portal; for the Browser Client, the web.config file is located in Cherwell Browser Applications\Browser
Client.

For best results, restart Internet Information Services (IIS) after you modify a web.config file.

Good to Know

• There are several web.config files used by CSM.

• When an application starts, the web.config file is backed up in a separate folder.

• Content of the web.config files is retained during both upgrade and reinstallation, so any changes
you make to web.config files are preserved.

Change Prompt Time-out Period
Prompts generated by a One-Step Action, Expression, or Stored Search remain open in the web
applications for 2 minutes by default. If users do not respond to the Prompt within that time frame, the
Prompt closes.

To change the default time-out period, modify the following key in the web.config file:

<add key="UIInteractionTimeoutInSeconds" value="number of seconds"/>
      

Configure Service Monitor
For Service Monitor authentication, the Cherwell REST API configuration may need to be changed after
installing the Service Monitor. If using HTTP only, the cookie setting needs to be changed in the Service
Monitor configuration.

Service Monitor Web.config
Service Monitor configuration file location:

C:\Program Files (x86)\Cherwell Service Management\CherwellMonitor\Web.config

Under the system.web settings, use the following settings for HTTP only:
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<httpCookies domain=""
requireSSL="false"
httpOnlyCookies="true"/>

Note: In production environments, we strongly recommend using HTTPS.

Under appSettings, point the Service Monitor to the Cherwell database.

First, remove the following block of code:

<add key="CherwellRestApiRootUrl" value="http://localhost/CherwellApi" />
<!-- CherwellRestApiClientId is set in the API - exclusively for this use d
on't need to change on deployment-->
<add key="CherwellRestApiClientId" value="0A2C78D1-CB59-4F42-BD96-BD8BF7DBC
758" />
<!-- CherwellRestApiLoginUrl need to point to the location that the login p
age is setup for the client. -->
<add key="CherwellRestApiLoginUrlPath" value="auth/authorize" />
<add key="CherwellRestApiLogoutUrlPath" value="api/V1/logout" />
<add key="CherwellRestApiTokenUrlPath" value="token" />

Add the following new block of code:

<add key="TrebuchetDataSource" value="[Common]Cherwell Browser" />

Note: By default, the Service Monitor URL uses HTTPS. To use HTTP, change the URL value for
both the Service Monitor and the Cherwell REST API. The Cherwell REST API configuration file
may need to be edited after installing the Service Monitor.

Rest API web.config
Rest API config file location:

C:\Program Files (x86)\Cherwell Browser Applications\CherwellAPI

The following configurations are pulled over from the SAML integration (See Configure SAML in CSM):

• SAML redirect:

<add key="UseSAMLADFSRedirect" value="false"/>
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• IDP:

<add key="IDPisADFS" value="true"/>

Disable Label Resizing
While not recommended, to disable the resizing of labels that are set to dynamically auto-size in the
Browser Client, add the following key to <appSettings> section of the web.config file:

<add key="AutoSizeLabels" value="False"/>

Disable Scripts in Reports
By default, Users can run a Report that contains scripts if they have rights to run the Report. You can
disable scripts from running in all Reports, however. This may cause errors when Users run Reports that
contain scripts, but may improve security.

By default, scripts are enabled for Reports.

To disable scripts in all Reports, change the value in the following key to "False":

<add key="AllowScriptsInReports" value ="true"/>

Execute Embedded HTML and Script
While not recommended, to allow HTML and script embedded in labels to be executed in the Browser
Client, add the following key to <appSettings> section of the web.config file:

<add key = "AllowUnsafeLabels" value="True" />

<add key="AuthLogFile" value="c:\temp\webauthlog.log"/>

HTTPS-Only Cookies
In production environments, it is strongly recommended that sensitive cookies (like those used to maintain
your session) be marked as "Secure," meaning they will only be transferred with requests that are made
over HTTPS, and HTTP-only. They will not be accessible to Javascript running in the browser.

In order to take advantage of this configuration, perform the following steps:

1. Ensure the web application is running on an IIS instance that listens on both :80 (HTTP) and :443
(HTTPS).
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2. Ensure IIS (or a web.config file, or some other handler) is set up to automatically redirect http://
hostname/path to https://hostname/path.

3. Add the following line to these web.config files:
◦ C:\Program Files (x86)\Cherwell Browser Applications\Portal

◦ C:\Program Files (x86)\Cherwell Browser Applications\CherwellClient

◦ C:\Program Files (x86)\Cherwell Browser Applications\CherwellService

<httpCookies
httpOnlyCookies="true"
requireSSL="true" />

For more details, see https://msdn.microsoft.com/en-us/library/ms228262(v=vs.100).aspx.

In-line Browser Display Extensions
To specify other in-line browser display extensions that should open inside of a browser window, add the
following key to the <appSettings> section of the web.config file:

<add key="InlineBrowserDisplayExtensions" value=".pdf,.xml"/>

Note: Browsers that are not Microsoft Edge (ex: Chrome™, Mozilla Firefox®, etc.) handle in-line
browser display extensions more automatically, but Edge requires this to be set. PDF and XML
files are handled this way by default.
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Configure the Browser Client to Scan Barcodes
You can configure the CSM Browser Client to enable Users to scan asset barcodes using a mobile device
camera.

For example, use a mobile device camera to access the CSM Browser Client to scan asset tags as a
barcode reader, and take and upload photos to tickets.

The following types of barcode readers are supported:

• Code 128: code_128_reader

• EAN: ean_reader

• EAN-8: ean_8_reader

• Code 39: code_39_reader

• Code 39 VIN: code_39_vin_reader

• Codabar: codabar_reader

• UPC: upc_reader

• UPC-E: upc_e_reader

• Interleaved 2 of 5: i2of5_reader

• 2 of 5: 2of5_reader

• Code 93: code_93_reader

Prerequisite: Before Users can scan barcodes from within the CSM Browser Client, you must add the
BarcodeScan attribute to the Business Object and add a Field to store the barcode value.

Add the BarcodeScan Attribute
To add BarcodeScan to the Business Object for a Configuration Item:

1. In CSM Administrator, create a new or edit an existing Blueprint.

2. Select a Business Object, such as Configuration Item > Computer.
3. In the right pane, under Structure, select Edit Business Object.
4. Select Bus Ob Properties.

5. Select Advanced, then select the down arrow ( ) next to General attributes.

6. In the Attribute field, enter BarcodeScan.

7. Do one of the following:
◦ Leave the attribute value blank: the system will use all the barcode reader types specified

above.

◦ Specify the barcode reader types you want to support as a comma-delimited list in the attribute
value field: This increases scan reliability.
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8. Click OK.

Add a Field to Store the Barcode
To add a Field to Store the Barcode:

1. Open the Business Object that has the BarcodeScan attribute, and then:
a. Add a new Field or select an existing Field.

b. Open the Field Properties window.

c. Select Advanced, then select the down arrow ( ) next to General attributes.

d. In the Attribute field, enter BarcodeScan.

e. Click OK.

2. Under Appearance, select Edit Form.

3. Drag the type of control you want to use onto the Form, then right-click and select Control
properties.

4. Select Commands > Other.
5. Select the ScanBarcode command, and add it as the command for a control to launch the barcode

scanner. The result will appear in the Barcode Field on the form.

6. Click OK.
You can now launch the barcode scanner from a Bus Ob Form.

Once you have set up the BarcodeScan attribute in the Business Object and added a Field to store the
barcode, you can use it to enable scanning from a mobile device.

Related tasks
Scan a Barcode
Search for a Barcode
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Set the Location of a Business Object
In the Browser Client, the current location of any Business Object can be set automatically, through
location services, or manually, so that you know its location and can access it when necessary.

To set the location of any Business Object:

1. In CSM Administrator, create a new blueprint or open an existing blueprint.
2. Select a Business Object, such as Configuration Item > Computer. You can add the Location

attribute to any Business Object.
3. In the right pane, under Structure, select Edit Business Object.
4. Click Bus Ob Properties.

5. Select Advanced, then select the down arrow ( ) next to General attributes.
6. In the Attribute field, enter LocationAware. The Value field can remain (null).

This makes the Business Bbject location-aware.
7. Click OK.
8. Add the Lattitude, Longitude, and Altitude attributes to any single Field in your Business Object:

a. In the Business Object Editor, select any Field in the list, then click Field Properties.
b. Select Advanced.

c. Select the down arrow ( ) next to General attributes.
d. In the Attribute field, enter LocLatitude.

The location data will be stored in the Value field.
e. Repeat steps a - d for Longitude (LocLongitude) and Altitude (LocAltitude).

Note: Altitude (LocAltitude) is only supported on mobile phones and tablets.

Optional: You can also edit the Business Objects Form to add controls for these fields. For more
information, see Forms.

Expressions
Latitude and Longitude Fields can also be added to Expressions or One-Step Actions so you can use
them in mapping software such as Google Maps. Use a text Expression on a link label or a button
associated with an Action and use the documented URL. For example, if you use Google Maps, the URL
will be something like https://www.google.com/maps/search/?api=1&lat,long. Add the Fields
for lat,long into your Expression or One-Step Action.
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Troubleshoot the CSM Web Applications
If the CSM Web Applications (Browser Client, Portal, Web-Forms) are not working, use the following
steps to troubleshoot.

1. Make sure web.config is pointing to the correct connection (the default is Cherwell Browser):
a. Open the web.config file. By default, it is installed to: C:\Program Files\Cherwell Browser

Applications\"App"\web.config).

b. Make sure the value is "[Common]Cherwell Browser".
◦ For Portal and Browser Client, the XML is at the bottom and looks like this:

<appSettings>

<add key="TrebuchetDataSource" value="[Common]Cherwell Browser"/>

</appSettings>

◦ For Web Forms, the XML is at the top and looks like this:

<add key="TrebuchetDataSource" value="[Common]Cherwell Browser"/>

2. Make sure Cherwell Browser connection is using SQL Authentication or domain account
permissions have been set up appropriately:

a. If SQL is installed on same machine as IIS, Users can give the IUSR_<machineName>
account rights to the SQL server database.

b. If SQL is not installed on the same machine as IIS, Users have to create a domain account,
give that account rights to the SQL server database and also set up the application in IIS to
use that account. In addition, Users must give that account rights to the directory (and
subdirectories) where the Browser applications are installed.

3. Make sure IIS is set up for Anonymous Access. If desired, enable Integrated Windows
Authentication:

a. Go into IIS. On the left is the Internet Information Services tree. Expand the Web Sites node
and then the Default Web Site node underneath. Find the folder for the Browser application.

◦ In IIS-7 (Windows Server 2008), click the application in the left-hand pane, then double-
click Authentication in the IIS section of the features view on the right. If Anonymous
Authentication is not enabled, select it, then click Enable in the far right Actions pane. Do
the same thing for Windows Authentication if desired. Note that, if Windows
Authentication does not appear, you might need to go the Server Manager to install the
feature.

4. Consider the Browser being used (only if you are using Windows Authentication):
◦ Firefox cannot pass Windows credentials properly unless you install their plug-in. Try Internet

Explorer and see if this works.

5. Verify that the supported version of ASP.NET is registered in the Windows Registry.
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Troubleshoot Uploading Attachments
If Users are having trouble uploading attachments, make sure that they have rights to the Attachments
directory.

1. Go into IIS and find the Attachments directory under the Self-Service virtual directory.

2. Right-click and select Properties.

3. Go to the Directory Security tab.

4. Press the Edit button in the Anonymous Access box. Ensure that User is set up.

Note: Users might also need rights to the actual directory on the hard drive.
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Troubleshoot Grids in Internet Explorer
In some older versions fo Internet Explorer, Grids sometimes do not align properly after sorting the Grid
columns. In order to correct this, Users must disable the Compatibility View setting in Internet Explorer.

To disable Compatibility View:

1. Open Internet Explorer.

2. Click Tools to open the Tools menu, and then click Compatibility View Settings.

3. If the CSM Browser Client is displayed in the list of sites to display in Compatibility mode, remove it.

4. Users can also disable Compatibility View by clicking the Compatibility View button  in the web
address bar.
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Portal
The CSM Customer Portal is a highly configurable web application that enables Customers to securely
and conveniently access their CSM data using a browser. A Portal supports multiple sites, and also allows
managers to access their Team’s data.
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About Customer Portals
Customers can perform several tasks when using a Portal.

Using a Portal, customers can:

• Access a Service Catalog

• Log Incidents and Service Requests

• Complete common self-service functions (example: Reset a password)

• Access Knowledge Articles

• Access a Document Repository, if configured

• Monitor important metrics via a Dashboard
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A Portal comprises one or more configurable Portal Sites, each of which can display completely different
information. For example, there might be a primary IT Site, but also different Sites for other departments
or functions. Any particular Site can be made up of a number of Site Items.

To help get your system started, CSM provides an OOTB IT Portal Site. The Site is built using OOTB Site
Items, such as an OOTB Service Catalog, forms specific to the Portal, Dashboards specific to the service
desk, and predefined properties (header/footer, menu bar). Implement and use the OOTB IT Portal Site
as provided, modify it, or create new Sites to meet the needs of your organization.

Related concepts
Portal Sites
Site Items
OOTB IT Portal Sites
Portal Site Design Ideas
Create a Custom Portal
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Portal Sites
A Portal Site is a collection of self-service information in a CSM Portal that is dedicated to a topic or
function.

A Portal can display one or more Sites. For example, it might display:

• A company support Site (single site Portal).

• A Site for each department (IT, HR, Support).

• A Site for each locale (US, Germany, Chile), although a single Site can be configured to be available
in multiple languages.

A Portal Site is highly configurable and can be tailored to meet branding and layout needs. The Site can
display an Application Bar (Login, Site Selector), an informative banner/footer, a menu bar, a Search
Control, and a Startup Item (A Dashboard).
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1. Banner: Displays Site and background image, title, subtitle, and baseline text.

2. Application Bar: Displays the Language Selector, Site Selector, login menu, and Help menu.

3. Menu Bar: Lists the Site Items and/or supporting Actions. Select a Site Item to display its contents
in the main pane or its list of supporting Actions. The Portal menu bar collapses into a hamburger
menu on mobile screens and browser windows sized below 768 pixels.

4. Main Pane: Displays the Startup Item, which could be a Dashboard, a Report, a list of records, or
the record currently being edited.
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Site Items
When creating a Portal, add Site Items to be displayed on the Site menu bar.

The following items can be included on a Portal Site:

• Actions (including powerful create options and interactive One-Step Actions): Use on a Site's menu
bar to support Site Items (Create Incident or Display Document Repository) and enhance
navigation. Actions can also be used on Dashboards and HTML pages.

• Action Catalogs: Display a self-building and dynamic catalog of Actions that empower Customers
to help themselves (example: Create a Service Catalog that displays all your services with Actions
to create Incidents and Service Requests).

• Calendars: Displays time-sensitive Business Object data in a Calendar format.

• Dashboards and Widgets: Provide custom, insightful control panels capable of executing
commands and providing real-time, at-a-glance information. For example, a Customer-specific
Dashboard complete with a Twitter Feed, a list of announcements, and a list of Open/Closed
Incidents.

• Document Repositories: Provide a collection of resourceful documents, such as Knowledge
Articles, that encourage Customers to resolve their own issues.

• Forms/records: Allow Customers to expedite service by creating, viewing, and editing their own
records, such as Incidents and Service Requests, and possibly other Customer's records.

• Grids: Allow Customers view CSM data from a Business Object in a format that can be sorted and
exported.

• HTML Pages: Display a system administrator-designed HTML-coded page or host a web page from
an external site.

• Knowledge: Search for Knowledge Articles (KAs) using a Portal Site's configured Search Control.
When using a KA in the Portal, Customers can vote on Article popularity by selecting the Like button
and add feedback by selecting the Add a Comment link.

• Reports: Provide metrics of your record data in a formatted and organized presentation.

• Searching: Offers searching so that Customers can easily locate information about the Portal. Use
CSM's Out-of-the-Box (OOTB) Search Control or create your own Search Widget.

• Service Cart: Provides an e-commerce tool that Customers can use to add multiple Services to a
single order, and then temporarily hold the Services until they are ready to submit their order.

• Visualizations: Display a visual map of linked records, Customers or vendors.

Note: HTML pages are unique to the Portal. The other items are commonly used throughout
CSM.

When a Customer first accesses a Site, a default Startup Item is displayed; this can be an Action Catalog
(special Widget), a Dashboard, a Document Repository, an HTML page, a Report, or a Saved Search
(used to display a list of records). A Customer can access other Site Items using the Site menu bar. The
Startup Item can also be accessed when Users select the optional title logo/text or optional Home menu
bar button.
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Different Startup Items can be displayed upon login so information can be securely and appropriately
filtered based on credentials. For example, display a Service Catalog to Customers who are not logged in
and then display a Dashboard complete with a Customer's Open Incidents for a Customer who does log
in.

To help build and manage the Portal and Sites, CSM provides the Site Manager (manage Sites at a high-
level), the Site Wizard (create a cursory Site), and the Site Editor and Site Properties window (edit/refine
the way the Site/Site Items look and behave). CSM also provides numerous CSM Item Managers that
allow you to create Site Items, such as Dashboards, HTML pages, and Document Repositories.

Related concepts
Portal Sites
About One-Step Actions
Navigate CSM Portal Knowledge Articles
CSM Desktop Client Quick Search Widget
Create a Search Widget
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About Portal Actions
CSM provides several customizable Actions that can be added to and executed from the Portal menu bar,
a Dashboard, or an HTML page.

An Action is an activity that can be initiated manually (from a button, link, menu bar item, or Widget) or
automatically (from an Automation Process, One-Step™ Action, or E-mail Monitor) to execute a command
(example: Print) or display/run a CSM Item (example: Display a Dashboard or run a Search).

Examples include:

• Display Create commands for the Business Objects used on the Portal Site (example: Create
Incident).

• Display common Searches (example: Search My Open Incidents).

• Display a Home button on the Portal menu bar to take Customers back to the Startup Item.

• Display or run a CSM Item (example: Action Catalog, Report, Document Repository).

Some Actions are automatically added to the menu bar when creating a Site using the Site Wizard. For
example, a menu bar Item can be added for each Business Object associated with the Site and a
Document Repository Action is added if there is a Document Repository.

Manually add Actions or edit existing Actions by defining menu bar properties for a Site.

Manually add the following Actions:

• One-Step Action: Runs a One-Step Action, which runs one or more other Actions:
◦ Create/update/delete a Business Object.

◦ Excel merge.

◦ Execute a command.

◦ Go to a Field.

◦ Go to a record.

◦ Go to Action (branching).

◦ Launch a URL.

◦ Link/Unlink Business Objects.

◦ Print.

◦ Run another One-Step Action.

◦ Run a program.

◦ Run a Report.

◦ Send a Tweet.

◦ Send an email.

◦ Show a Pop-Up.
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◦ Step through children.

◦ Transfer Attachments.

◦ Transfer Related Business Objects.

◦ Update a Variable or Stored Value.

◦ Web service call.

◦ Write to a file.

◦ Work with a Queue.

• Command: Runs a system command applicable to the Portal. Categories include:
◦ Managers: Adds a command to launch a CSM Item Manager so that a Customer can choose a

CSM Item (Action Catalog, Dashboard, Document Repository, One-Step Action, HTML page,
Report, or Search) to open/run (example: Add the Report Manager to the Site menu bar so
that Customers can choose to run an available Report). Note: Recent Items lists must be
placed inside folders (they cannot be at the top level of the menu bar), and it is recommend
that they be placed as the last item in the folder.

◦ (Other) Business Object Search: Provides common Site Searches (example: Business Object
to search, how the results should be sorted, whether to limit to the current Customer, or limit to
Open or Closed records).

◦ (Other) Create Business Object: Creates a new Business Object (record) but with several
powerful options, such as a One-Step Action to run as part of the creation process and
whether a custom Form should be displayed (which can be different than the Out-of-the-Box
(OOTB) Form used for viewing a Business Object).

◦ (Other) Home: Takes the Customer to the Startup Item (Dashboard, HTML page).

Note: This command must be placed in a folder.

• Dashboard: Displays a Dashboard.

• Report: Runs a Report.

• Search: Runs a Saved Search.

• Page: Displays an HTML page.

• Doc Repository: Displays a Document Repository.

• Action Catalog: Displays an Action Catalog (Widget).

Related concepts
About One-Step Actions
About CSM Item Managers
Related tasks
Create a Site Using the Site Wizard
Define Menu Bar Properties for a Portal Site
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About Portal Action Catalogs
Use Action Catalogs in a Portal so Customers can select services from a Service Catalog.

An Action Catalog is a dynamic catalog of Actions that empowers Users and Customers to help
themselves (example: Create a Service Catalog that displays all your Services with Actions to create
Incidents and Service Requests).

When a Customer selects a hyperlink, an Action executes (example: Request Account creates an Incident
record and categorizes it as a Request). The Action Catalog's theme, such as Cherwell Next, controls the
fonts, colors, and block layout.

Note: A Service Catalog is built using the Action Catalog Widget, which can be used on a
Dashboard or as a standalone Widget in the Portal.

Related concepts
Create an Action Catalog Widget
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About Portal Calendars
The CSM Portal has Calendar capabilities that are very similar to those in the Browser Client Calendar.

A Calendar allows you to view time-sensitive Business Object data in a natural format that can be shared
with Teams or an organization.

Examples of Portal Calendars include the IT Calendar, Task Calendar, and Event Calendar.

When working with Calendars In the Portal, users can:

• View a Calendar by selecting IT Calendar on the menu bar.

• Change the Calendar View.

In the Portal, Calendar functionality is accessed using the IT Calendars text on the Portal menu bar if you
designed the Portal to include it.

Related concepts
Browser Client Calendars
Change the Calendar View
Design a Portal
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About Portal Dashboards
A Portal Dashboard is a custom, interactive, and insightful console that is optimized to provide helpful at-
a-glance self-service information and navigation for Customers accessing a Portal Site.

Like all CSM Dashboards, a Portal Dashboard uses configurable Widgets to display critical metrics,
analyze and predict trends, drill down into data, initiate commands and Actions, facilitate navigation, or
show a sampling of information relevant to Customers.

Examples of Portal Dashboards include:

• A not logged-in Portal Dashboard, intended for anonymous Customers, that presents general
information and data, such as a welcome information, a community announcement board, and
service desk hours.

• A logged-in Portal Dashboard, intended for logged-in Customers, that displays a list of open records
(by Customer and organization), facilitates navigation, and helps Customers with self-service
operations (example: Logging Incidents, locating Knowledge Articles and FAQs).

• A department Dashboard, intended for Customers in a specific department (example: HR, Facilities,
Finance), that presents department-specific records and metrics, an announcement board, or a
Twitter Feed.

CSM provides several Out-of-the-Box (OOTB) IT Portal Dashboards, which are used on the OOTB IT
Portal Site. Use these OOTB Dashboards as provided, modify them, or create new Dashboards using the
Dashboard Manager and Dashboard Editor.

Related concepts
About Dashboards
About Widgets
OOTB IT Portal Sites
Dashboards
Widgets
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About Portal Widgets
Use Widgets on a Portal to display information for Customers to see.

A Widget is a mechanism that displays information about a Dashboard or Portal Site (example: Chart,
Gauge, Button). Examples of Portal Widgets include:

1. Search Results List Widget

2. Chart Widget

3. Action Widgets (links or commands)

CSM provides multiple of OOTB Widgets designed to display data on a Dashboard or Portal Site. Use
these OOTB Widgets as provided, edit them, or create your own using the Widget Manager.

Related concepts
Dashboards
Portal Sites
Managing Widgets
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About Portal Forms
CSM allows you to create several different types of Portal Forms for each Business Object.

Portal Forms are regular Forms designed specifically for the Customer Portal to provide self-service
record logging capabilities, such as an abbreviated Incident Form. Typically, Portal Forms are much
simpler than the default Form used in the Desktop/Browser Client.

Regular Forms are Main Forms or Forms for the Business Object. By default, each Business Object has
one Default regular Form; however, you can create as many as you need. Typically, a regular Form is
intended for detailed logging activities in the Desktop and Browser Client.

Related concepts
About Customer Portals
About Forms
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About Portal Grids
Grids in the Browser Client and Portal look very similar to Desktop Client Grids.

Portal Grids include the following features:

• Grid Menu Bar: Displays actions available for the Grid, including navigation, Actions, and available
columns.

• Title: Grid title that might or might not match the name of the Business Object that the Grid
represents. Also, a Business Object might have multiple Grids, so each might have its own name.

• Sort icon: Indicates the column currently sorting the Grid, and if it is in ascending or descending
order. Select the icon to toggle sorting. Select another column heading to sort by that column.

• Filter icon: Indicates the column data can be filtered. Select the icon to show filtering options
(possible filter values appear in the column's Filter drop-down list).

• Grid item: Each item within a Grid contains its own line of information. Selecting the item opens the
record in the Main Pane.

Related concepts
Browser Client Grids
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About HTML Pages
CSM provides several OOTB HTML Pages.

A CSM HTML Page is an HTML-coded web-like page used to display information on a CSM Customer
Portal Site or in the CSM Browser Client.

HTML Pages can be:

• Internal HTML Pages: HTML pages that users design and code. Users can insert CSM commands
directly into the page, as well as CSM Images, Tokens, and Stored Values.

• External HTML Pages: Existing websites; users supply the URL.

Use an HTML Page to display:

• A company website as a Startup Item on a Portal Site.

• A hardware website or forum on a Portal Site (add an Action to a Site menu bar to display an HTML
page).

• A hard-coded HTML Page that Users design directly in the Browser Client.

Use these OOTB HTML Pages as-is, edit them, or create new HTML Pages using the HTML Page
Manager. CSM also provides the HTML Page Editor to help design and code your own Internal HTML
Page.

Note: The HTML Page Editor is useful for building pages. For more advanced options, it is
assumed that users have a working knowledge of HTML and possibly CSS.

Related concepts
About Portal Actions
HTML Page Editor
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About Portal Knowledge
CSM consolidates multiple Knowledge Sources into a single, powerful Knowledge Base so that users can
find relevant information quickly without the use of additional resources.

Depending on the configuration of your system, Customers might also have access to Knowledge through
the Portal so that they can independently solve issues.

CSM Knowledge can come from many different Knowledge Sources, including:

• Knowledge Articles (KAs): CSM Business Object dedicated to Knowledge. Use to share identified
solutions with users and Customers. Note that KAs can also be imported from third-party Knowledge
providers.

• Business Object records: Closed Incidents or Problems (Known Errors), or any other appropriate
Business Objects.

• Attachments: Imported internal or external documentation.

• Web: Adobe®, Google®, Microsoft TechNet®, Twitter®, Yahoo!®, and YouTube®.

By default, only members of the Portal Workgroup Manager Security Group can create Knowledge
Articles in the Portal.
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In the Portal, Customers can search for Knowledge Articles using a Portal Site's configured Search
Control or using the Knowledge Article Dashboard. When on a KA in the Portal, Customers can vote on
Article popularity by selecting the Like this Article link, note whether or not it resolved their issue by
selecting Yes or No, and add feedback by selecting the Add Comment link.

Related concepts
Knowledge Articles
About Security Groups
Navigate CSM Portal Knowledge Articles
Related tasks
Create a Knowledge Article in the Portal
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About Portal Reports
Portal Reports behave similarly to Reports in the Browser Client.

In the Portal, Reports can be run from Specific links and Widgets in a Dashboard (if configured in CSM
Administrator).

Related concepts
Browser Client Reports
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About Portal Searching
CSM provides multiple search tools to help efficiently and thoroughly search and filter CSM data, locating
one record or a set or records.

Searching tools for the Portal include:

1. Knowledge Search: A Knowledge Search is a search that runs against the Cherwell Knowledge
Base to quickly find solutions. Knowledge Searches can also treat existing records in CSM as
Knowledge Sources. Search results display according to their Relevancy ranking, which means the
records most likely to be relevant to your search string display at the top of the results. On the Out-
of-the-Box (OOTB) IT Portal Site, the Find Help Dashboard contains an Action link that opens the
OOTB IT Portal Site Knowledge Article Dashboard. This Dashboard displays a Knowledge Search
bar as well as the Most Popular Knowledge Articles.

2. View Service Catalog: Selecting View Service Catalog takes you to the Service Catalog where you
can run a search.
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Related concepts
About Knowledge Management
OOTB IT Portal Sites
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About the Service Catalog
The OOTB Service Catalog displays Service Catalog items with an icon (optional), title, and description in
card format.

The number of columns adjust according to the size of the user's screen.

The following services are in the OOTB Service Catalog:

• Account Management: Pertains to network access and passwords.

• Conferencing/Presentation: Encompasses conference setup, web sharing, projectors, and more.

• Desktop Management: Covers end-user computer equipment and OS, anti-virus, and
miscellaneous software.

• E-mail/Calendaring: Contains email and calendaring software and account management.

• Employee Support: Used primarily by HR and hiring managers to set up new employees, update
their information, or request an employee separation task.

• Enterprise Apps: Contains options for business software used by the organization.

• IT Service Desk: Used primarily by an IT department to manage technology systems in the
organization.

• Network Services: Covers the network itself, both wired and wireless. It includes file sharing and
backup/restore services.

• Printing: Covers local desktop and shared network printers. Users can request access to network
resources, request toner/ink, or request a local printer of their own, pending approval.

• Telephony/Fax: Covers telephony equipment (desktop and mobile) and fax machines.

• Web Services: Includes external (Internet) and internal (Intranet) requests.
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The OOTB Service Catalog has a search feature that produces a list of suggested matches after typing
three characters into the search box. You can search on the title and description of Service Catalog items.
The drop-down list of suggested results will show up to five suggestions. Select the More... link to view
additional suggestions. Select the Search button or press the Enter key to view all search results.

The Cards with Search style was introduced to the OOTB Service Catalog in CSM 9.2.0. If you upgraded
from a version of CSM than 9.2.0, you can implement the Cards with Search styling.

Note: When a user's screen size is small enough that only one column of cards is displayed, the
card icon will be hidden.

Related concepts
OOTB Service Catalog and Cards with Search Styling
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About Service Carts
CSM provides an OOTB Service Cart as a Major Business Object for Customers to use in the OOTB IT
Portal.

A Service Cart is an e-commerce tool that allows Customers to add multiple Service Requests to a single
order, and then temporarily hold the items until they are ready to submit the full order. When the order is
submitted, each Service Request automatically creates associated Tasks based on related Service
Catalog Template Work Units. Technicians fulfill the Service Requests in CSM, and Customers view and
track the Service Requests (and Service Request history) on the My Service Orders page of the
Customer Portal.

Note: Service Cart can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM).

Related concepts
OOTB IT Portal Sites
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About Portal Visualizations
Portal Visualizations look and behave similarly to Visualizations in the Browser Client.

A Visualization is an interactive graphical representation of related data, represented as a relationship
chain with colored nodes (boxes) and links (arrows). Defined alerts can also be added to indicate potential
risk. Examples include:

• Configuration maps (records that are linked using a common factor)

• Organization charts

In the Portal, users can:

• View a Visualization using the Visualization button on the menu bar.

Note: In order to open the Visualization in the Portal, the Visualization feature must be
added to the Out-of-the-Box (OOTB) IT Portal Site menu bar.

Good to know:

• Actions, Dashboards, Visualizations, Calendars, Widgets, and Searches can be viewed, accessed,
or run in the Portal; however, they are managed (created, edited, deleted, etc.) and configured
(security rights and defaults) only in the CSM Desktop Client and CSM Administrator.

• The Portal Visualization window provides much of the same functionality as the Desktop
Visualization window and includes the toolbar, Main pane, Aerial pane, and Legend; however, the
Portal Visualization window does not include a menu bar.

Related concepts
Browser Client Visualizations
The Relationship between CSM and SIAM
Related tasks
Define Menu Bar Properties for a Portal Site
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OOTB IT Portal Sites
CSM is shipped with an Out-of-the-Box IT Portal Site, complete with Portal-specific Forms and
Dashboards.

The Site is built using OOTB Site Items and predefined properties (below). We recommend that you
implement the OOTB Site so that you can explore the features, and then modify it or create new Sites to
meet the needs of your organization. OOTB Site Items include:

• Home Dashboard: Directs Customers to log and/or view Incidents and Service Requests, find help
by browsing Knowledge Articles and FAQs, and manage their devices through Service Requests.
Also displays live metrics (global and personal) and a live Announcement Board.

Note: CSM also provides a not logged-in Dashboard for anonymous Customers. This
Dashboard is simple and provides access to only a few self-service operations (example:
Resetting a password).

• Service Catalog: Displays all available Services in a dynamic card format.

• Metrics: Displays detailed metrics for the Customer (My Items), department (Department Items),
and records (Status and Problems). Metrics are displayed by using Dashboards.

• Portal-specific Incident, Change Request, and Knowledge Article Forms: Simple Forms help
Customers log and manage their own records.

OOTB IT Portal Site properties include:

• General properties: Defines the name (IT) and associated Document Repository (Default Portal
Documents).

• Display properties: Defines the Startup Item to display when first accessed (a Dashboard named
Portal (not logged in)) and the alternate Startup Dashboard to display upon login (Portal Default).
Also defines the Theme and Search Control (both are OOTB).

• Banner properties: Defines the title and subtitle, as well as the colors.

• Footer properties: No footer is used.

• Menu bar properties: Defines which items to display on the menu bar (Home, Service Catalog, My
Devices, IT Calendar, Charts and Items, and Service Orders).

◦ Reset Password is a conditional menu item that only displays when the Portal (not logged in)
Dashboard is active.

◦ The BeyondTrust Chat Request menu item is also conditional and displays only when
BeyondTrust is enabled.

◦ Service Orders is conditional and only displays when the Service Cart Enabled Stored Value is
set to True. This value must be set for each language.

• Localization properties: Translated Sites are available for Spanish, French, German, and Brazilian
Portuguese. You can override certain properties for each translated Site.

Related concepts
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Implement a Portal
Create a Custom Portal
Navigate the CSM Portal Site Announcement Board
About the Service Catalog
Related tasks
Define Localization Properties for a Site
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CSM Customer Portal Good to Know
Use these tips for helpful information on the CSM Portal.

• The CSM Portal is personal (you can display different views for different customers).

• The CSM Portal allows Anonymous access (customer is not required to log in), though access to
data is limited.

• If a CSM Portal Site requires a log in, customers must have CSM Portal login credentials, which
means they must have a Customer Record with defined credentials and security rights.

• Content can be real time or static and is organized using a set of highly configurable Sites that you
create for your customers.

• A CSM Portal Site can contain any number of Site Items, including Business Objects/records
(customers can create and edit records), Actions (including powerful create options and interactive
One-Step Actions), Action Catalogs, Dashboard and Widgets, Document Repositories, HTML
pages, Reports, Search Groups, and Searching.

• When a customer first accesses a Site, a default Startup Item is displayed; this can be an Action
Catalog (special Widget), Dashboard, Document Repository, HTML page, Report, or Saved Search
(used to display a list of records). A customer can access other Site Items using the Site menu bar.

• To help get the system started, CSM provides an OOTB IT CSM Portal Site. This OOTB IT CSM
Portal Site is built using OOTB Site Items (example: An OOTB Service Catalog, Portal-specific
forms, service desk-specific Dashboards, an OOTB Document Repository) and predefined
properties (Startup Item, alternate Startup Item, header/footer, menu bar). Implement and use this
OOTB IT CSM Portal Site as provided, tailor it, or create new Sites to meet the needs of your
organization. For more information, see Portal Site Design Ideas and Create a Custom Portal.

• You may see random characters in a CSM Portal page's URL. These are related to query strings
and are normal behavior.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights and Configure Portal Security Rights.

Related concepts
Create Portal Login Credentials (for a Customer)
Portal Sites
Site Items
About Document Repositories
OOTB IT Portal Sites
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Use a CSM Portal
Use a CSM Customer Portal to navigate and access your CSM data.

When working with a CSM Portal, users and customers can:

Related concepts
Define Display Properties for a Site
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Log in to a CSM Portal
The CSM Customer Portal can be configured so customers and users do not need to log in, but
functionality is limited until a login is complete.

To log in to a CSM Portal:

1. Navigate to http://server/CherwellPortal, where server is the location where CSM Web Applications
are installed.
This opens the default Site chosen by the system administrator.

Tip: To navigate to a specific Site, specify the Site in the URL (example: http://server/
CherwellPortal/Marketing.

2. Depending on the design of the CSM Portal, the user might need to select the Login link to log in to
the CSM Portal Site. Consider that not all portals and Sites require login.

3. Provide login credentials (user name and password).

Note: If Windows/LDAP login was enabled, provide the Windows credentials.

4. Select Login.
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Navigate to a Site
Navigate directly to a Site or use the Site Selector.

If a CSM Customer Portal contains multiple Sites, site options display in the Site Selector, which is located
in the CSM Portal application bar. The list of Sites varies depending on whether or not you are logged in,
which Sites the system administrator has chosen to expose using the Site Selector, and your security
rights.

You can also navigate to a Site directly by name using the URL http://server/CherwellPortal/SiteName,
where server is the server where the CSM Web Applications are installed and SiteName is the name of
the Site you want to visit. If you enter an invalid value or you omit the SiteName, you are taken to the
default Site.
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Log a CSM Portal Record
The CSM Customer Portal allows you to easily log Incidents and Requests using the Service Catalog.

There are two types of records you can log using the CSM Portal:

• Incident: An Incident is an unplanned interruption to a Service or a reduction in the quality of a
Service (example: Something is not working).

• Request: A Service Request is a request for information, advice, a Standard Change, or access to a
Service (example: Installation of new software). The Request Form in the CSM Portal will contain
different fields depending upon the type of service requested (example: New Device vs. Network
Request).

In the CSM Portal, Incidents and Service Requests (often called Requests) are stored together in the
Incident Business Object. The Categorization (Service/Category/Subcategory) identifies the record as
either an Incident or Request and is decided by the Service chosen in the Service Catalog. You can also
log an Incident or Request using the Affects Me Too link on a Problem logged by another customer or
user.

Related concepts
Affects Me Too
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Log a Portal Incident
Log an Incident from either the Service Catalog or a Configuration Item Form. You can log a Service
Request directly from the Service Catalog.

To log an Incident or Request from the Service Catalog:

1. In the Service Catalog, select Submit Incident or Request in the appropriate tile.
2. Complete the Incident Form.

There is a Rich Text Editor available for this section.

Note: To submit an Incident on behalf of another person, select the Submit on behalf of
another user check box.

3. Select the Submit button.

A window opens to notify you of the Incident ID number.

4. View the new Incident or Request by doing one of the following:
◦ Select the My Open Tickets tile to view the open Incident or Request in the My Incidents and

Open Requests section.
◦ Select the number next to Incident Tickets or Service Requests in the My Items section.

Remember: When you use the Submit on behalf of feature, you are the requester and the person
you're submitting the Incident for is the Incident owner. The Incident owner is the only one who
can edit or add attachments to the Incident. Ensure requesters understand this restriction so they
can include all relevant information prior to submitting the Incident.

Related concepts
About Rich Text
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Affects Me Too
Affects Me Too functionality is a way to log an Incident or Request that links to a similar, pre-existing
Problem in the Portal.

When the Affects Me Too link displays on a Problem, a new Incident or Request can be created with a
unique ID number simply by selecting the link.
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Navigate the CSM Portal Site Announcement Board
The Portal Announcement Board provides a collaborative environment for Customers to share information
in real time.

The Announcement Board can be customized using the Widget Manager.

On the Portal Announcement Board, users can View an Announcement Topic.

Related concepts
Managing Widgets
Related tasks
View an Announcement Topic
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View an Announcement Topic
View an Announcement topic from the Portal Announcement Board.

To view an Announcement in the Announcement Board:
On the home page, select an announcement link in the Announcements from the Service Desk section.
The Announcement topic opens.

On the Announcement topic page, users can:

• View the Message (a more detailed explanation of the problem/concern/announcement).

• Read the responses from other Customers and users.

• Add a Comment.

• See who posted the Announcement.

Related tasks
Add a Comment
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Create a New Announcement Topic
Create a new announcement topic to share information in real time.

To create a new announcement in the Announcement Board:

1. Select Charts and Items and then select My Items to open the My Items Dashboard.
2. Select the New Announcement link in the My Announcement Topics section.

The Announcement Topic page opens.
3. Specify the Subject.
4. Detail the question or concern in the Message field.
5. Select the Save button.
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Add a Comment
Add a comment to an Announcement topic to share additional information.

To add a comment from the Announcement Topic page:

1. Open an existing Announcement topic.
2. Select the Add a Comment link.

The Comment prompt opens.
3. Provide a comment.
4. Select OK.
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Navigate CSM Portal Knowledge Articles
Customers and users can access Knowledge Articles to help solve issues without having to log Incidents.

Find Knowledge Articles in the CSM Customer Portal:

• Using the Search Control.

• Using the Search Knowledge Base search bar on the CSM Portal home page.

• Using the Knowledge Article Dashboard. Open the Dashboard by selecting Charts and Items >
Knowledge Articles on the menu bar.

From a Knowledge Article, users can:

• Read through the article content.

• Allow users and other customers to know if an article resolved your issue:
◦ Select Yes if the article helped.

◦ Select No if the article did not help. The Incident is logged and a new window opens with the
Incident ID.

• Add a comment by selecting the Add Comment link.

Customers can view or hide comments using the vertical splitter bar.

• Vote on the Knowledge Article by selecting the Like this Article link to let other customers and
users know that the article was helpful or informative.

Related concepts
CSM Desktop Client Quick Search Widget
Form Splitters
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Create a Knowledge Article in the Portal
By default, only members of the Portal Workgroup Manager Security Group have the rights to create new
Knowledge Articles in the Portal.

To create a new Knowledge Article in the Portal:

1. In the OOTB IT Portal Site, open the Knowledge Article Dashboard by selecting Charts and Items
> Knowledge Articles on the menu bar.

2. Select the Create a Knowledge Article link in the Search Knowledge Articles section. If the link is
not visible, review your Security Rights.

3. Select an Article Type.
4. Provide a Title and the Article Content.
5. Select Save.

Related concepts
About Security Groups
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View Knowledge Articles as Anonymous User
If enabled, Anonymous Users can view knowledge articles to help solve issues without having to log in to
the CSM Portal.

To view knowledge articles as an Anonymous User:

1. Open a browser and navigate to the CSM Portal Home page.
2. In the Search field, type one or more keyword(s) related to a knowledge article you want to view

and press Enter.
3. In the search results, select the link to the knowledge article you want to view.

Note: Anonymous users can only view records. Login is required for users who want to
interact with or edit records in the Portal.
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Design a Portal
Useful tips and consideration when designing a Portal.

Portal design is important. Before creating a Portal:

• Answer questions about audience, scope, and purpose.

• Review Portal design tips.

• Consider how CSM features, such as Security and Site Items play into design.

• Start with the OOTB IT Portal Site for design ideas.

Related concepts
Portal Design Worksheet
Portal Design Tips
Portal Design Considerations
Portal Site Design Ideas
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Portal Design Worksheet
Use the Portal design worksheet to assist you in creating a Portal.

Before creating a Portal, you should ask yourself some basic questions to help drive the design.

 Question Consideration

1. Who is your audience (in other words, who are your Customers)?

a. Are your Customers internal
employees? External? Both?

• Portal login credentials.

• Anonymous login/Security Groups.

b.

Are your Customers
experienced? IT personnel who
can complete tasks by
themselves? Novice Customers
who need guidance? Both?

• Number of Sites (single Site or one for each expertise
level).

• Site Item and navigation design (simple or sophisticated).

• Portal Views (personalize and secure what Customers
see).

• Automation (Add One-Step Actions/Actions to simplify
tasks).

 

Tip: Expose Customers only to the information they need.

c.

Do your Customers have
different interests (different
Teams/different responsibilities
(example: General Status for
Managers, Requesters of IT.)

d. Are your Customers
International? • Localization.

2. What will your Customers need to do in the Portal?

a.

Will your Customers view/
monitor data (Reports,
Dashboards)? Interact with data
(Action Catalog/create Incident
or Service Request)? Both?

• Add data-driven Site Items (Reports, Dashboards,
Document Repositories) or action-driven Site Items
(Actions to create/edit records, run One-Step Actions,
launch CSM Managers).

• Security Groups/security rights (View, Create, Delete).

• Record ownership.

• License consumption.

b

What activities do your
Customers need on a Site
(example: run a Report, create
an Incident, access documents
(Doc Repository)?

• Create Site Items that deliver what Customers need most.

• Make information easy to find (Startup Item should be
informative).
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 Question Consideration

c. Will your Customers need
searching capabilities?

• Display a Search Control.

• Display Saved Searches to automate Common searches.

• Add an Action to display the Search Manager (allows
custom Searches).

d. Will your Customers need to
access documents? • Display a Document Repository.

e. Will your Customers need to
access other websites? • Display an External HTML page or an External Site.

3. Will your Customers need access to data other than their own?

a.
Will your Customers need to
view/edit other Customers'
records?

• Record ownership.

• License consumption.

4. Will different Customers need different Security?

a. Will you allow Customers to
access data without logging in?

• Anonymous login/Security Groups.

• Different Startup Items for logged-in/anonymous
Customers.

b. Will you require a login? • Customers will need Portal login credentials.

c.
Will some Customers need view-
only rights? Will some need edit
rights?

• Anonymous login/Security Groups.

Note: For more information about considerations
and some helpful design tips, see Portal Design
Considerations and Portal Design Tips. For more
information about Security (Security Groups,
license consumption, scope) refer to the Security
documentation. For more information about Site
Items (including how to create each), see their
respective documentation.

Related concepts
Create Portal Login Credentials (for a Customer)
Anonymous Security Group
Site Items
Portal License Consumption
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Record Ownership
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Portal Design Tips
Use the Portal design tips for useful information and recommendations.

The following are some tips to help design a Portal that meets the needs of your Service Desk and your
Customers:

• Make it easy to find: Layout and navigation are important. Strategically place important information
or commonly-accessed Services in obvious places. Use tables, bullets, columns, and headings to
elegantly organize information into logical and clearly-labeled groupings. Enhance navigation by
using an intuitive menu bar, Actions, and links.

• Make it easy to use: Keep it simple. Simplify Forms and Service Catalogs so that Customers are
only exposed to the information they need. Use Customer-friendly language so that Customers feel
comfortable with the content. Automate common tasks using One-Step Actions/Actions and
templates.

• Make it personal: The Portal is highly customizable so make each Customer's experience relevant
and personal. Create custom Dashboards and Forms, expose only relevant Services and
Knowledge Articles, dazzle Customers with meaningful graphics, colors, and logos.

• Make it enticing: Do not underestimate the visual experience. Employ visual elements, such as
graphics, symbols, and colors, to convey information and embellish the aesthetic. Use consistent,
browser-friendly fonts and colors (or themes) to ensure stability and cohesion.

• Make the Startup Items count: Your Startup Items set the tone for your Portal and Sites. Select an
Out-of-the-Box (OOTB) IT Portal Site that effectively introduces your Portal. Designate a Site
Startup Item that immediately communicates the purpose of your Site and provides clear access to
common Actions. For example, select an Action Catalog that clearly communicate your Service
offerings or a Dashboard that provides status, common Actions, and links.

• Proactively share: Post Advisories and Bulletins (Known Errors, outages, and solutions) to help
avoid potential issues. Set expectations by communicating your Services and policies to avoid
confusion and misunderstandings.
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Portal Design Considerations
Use these tips when designing a Portal.

• Customer Security Groups: Users (Service Desk professionals working in CSM) and customers
(End-Users using the CSM Portal to conduct self-service activities) perform different functions in
CSM and, therefore, require different security.

• Security rights: Security rights control access to CSM functionality and data. For example, to
create a Dashboard, you must have security rights to access the Dashboard Manager (functionality).
To view, add, edit, or delete the Description Field in an Incident record, you must have security rights
to access the Incident Business Object and the Description field (data). For more information, see
Security Rights.

• Anonymous Access (allow Customers to access Portal data without logging in): CSM
provides an Anonymous Security Group for customers who need to access the Portal without
logging in. The Portal Client uses this Anonymous Security Group to define security rights for those
anonymous customers.

• Portal Views: Use a Portal Form View to create customer-specific versions of your forms. A Portal
View allows you to expose data to customers in a more secure and customer-friendly way.

• Record ownership: Access to records is controlled through record ownership. Typically, customers
own and can access their own records. However, record ownership rights can be extended to
managers, Workgroups, and Workgroup managers so that customers can update records that are
owned by another customer.

• License consumption: Customers can view, create, and edit their own records without consuming
a license. With security rights, a customer can also view, and in some cases, edit (through a One-
Step Action) another customer's records without consuming a license. For more information, see
Portal License Consumption.

• Site scope: CSM provides a Site scope, which allows you to limit CSM Items (Dashboards,
Reports, One-Step Actions) to a specific Portal Site.

• Startup Site Items: Each Site has a designated Startup Item (example: a Dashboard) which is
displayed by default when the Site is first accessed. If desired, a different Startup Item can be
displayed upon login so that information can be more securely or appropriately filtered based on
credentials. For more information, see Site Items.

• External Sites: The Portal can link to external websites using a simple link to a URL.

Related concepts
About Security
About Security Groups
Form Views
Security Considerations
External Portal Sites
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Portal License Consumption
A Customer can view, create, and edit their own records without consuming a license.

With security rights, a Customer can also view, and in some cases, use a One-Step Action to edit another
Customer's records without consuming a license.

CSM notifies the Customer when a concurrent license is necessary. If the Customer does not have rights
to consume a license, they will be told that they cannot edit the record.

Note: A Site can be configured to always use a license. (This might be done for a management-
focused Site where it is assumed that all work is done against other Customer's records).

Portal License consumption rules:

• A Customer logging in to CSM through the Portal to view/edit their own records (they are the
Customer Record owner, meaning they are the Requester/Initiator and is associated with the record)
does not consume one of the concurrent licenses.

• A Customer logging in to CSM through the Portal to access someone else's records (they are not
the Requester but has been granted access rights) does not consume a license to view the record
but does consume a license to edit a record.

• A Customer can run some One-Step Actions without consuming a license:
◦ One-Step Actions Actions that do not alter data can be run without consuming a license

(example: Send an email).

◦ One-Step Actions Actions that do alter data can be run against records owned by the
Requester without consuming a license.

◦ One-Step Actions Actions that alter data generally consume a license when run against a
record owned by someone other than the Requester. However, there are a handful of
situations where a One-Step Action is allowed to change another Requester’s record without
consuming a license:

◦ Creating a journal entry: For example, allowing a Customer to provide feedback on an
Incident or Knowledge Article even if they are not an owner/requester.

◦ Rating a record: Toggling a logical field or incrementing the count in a numeric field
(example: Allowing a Customer to vote on whether or not they liked a Knowledge
Article). The Field must be appropriately configured by the administrator to hold a rating
value.

Related concepts
License Consumption
Security
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External Portal Sites
The Portal can link to external websites using a simple URL.

This helps make all of your Customer-facing Sites feel more integrated because CSM and non-CSM Sites
show up next to each other. For example, incorporate your organization's website or a department's
website into the Portal, or add a website that supports your hardware.

Note: The way your CSM Portal is accessed (via HTTPS or HTTP) will affect the display of an
embedded HTML page.

Related concepts
HTML Pages Good to Know
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Portal Site Design Ideas
CSM provides an OOTB IT Portal Site to get started.

This OOTB IT Portal Site is built using OOTB Site Items (Dashboards, Forms) and predefined properties
(Startup item, header/footer, menu bar). You can use this OOTB IT Portal Site as provided, or tailor it to
meet the needs of your organization. Design ideas include:

• Edit the site display for logged-in and not logged-in modes.

• Edit the banner.

• Edit display options for the footer.

• Display your organization logo in the banner and/or footer.

• Display organization Business Hours.

Related concepts
OOTB IT Portal Sites
Site Items
Edit a Site
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Implement a Portal
Use these steps to implement the OOTB IT Portal Site.

Complete the following steps to implement the OOTB IT Portal Site:

1. Review the OOTB IT Portal Site. Understand the OOTB Site Items (Dashboards, the Service
Catalog, the Discussion Board, the Document Repository) and the OOTB properties (header/footer,
menu bar).

2. Configure required Portal settings:
a. Configure the Portal URL.

b. Set the default domain in CSM Administrator.

c. Create Portal login credentials (for a Customer). Typically, this is done as part of the Security
setup.

Note: CSM provides other default settings (example: Anonymous login, password
enforcement rules); you can change these, if needed, but it is not required.

3. (Optional) Explore ideas for Portal Site design. For more information, see Portal Site design ideas.

4. (Optional) See ideas for creating a custom Portal. For more information, see Create a custom
Portal.

Related concepts
OOTB IT Portal Sites
About the Service Catalog
Configure Browser Application Settings (URLs, Timeouts, RSS Feeds)
Define the Default Domain and Anonymous Login Settings
Configure Login, Authentication, and Inactivity Settings for the Portal and Browser Client
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Create a Custom Portal
You can use these options or create a Portal from scratch.

We recommend starting with this design and then customizing it to your specific needs. However, users
can create a Portal from scratch, if needed.

To create a custom Portal:

1. Design the Portal (Site items, navigation, security).

2. Create the Site Items to include on each Site. Users can include the following:
◦ Business Objects and records. For more information, see Business Objects/records.

◦ Actions. For more information, see About Portal Actions.

◦ Action Catalogs. For more information, see About Portal Action Catalogs.

◦ Dashboards and Widgets. For more information, see About Portal Dashboards and Widgets.

◦ Document Repositories. For more information, see About Document Repositories.

◦ HTML Pages. For more information, see About HTML Pages.

◦ Reports. For more information, see About Reporting.

◦ Saved Searches. For more information, see About Saved Searches.

◦ Searching. For more information, see About Searching (rich searching, combined searches
and results).

3. Run the Site Wizard to create one or more cursory Sites: Create cursory layout and characteristics
for the Site (title, Business Object associations, display, and Document Repository association).

4. Refine/edit Sites using the Site Editor and Site Properties window: Refine the way the Site/Site
Items look and behave. For more information, see Refine/Edit a Site.

5. Configure the Portal. For more information, see Configure a Portal (settings, login credentials,
password enforcement rules).

Related concepts
Portal Sites
Design a Portal
Portal Site Design Ideas
Steps to Implement the OOTB IT Portal
Related tasks
Create a Site Using the Site Wizard
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Build and Manage a Portal
Use the Site Manager and Site Wizard to help you build and manage a Portal.

Portals are highly configurable. When you create your Portal, you decide how many Sites to create, which
Site displays by default, how each Site looks, which Site Items are displayed on each Site, and who can
access each Site/Item.

To help create and manage your Portal, CSM provides the:

• Site Manager: Helps manage Sites.

• Site Wizard: Walks through the steps to create a cursory Site.

• Site Editor and Site Properties window: Help edit/refine the way Site/Site Items look and behave.

• CSM Item Managers: Help manage Site Items, such as Dashboards, HTML pages, and Document
Repositories.

Note: Good design is important. Before creating a Portal, see our recommendations on how
to design a Portal.

Related concepts
Site Manager
Design a Portal
Related tasks
Create a Site Using the Site Wizard

187

CSM 10.0.0 Client Suite

CSM 10.0.0 Client Suite

https://help.cherwell.com/bundle/csm_client_suite_10_help_only/page/content%2Fclient_suite%2F..%2F..%2Fcontent%2Fclient_suite%2Fsite_manager.html
https://help.cherwell.com/bundle/csm_client_suite_10_help_only/page/content%2Fclient_suite%2F..%2F..%2Fcontent%2Fclient_suite%2Fdesigning_a_portal.html
https://help.cherwell.com/bundle/csm_client_suite_10_help_only/page/content%2Fclient_suite%2F..%2F..%2Fcontent%2Fclient_suite%2Fcreate_a_site_using_the_site_wizard.html


Site Manager
Use the Site Manager to complete general CSM Item Manager operations for Sites.

You can also mark a Site as the default Site for the Portal.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Manager tree:
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Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

5. Main Pane:

Displays items by View (Icon, List, or Details [Grid]) and lists search results when a Search is run.

Related concepts
CSM Item Manager Main Window (Typical)
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Open the Site Manager
Open the Site Manager from CSM Administrator.

To open the Site Manager:

• In the Blueprint or mApp Editor menu bar, select Managers > Site Manager.
• In the CSM Administrator main window, select Browser and Mobile > Site Manager.

Related concepts
Blueprint Editor Menu Bar
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Create a Site
The Site Wizard helps you create a basic working Portal.

The Site Editor/Site Properties window helps you add refinement. You can skip refinement, if needed, or
you can select Finish at any time in the Wizard and go straight to refining.

To create a Site:

1. Run the Site Wizard to create a cursory Site: Create cursory layout and characteristics for your Site
(title, Business Object associations, display, and Document Repository association).

2. Refine/edit your Site using the Site Editor and Site Properties window: Refine the way your Site/Site
Items look and behave.

a. Define general properties for the Site: Define the name and title, login requirements, record
ownership, the Business Object/record associations (which Business Objects/records the
Customers can interact with), and the Document Repository association.

b. Define display properties for the Site: Define appearance (color/theme), Startup Site Items,
and search capabilities.

c. Define Banner properties for the Site: Define what the Site Banner looks like (background
color and image, and Banner image) and what text displays on it (title, subtitle, and baseline).

d. Define Footer properties for the Site: Define what the Site Footer looks like (background color
and image, and Footer image) and what text displays on it (title, subtitle, and baseline).

e. Define menu properties for the Site: Define which Site Items display on the Site menu bar, and
which Actions a Customer can initiate from each.

f. Define Localization properties for the Site: Select a default language and override options for
translated Sites.

Related concepts
Edit a Site
Site Items
About Portal Actions
Related tasks
Create a Site Using the Site Wizard
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Create a Site Using the Site Wizard
Use the Site Wizard to walk through steps to create a Site.

To create a Site using the Site Wizard:

1. Open the Site Manager.
2. Select the Create New button, and then select Site.

Note: To create an External Site, one that simply displays an existing website, select
External Site. The External Site window opens to provide the URL and other options.

3. Select Next.
4. Define basic properties for the Site:

a. Specify a title for the Site that displays in the Banner.
The Name and Description initially include text that you can refine later. The Name becomes
part of the URL for referencing this Site in a browser. The Description is shown in the Site
Selector when Customers switch between Sites.

b. Select a Theme (set of fonts, colors, and options) to be used by different elements. Using a
Theme simplifies the cohesive look. You can change the Theme at any time, which
automatically updates the various elements.
If the Theme is changed, refresh the browser to view the changes.

c. Select Banner image to launch the Image Manager, and then select an image to display on
the Site Banner. You can select an existing image or import a new image.

5. Select Next.
6. Select the Business Objects/records to include on the Site:

Note: These are the Business Objects with which you want your Customers to interact. For
example, if you want Customers to be able to view or create Incident records, select the
Incident Business Object.

a. Select Add to include Business Objects/records on the Site.

Tip: Use the up and down arrows   to order the Business Objects on the Site
menu bar and to indicate the relative importance of a Business Object on the Site.
Select Remove to remove a selected Business Object from the Site.

b. Select the Add newly associated objects to site menu check box to automatically add the
associated Business Object to the Site's menu bar.

Note: When you add a Business Object to the Site's menu bar, CSM adds a Business
Object menu option and some Out-of-the-Box (OOTB) Business Object Actions. For
example, if you add Incident to the menu bar, CSM adds an Action to create a new Incident,
as well as Actions to launch some Incident searches (My Open, Closed, and Recent
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Incidents). You can use these Actions, modify them, or create your own when you define the
menu properties.

7. Select Next.
8. Select the Document Repository to include on the Site:

Tip: You can use multiple Document Repositories on a single Site. Within the Site Editor,
you can add an Action to display another Document Repository on the Site menu bar.

◦ Select Create new document repository named to create a new Document Repository for
this Site. Then, name the Document Repository (or leave the auto-generated name).

◦ Select Associate an existing document repository to use an existing Document Repository

for the Site. Select the Ellipses  to open the Document Repository Manager, and then
select an existing Document Repository or create a new Document Repository.

◦ Select Do not associate a document repository if you do not want to use a Document
Repository on the Site.

9. Select Next.
10. Select a Startup Site Item from the following:

a. Select Dashboard to display a Dashboard on startup. Select the Ellipses to open the
Dashboard Manager, and then select an existing Dashboard or create a new Dashboard.

b. Select Page to display an HTML page on startup. Select the Ellipses to open the HTML Page
Manager, and then select an existing HTML page (or create a new internal or external HTML
page).

Note: The way your CSM Browser Client is accessed (via HTTPS or HTTP) will affect
the display of an embedded HTML page. For more information, see HTML Pages
Good to Know.

c. Select Other to display an Action Catalog Widget, a Document Repository, a Report, or a
Saved Search on startup. Select the item's Ellipses to open the Action Manager, and then
select an existing item.

d. Select The site requires the user to log check box to require Customers to log into the Site.
If you do not require a login, you can specify a different Startup Item for when the Customer
does log in.

Note: A license is consumed when a Customer logs in.

11. Select Finish.

Related concepts
Open the Site Manager
External Portal Sites
About Portal Actions
Action Manager
Related tasks
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Define Menu Bar Properties for a Portal Site
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Edit a Site
Edit a Site to customize it based on your preferences.

Use the Site Editor and Site Properties window (both accessed from within the Site Manager) to edit a
Portal Site and its Site Items.

Related concepts
Site Manager
Portal Sites
Site Items
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Define General Properties for a Site
Use the General Properties page to edit basic Site features that may have initially been defined in the Site
Wizard. Edit and customize the Site title, login requirements, document repository association, and
Business Object association.

To define General properties for a Site:

1. Open a Site in the Site Editor (CSM Administrator > Site Manager > Portal Site Name).
2. Select the General page.
3. Define general properties for the Site:

a. Title: Provide a title to display in the Portal UI. The Site title and Banner title were intially
created in the Site Wizard, but can be edited here.

b. Description: Provide a description to display in the Portal UI.
4. Define access options for the Site:

a. Show in Site Selectors: Select this check box to include the Site name in the Site Selector
drop-down list. The Site Selector is located on the Site Application Bar in the Portal Main
Page.

b. Require login for access to site: Select this check box to require users to login to the Site.
c. Acquire a license at login (so editing other users' records will not require a prompt): Select this

check box to acquire a license for the user upon login.
d. Acquire a license on edit (suppress prompt): Select this check box to acquire a license for the

user upon editing another user's record while suppressing the prompt to acquire the license
(example: A Site intended for managers that are editing other user records).

5. Select Business Objects to associate with the Site:
a. Select the Add button
b. Select a Business Object from the list. Choose Business Objects for users to interact with

(example: If a user needs to view or create Incident records from the Site, select the Incident
Business Object).

c. Repeat Steps A and B for all desired Business Objects.
d. Add newly associated objects to site menu: Select the check box to automatically add

associated Business Objects to the Site's menu bar.
6. Select a Document Repository to include on the Site.

a. Select the Associate an Existing Document Repository check box.
b. Select the Ellipses. The Document Repository Manager opens.
c. Select an existing Document Repository or create a new Document Repository.
d. Select OK to close the Document Repository Manager.

7. Select Save to close the Site Editor.

Related concepts
About Document Repositories
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Configure the CSM Portal Site to Allow Anonymous
Access

To allow Anonymous access, the CSM Portal Site must be configured so that it does not require login.

To configure the CSM Portal Site to allow Anonymous access:

1. In CSM Administrator, select Browser and Mobile > Site Manager
2. Right-click on the Site designed as your CSM Portal and select Edit.
3. In the General tab, clear the Require login for access to site check box.
4. Select Save.

Related concepts
Anonymous Security Group
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Define Display Properties for a Site
Use the Display Properties page to specify startup Site items, login options, search capabilities, browser
tab images, and custom documentation. The Display page can also be used to further refine the Site's
appearance and Theme.

Define General Appearance Properties
To define appearance properties for a Site:

1. In CSM Administrator, select Site Manager to open your CSM Portal Site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. In the Appearance section, define the following:
a. From the Theme drop-down list, select a theme to define sets of colors, styles, and fonts for

the Site.

b. From the Use Background drop-down list, select a color to define the Site's background color.
For best results, use From Theme as the background color.

c. Select the Show Site Selector on application bar check box to display the Site Selector
drop-down list on the Portal Application Bar.

d. From the Keep menu visible when scrolling drop-down list, choose to keep the Site menu
bar visible or hidden to when user's scroll. You can also choose to keep the menu bar visible
for mobile devices only.

5. Select Save.

Define Browser Tab Properties
To add a custom image to your Site's browser tab:

1. In CSM Administrator, select Site Manager to open your CSM Portal Site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. Select the Use Favicon check box.

5. Select the Ellipses. The Image Manager opens.

6. Upload a new image or choose an existing image:
a. Select the New button to upload a new image (example: your company logo).

Note: Favicon images have a size limit of 512K. An error message appears if the
uploaded image is too large.

b. Select an existing image from the Image Manager. The name of the selected image populates
the Favicon field.
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7. Select Save to close the Site Properties page.

Define Site Startup and Login Options
Define items that appear on Site startup, as well as items that appear after a user has logged in.

The options you set on the Display page apply to the Site's default language. You can customize startup
and login actions for each Site language.

To define startup options:

1. In CSM Administrator, select Site Manager to open your CSM Portal Site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. In the Startup section, define the following:
a. Select the Ellipses to the right of the Show on startup to select a Site Item to display when a

user initially accesses the Site. Site Items include Widgets, Dashboards, Reports, HTML
pages, or Saved Searches.

b. Select the Show on login check box to display a different Site Item when users log in. Then,
select the Ellipses to select a Site Item.

c. From the View drop-down list, select the View to control the behavior and appearance of
Business Objects within the Site. Options include:

◦ Role-based: Based on the default Role associated with the user's Security Group.
Different users see different Business Object Forms based on security.

◦ Portal Default: Provides the OOTB Portal View for Business Objects within the Site.

◦ Portal Secondary: A View option for smaller, secondary Sites that may supplement or
support your main Site.

◦ Default: The Default Site View is not recommended because it also displays technician
forms, which are not relevant for Site users.

5. Select Save.

Define Login Options
Customize what users see on when they log in to the Portal site.

To define login options:

1. In CSM Administrator, select Site Manager to open your CSM Portal Site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. Select the Login Options button.

5. In the Text to display on login dialog box, provide a custom message for users when they log in to
the Site.
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6. Select the Show privacy link in login dialog check box to display a link to a Privacy statement,
then provide text for the link and the URL to the Privacy document.

7. Select the Custom avatar image button to open the Image Manager, then select default images to
display for a non-logged-in Customer and a Customer without an assigned avatar.

8. Select the Redirect User on Logout check box to automatically redirect Customers to a specified
URL when they log out of the Portal. Then, provide the URL or select the Browse button and select
a website where Customers will be redirected after logging out of the Portal.

9. Select Save.

Define Search Control Options
The options you set on the Display page apply to the Site's default language. You can customize Search
Control for each Site language.

To customize Search Control Options:

1. In CSM Administrator, select Site Manager to open your CSM Portal Site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. In the Search area, select one of the following options:
a. Use default: Select this option to use the Search Control options that are based on the list of

Associated Business Objects from the General page.

b. Use search widget: Select this option to use a custom Search Widget. Select the Ellipses to
open the Widget Manager, and then select a Widget.

c. No search: Select this option to omit searching from this Site by removing the Search Control.
You can still create Search Widgets and place them on Dashboards to allow for target
searching.

5. Select the Require login before showing search results (excluding Dashboards) check box to
require a user to login before performing a search. If a Search is performed without requiring the
user to login, the Search results are based on security rights of the Anonymous Security Group.

6. Select Save.

Disable or Enable Custom Portal Documentation
By default, the CSM Portal links users to the default Cherwell online documentation system. Due to the
highly configurable nature of the CSM Portal, a Customer may choose to disable this feature or link to a
custom online documentation system.

To disable default CSM Portal documentation:

1. In CSM Administrator, select Site Manager to open your CSM Portal Site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. Clear the Show help button check box to remove the default help button from the CSM Portal.
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5. Select Save.

To enable custom CSM Portal documentation:

1. In CSM Administrator, select Site Manager to open your CSM Portal Site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. Select the Use custom URL option.

5. Provide an alternate URL in the Help URL field (example: a link to an internal documentation
system or training documents). This URL replaces the default Cherwell online documentation
system URL.

Important: The URL must be a full URL (example: https://www.sample.com) and not a
partial URL (example: sample.com).

6. Select Save.

Related concepts
Anonymous Security Group
Related tasks
Define Localization Properties for a Site
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Define Banner Properties for a Site
Use the Banner Properties page to edit the Site Banner. Some aspects of the Banner may have initially
been defined in the Site Wizard. Edit and customize the Banner size, color, fonts, and associated images.

To define Banner properties for a Site:

1. Open a Site in the Site Editor (CSM Administrator > Site Manager > Portal Site Name).
2. Select the Banner page.
3. Select the Show Header check box to display a Banner at the top of the Site.
4. Define a Banner background by doing one of the following:

◦ Select the Color Selector button to select a background Banner color.
◦ Select the Image button to select an image to use as the Banner background.

5. Define a Banner image (example: your company's logo):
a. Select the Browse button. The Image Manager opens.
b. Select an image.
c. Select OK.
d. Provide pixel dimensions for the image in the Size field.
e. Select the Align drop down list to edit the alignment of the image within the Site Banner.

6. Provide a Title for the Site in the title field.
7. Select the Image Selector button in the Title area to change the color of the title.
8. Provide a Subtitle for the Site in the subtitle field.
9. Select the Image Selector button in the Subtitle area to change the color of the subtitle.

10. (Optional): Provide any additional text for the Site Banner in the Baseline Text field (example:
copyright notices).

11. Define a Hamburger Menu image (example: your company's logo):
a. Select the Browse button. The Image Manager opens.
b. Select an image.
c. Select OK. The selected image appears in the Hamburger Menu image preview field.

Note: CSM automatically scales images to a height of 25 pixels. The hamburger menu
bar replaces the Portal menu bar on mobile screens and browser windows sized below
768 pixels.

12. (Optional): Select the Fixed Height check box to make the Banner a fixed, specified height. If
cleared, the Banner resizes to accommodate selected text, images, and margins.

13. (Optional): Select the Extend Banner fo Application Bar check box to automatically resize the
Banner based on the Site's Application Bar.

14. Select the Margins button to define top, bottom, right, and left margins around Site text.
15. Select Save.
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Define Footer Properties for a Site
Use the Footer Properties page to define background color, images, text, font, and Footer size.

The Site Footer is located at the bottom of the Site, and can provide additional general information (such
as a copyright notice) or aesthetic value. Use a Site's Footer Properties page to define:

• What the Footer looks like (background color and image, and Footer image).

• What and how text displays on the Footer (title, subtitle, and baseline text, fonts, and colors).

• The Footer's height and position (relative to a margin).

To define Footer properties for a Site:

1. Open a Site in the Site Editor (CSM Administrator > Site Manager > Portal Site Name).
2. Select the Footer page.
3. Select the Show Footer check box to display a Footer at the bottom of the Site.
4. Define a Footer background by doing one of the following:

◦ Select the Color Selector button to select a background Banner color.
◦ Select the Image button to select an image to use as the Banner background.

5. Define a Footer image (example: your company's logo):
a. Select the Browse button. The Image Manager opens.
b. Select an image.
c. Select OK.
d. Provide pixel dimensions for the image in the Size field.
e. Select the Align drop down list to edit the alignment of the image within the Site Banner.

6. Provide a Title for the Site Footer in the title field.
7. Select the Image Selector button in the Title area to change the color of the title.
8. Provide a Subtitle for the Site in the subtitle field.
9. Select the Image Selector button in the Subtitle area to change the color of the subtitle.

10. (Optional): Provide any additional text for the Site Footer in the Baseline Text field (example:
copyright notices).

11. (Optional): Select the Fixed Height check box to make the Footer a fixed, specified height. If
cleared, the Footer resizes to accommodate selected text, images, and margins.

12. Select the Margins button to define top, bottom, right, and left margins around Site text.
13. Select Save.
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Define Menu Bar Properties for a Portal Site
Use the Site Menu Properties page to define menu items, Actions, tooltips, Expressions, and Security
options for the Site menu bar.

The Site menu bar is located below the Banner and lists the Site Items, as well as any Actions that
support the items. Use a Site's Menu Properties page to define:

• Which Site Items display as menu items on the Site menu bar.

• Which Action the menu item initiates: Display a Dashboard, Service Catalog, or Document
Repository; run a report, display a record.

• The Help text that displays on the menu item's tooltip.

• Expressions for showing/hiding and enabling/disabling menu items.

• Security options for showing/hiding and enabling/disabling menu items: For example, Always show,
show only for Anonymous (not logged-in Customers), or show only for Logged-in Customers.

• Display options (separators) for groups of menu items.

Related concepts
Define Business Object Actions
Refine/Edit a Site Reference
About Actions
Create Portal Login Credentials (for a Customer)Add Menu Items to Site Menu Bar

To add menu items and define menu item properties:

1. Open a Site in the Site Editor (CSM Administrator > Site Mananger > Portal Site Name)
2. Select the Menu page.
3. Select the Show Menu check box to add a menu bar to the Site.
4. Select the Add Action button.
5. Select an Action to add to the menu bar.
6. Define general properties for selected Action:

a. Action name: Cannot be changed, displays the name of the selected Action.
b. Display text: Specify the text to display in the menu bar.
c. Select the Image Manager button.
d. Select an existing image or import a new image to represent the Action in the menu bar

(example: a house icon for Home).
e. Help text: Specify a tool tip to display when the cursor is on the menu item.

7. (Optional): Define an Expression to display in the menu bar:
a. Select the Visible check box. An Expression can still be imported if this check box is cleared.

If so, the Expression still runs in the background and is not visible in the menu bar.
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b. Select the Ellipses to import an existing expression or select the Custom Expression button
to create a new expression. Imported expressions populate the Visible Expression drop-down
list.

8. (Optional): Define an Expression to enable or disable an item in the menu bar:
a. Select the Enabled check box.
b. Select the Ellipses to import an existing expression or select the Custom Expression button

to create a new expression. Imported expressions populate the Visible Expression drop-down
list.

9. Select security options from the drop-down lists to define rights for displaying, enabling, or disabling
the menu item:

◦ Visible: Select whether menu items are visible for all Portal Customers (Always), only Logged-
In Portal Customers (Logged-in Only), or only Portal Customers who are not logged in
(Anonymous Only).

◦ Enabled: Select whether menu items are enabled for all Portal Customers (Always), only
Logged-In Portal Customers (Logged-in Only), or only Portal Customers who are not logged in
(Anonymous Only).

◦ Rights: Assign Portal rights to make menu items visible/enabled for a Customer Security
Group.

10. (Optional): Select the Begin Group check box to display a horizontal line before menu items on
sub-menus to separate the sub-menu from other items.

11. Select the Show toolbars check box to show/hide toolbars on Business Object Forms within the
Portal Site.

12. Repeat Steps 4-10 for all desired menu items. Selected menu items populate the left-hand Action
pane.

13. Select Save.
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Define Localization Properties for a Site
Use the Localization page to select the default language for a Site and to override the startup action, login
action, and custom Search Widget for each Site translation.

To define Localization properties for a Site:

1. Open a Site in the Site Editor (CSM Administrator > Site Manager > Portal Site Name).
2. Select Edit.

The Site Properties page opens.
3. Select the Localization page.
4. From the Default Language drop-down list, select the default language to display in the Language

Selector on the Site Application Bar.
5. Select the Show language selector on application bar check box to show the language selector

for the Site; clear the check box to hide the language selector.
6. Select Save.

Related concepts
Define Display Properties for a Site
Translating Strings for Portal Sites
Using Language Packs to Translate Portal StringsOverride Site Options for Each Language

By default, each Site uses the startup action, login action, and custom Search Widget defined on the
Display Properties page. You can override these options for each language.

To override Site options for a language:

1. Open a Site in the Site Editor (CSM Administrator > Site Manager > Portal Site Name).
2. Select Edit.

The Site Properties page opens.
3. Select the Localization page.
4. Select the language you want to override, and then select Edit.
5. From the View drop-down list, select custom Views you may have defined for the language. If you

use a Role-based View, the View associated with an appropriately assigned language is used.
6. Select the Custom Startup Action check box, and then select the startup action for the translated

Site. For example, if you have a translated Dashboard or HTML Page, you can select that.
7. Select the Custom login action check box, and then select the login action for the translated Site.
8. Select the Login options button to override login options for the translated Site. For example, you

can set alternative text or a Privacy Link on the login window.
9. Select OK.

10. Select Save.
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Refine/Edit a Site Reference
Additional details for refining and editing a Site.

Available Menu Bar Actions
The following are Actions that can be added to the menu bar:

• One-Step™ Action: Runs a One-Step Action. You can choose to run an existing One-Step Action or
create a new One-Step Action.

• Command: Runs a system command applicable to the Portal. Categories include:
◦ Managers: Adds a command to launch an Item Manager so a Customer can choose an item to

open/run (example: Add the Report Manager to the Site menu bar so Customers can choose
to run an available Report).

◦ Recent Items: Provides a Recent Items list that displays the last five (5) items of the specified
type selected by the Customer (example: the last five Reports run by the Customer). This
makes sense if you made the Manager available.

Note: Recent Items lists must be placed inside folders (they cannot be at the top level
of the Site menu bar), and it is recommend that they be placed as the last item in the
folder.

◦ Chat: Includes commands related to remote support services (example: BeyondTrust) (only
available if you have Chat and Remote Support Connector Settings enabled in CSM
Administrator).

◦ (Other) Business Object Search: Provides common Site searches (example: Business Object
to search, how the results should be sorted, whether to limit to the current Customer, and limit
to Open or Closed records).

◦ (Other) Create Business Object: Creates a new Business Object (record) but with several
powerful options, such as a One-Step Action to run as part of the creation process and
whether a custom Form should be displayed (which can be different than the OOTB Form
used for viewing a Business Object).

◦ (Other) Go to Edit Mode: Puts a Business Object record into edit mode so that a Customer or
user can immediately edit it. This command is designed to be used in an Execute Command
One-Step Action, which is the automated equivalent of a Customer or user selecting the Edit
button in the Portal.

◦ (Other) Home: Takes the Customer to the Startup Item (Dashboard, HTML page).

◦ (Other) New Bus Ob Drop-down list: Automatic command that displays a default list of create
commands for all Associated Business Objects for the Site.

Note: This command must be placed in a folder.

• Dashboard: Displays a Dashboard. You can display an existing Dashboard or create a new
Dashboard.
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• Report: Runs a Report. You can run an existing Report or create a new Report.

• Search: Runs a Saved Search. You can run an existing Saved Search or create a new Saved
Search.

• Page: Displays an HTML page. You can display an existing HTML page or create a new HTML
page.

• Document Repository: You can display an existing Document Repository or create a new Document
Repository.

• Action Catalog: Displays an Action Catalog. You can display an existing Action Catalog or create a
new Action Catalog.

• Folder: Adds a folder to the toolbar so that you can organize Actions into another level.

Note: Some Actions also allow you to limit scope and Associated Business Object (select
the activated Options button). We recommend that you limit Customers to just the Site scope
and make items available in just that scope.

Available Site Items
Available Site Items that can be selected for a Portal Site include:

• Action Catalog, (special Widget), a Dashboard, a Document Repository, an HTML page, a Report,
or a Saved Search (used to display a list of records). For more information, see Site Items.

Related concepts
About CSM Item Managers
Configure CSM Remote Support Settings
Define General Settings
Create/Edit a Dashboard
Create a Document Repository
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Select a Startup Portal Site
If you have more than one Site on your Portal, you can choose a Site to first display if the Customer goes
to the main URL: http://MyServer/CherwellPortal.

Customers can also go directly to a particular Portal Site by specifying it as part of the URL:

http://MyServer/CherwellPortal/IT

To select a Startup Portal Site:

1. Open the Site Manager.
2. Right-click Site > Set as Default.
3. Select Close.

Related concepts
Site Manager
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Troubleshoot a Portal Site
Troubleshooting solutions for Portal issues.

Use the following table to troubleshoot Portal issues.

Problem Solution

Cannot access tools to create a
Portal or Site

Check your functionality rights (CSM Administrator > Security > Edit
security groups > User Security Group > Rights tab).

Customer cannot access a
Portal or Site

Check the Customer's functionality rights (CSM Administrator >
Security > Edit security groups > Customer Security Group > Rights
tab).

Customer cannot access data on
a Portal or Site

Check the Customer Security Group's data rights(CSM
Administrator > Security > Edit security groups > Customer Security
Group > Business Objects tab).

Portal does not display correct
form

Verify the forms were designed in the Portal View, not in the Default
View.

Query does not work
Verify the query is set up correctly (not limited to a particular group).
Check security; records might not show up if the Customer does not
have appropriate rights.

Automatic Actions not working Verify automatic Actions are run from the Portal View, not the
Default View.

Customer can edit another
Customer's record Change the record ownership rights.

Windows Account not registered
message Create login credentials for the Customer.
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Configure a Portal
Configure the Portal so customers can log incidents.

Required steps include:

• Configure Portal security rights.

• Configure Client Application settings (URL, timeout, and access to RSS Feeds).

• (Optional) Specify a default domain for the Portal.

• (Optional) Configure login, authentication, and inactivity settings for the Portal (only if you want them
to be different from the Desktop Client).

• Configure anonymous login settings.

• Configure Cherwell credential settings (User/Customer password rules).

• Configure Miscellaneous Browser/Portal Settings.

• Create Portal login credentials (for a Customer).

Note: The majority of the configuration is conducted from the Browser and Mobile Settings
page in CSM Administrator.

Related concepts
Configuring the Browser Client
Configure Portal Security Rights
Configure Cherwell Credential Settings (User/Customer Password Rules)
Create Portal Login Credentials (for a Customer)
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Configure Portal Security Rights
Configure Portal Security Rights before Customers can access the Portal.

Because Portal access must be set differently for Anonymous Browsers as well as logged-in Customers,
there are several places that Portal security rights must be set in CSM Administrator before users and
Customers can access the Portal. The following are all the rights that must be configured for Anonymous
Browser and Portal Customers:

• Application rights

• Browser and Mobile device rights

• Calendar rights

• Chat Service Integration rights (BeyondTrust)

• Command Manager rights

• Dashboard rights

• Document Repository rights

• HTML Page rights

• Knowledge rights

• Record locking rights

• One-Step™ Action rights

• Report rights

• Searches rights

• Security features rights

• Sites rights

• Sites Manager rights

• Users rights

• Visualization rights

• Web Service One-Step Action rights

Related concepts
Security Rights Reference
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Track Portal Use With Google Analytics
You can use Google Analytics to track User selections, such as mouse clicks and taps, in the CSM Portal.

For example, you can track:

• User logins

• Portal Site usage

• Dashboard usage

• Service Catalog, including categories and services, usage

• Searches (from the toolbar Quick Search only)

• Action Link clicks from the home page

User information, search criteria, and other data entered by users is not tracked.

Configuring Google Analytics for the CSM Portal
Prerequisites:

• You must have a Google Analytics account and access to the tracking ID for that account. The
tracking number follows this format: UA-XXXXXX-X. For details, visit the Google Analytics site.

• A basic understanding of Google Analytics and how it tracks and reports site usage will help you
analyze CSM tracking data. Free training videos are available from Google.

To configure Google Analytics for CSM:

1. In the CSM Administrator main window, select the Settings category, and then select the Edit
System Settings task.

2. Select the Advanced page.

3. Select the Google Analytics Tracking ID (Portal) check box, and then add your tracking ID to the
box.

Important: Be sure to enter your tracking ID exactly as it is provided by Google Analytics.

4. Select OK.

Related concepts
Tips for Using Google Analytics with CSM
Configure Global Advanced Settings
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Tips for Using Google Analytics with CSM
Use these tips for using Google Analytics with CSM.

Google Analytics is a powerful tool for tracking, reporting, and analyzing data from web sites. This topic
provides a few tips for using Google Analytics with CSM. For detailed guidance, refer to the Google
Analytics documentation.

Use Views to Segregate Site Data
Depending on your reporting needs, you may choose to create views in Google Analytics for each Portal
Site. This enables you to easily see tracking information specific to each Portal Site.

For example, you can create a view to track data for the Portal IT Site. You can see page views for all
pages for that Site for a specific time period or you can filter the list of pages to specific areas, such as the
Service Catalog.

Tracking User Interactions
Events differ from page views because they provide data on how users interact with your Portal. For
example, you can use Events to learn which Business Objects that Users are selecting when they search
for records from the toolbar Quick Search.
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CSM events include:

• Logins

• Menu selections

• Searches

• Action Links

Events are located in the Behavior area of Google Analytics.

Related concepts
Track Portal Use With Google Analytics
Configure Global Advanced Settings
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OOTB Service Catalog and Cards with Search
Styling

The Cards with Search style offers a modern, easy-to-navigate styling for Action Catalog items.

The Cards with Search style was introduced to the OOTB Service Catalog in CSM 9.2.0.

Implementing Cards with Search
If you upgraded from a version of CSM prior to 9.2.0, you can implement the Cards with Search theme
two ways:

• Edit the existing Service Catalog Widget

• Create a new Widget to act as your Service Catalog

Using Images in Cards with Search
Cards with Search styling supports custom images at the root level, but not the action level. Use the
Groups page of the Widget dialog to link to a custom image.

To display images with root-level Services in the Cards with Search view:

1. In the Groups page of the Service Catalog Widget, select the Display Options button for the top-
level group.

2. Select the Show image next to each item check box.
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3. Select the Field with Image radio button, then select Linked Image from the drop-down menu.
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Related concepts
About the Service Catalog
Example: Enable Anonymous View of Service Catalog
Related tasks
Implement the OOTB Service Catalog (Using an Existing Service Catalog Widget)
Implement the OOTB Service Catalog (by Creating a New Service Catalog Widget)
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Implement the OOTB Service Catalog (Using an
Existing Service Catalog Widget)

Use the Widget Manager to implement the OOTB Service Catalog.

To update an existing Service Catalog to take advantage of the Cards with Search style introduced in the
CSM 9.2.0 OOTB Service Catalog, perform the following steps:

1. From the Widget Manager, right-click Service Catalog > Edit. In the Display page, select Cards
with Search from the Style drop-down list.

2. If necessary, add a description field in each lookup table, then add the field to the associated form.
3. Select the Show Image next to each command check box.

a. Choose Field with Image to select a source for the image. The fields available in the drop-
down list are related to the Action Business Object selected on the Actions page.

b. Choose Expression to build an expression to provide an image.

Note: To use card images on a single-level Service Catalog, ensure the Action Business Object
you choose has a field that stores images.
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Implement the OOTB Service Catalog (by Creating
a New Service Catalog Widget)

Create a new Widget to implement the OOTB Service Catalog.

To create new Service Catalog using the Cards with Search style introduced in the CSM 9.2.0 OOTB
Service Catalog, perform the following steps:

Create a New Service Catalog Widget

1. In CSM Administrator, create a new Blueprint.
2. Open the Widget Manager and create a new Action Catalog Widget.
3. In the Widget dialog, select the Display page. Choose Cards with Search from the Style drop-

down menu.
4. The image on each parent-level card will show up as either custom images or pre-CSM 9.2.0 OOTB

images. In the Groups page, select the Display Options button for the top-level Group.
5. Select the Show image next to each item check box.
6. Select the Field with Image option, then select Linked Image from the drop-down menu.
7. Complete the rest of the necessary fields to complete the Service Catalog Widget.

Map Description Fields

8. Important: The Incident Category and Incident SubCategory lookup tables also need a
description field to take advantage of the Cards with Search theme. The title and description
text in each parent-level card are mapped to the description fields in the Service Major
Business Object. The child-level cards are mapped to description fields in the Incident
Category and Incident SubCategory Lookup Tables.
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If your database does not have a description field in those Lookup Tables, perform these substeps:
a. Add description fields to the Incident Category and Incident SubCategory Lookup Tables.
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b. Add the description field to the associated forms.

Add New Widget to the Portal menu
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9. Open the Site Manager.
10. Right-click the Portal site you wish to add the new Service Catalog Widget to and select Edit.

a. Select the Menu page.
b. Select the Add action down arrow
c. Select Add Action Catalog action...

The Widget Manager opens.
11. Select the new Widget.
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Enable Anonymous View of the Service Catalog
The CSM Portal can be configured to allow Anonymous Users to view the Service Catalog without having
to log in.

Note: Anonymous access requires some initial configuration. See Anonymous Security Group for
specific information.

Enable Anonymous view of the Service Catalog Business Object and then determine the way(s) in which
you prefer to enable the Service Catalog for Anonymous view on the CSM Portal, including configuring
the Service Catalog to show on startup, as a menu item enabled for anonymous access, or as an Action
Catalog Widget enabled for Anonymous access.Enable Anonymous View of the Service Catalog Business Object

1. In CSM Administrator, select Security > Edit security groups.
2. In the Group drop-down list, select the Anonymous Security Group (OOTB: Anonymous

Browser).
3. Select the Business Objects tab.
4. In the Business Object drop-down list, select the Service Catalog Business Object (OOTB:

Service).
5. Select the View check box for the Business Object and all associated fields. You must also grant

View permissions to any additional Business Objects associated with the selected Business Object
(example: Incident Category, Incident SubCategory).

6. Select Save.
7. Enable Anonymous View of any additional Business Objects associated with the Service Catalog

that should be visible to Anonymous users.
8. Configure at least one of the following views for Anonymous users.

Configure the Service Catalog to Show on Startup

1. In CSM Administrator, select Browser and Mobile > Site Manager.
2. Right-click on the site designed as your CSM Portal and select Edit.
3. Select the Display tab.
4. In the Show on startup field, browse for and select Service Catalog.
5. Select OK.
6. Select Save.

Enable Anonymous View of an Action Catalog Widget

An Action Catalog Widget can be used to build a dynamic Service Catalog that is organized by Category
and Service, and is capable of executing Actions. Anonymous users can be enabled to view the Service
Catalog through this Widget when they select a link to the Action Catalog from a Dashboard, Menu link, or
Button.
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1. Open the Widget Manager.
2. Create an Action Catalog Widget or modify an existing Action Catalog Widget (OOTB Example:

Service Catalog) by right-clicking on the existing Widget and selecting Edit.
3. In the General tab, follow the steps to define the General Properties for the Action Catalog Widget.

Select theAllow Anonymous Access to Action Catalog in the Portal check box. When selected,
the Action Catalog is viewable to Anonymous users.

Note: When this check box is cleared, the Action Catalog is not viewable to Anonymous
users even if the associated Business Object(s) are configured to allow Anonymous access.

4. Add a link to the Action Catalog from a Dashboard, Menu link, or Button.

Configure the Service Catalog as a Menu Item with Anonymous Access

1. Enable Anonymous View of an Action Catalog Widget (see above).
2. Follow the steps to add menu items to a site menu bar.

a. If the Action Catalog action already exists in the menu (OOTB: Service Catalog), select it to
view the menu properties. If the Action Catalog action does not already exist in the menu, in
the Add Action drop-down list, select Add Action Catalog action and select the specific
Action Catalog (OOTB: Service Catalog).

b. In the Security Options section, select the Visible drop-down list and select Always or
Anonymous only.
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Configuration Management Page
Use the Browser and Mobile Settings page to access many of the Portal and Browser Client management
and configuration tasks.

Browser and Mobile Settings can be found in CSM Administrator > Browser and Mobile.

Configuration tasks include:

• Site Manager: Use to manage Portal Sites.

• Browser Application Settings: Use to configure URLs, session timeouts, and RSS Feeds.

• HTML Page Manager: Use to manage HTML Pages.

• Document Repository Manager: Use to manage Document Repositories.

• Twitter Account Manager: Use to manage Twitter Accounts.

• Web Services Manager: Use to configure web services used for One-Step™ Actions.

• Edit Mobile Configuration: Use to set defaults (Dashboards, Business Objects, and Actions) for the
entire system or for each Role for Cherwell Mobile™.

• Open Mobile Dashboard Editor: Use to manage Mobile Dashboards specifically designed for use on
mobile devices.
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Add a Portal Login Command to a CSM Portal
Dashboard, Menu, or Form

Use the Portal Login Command as the action for a Button or Link on a CSM Portal Dashboard or Form.
The Portal Login Command can also be added as an action in a CSM Portal Menu.

When the Button, Link, or Menu item is selected in the CSM Portal, the user is prompted with a Login
dialog.

Note: The Portal Login Command is not supported in the CSM Desktop Client, CSM Browser
Client, or One-Step Actions.Add a Portal Login Command to a Dashboard

1. Open CSM Administrator and select Create a New Blueprint.
2. In the Managers menu, select Dashboards > Dashboard Manager.
3. Select the Portal Dashboard you wish to edit and select Edit.
4. In the left pane, select and drag a Button or Link onto the Dashboard.
5. Right-click the Button or Link Label and select Widget properties > Widget properties.

6. Select the Ellipses  to the right of the Action field.
7. In the left pane, select Commands.
8. In the middle pane, select System > Other.
9. In the right pane, select Portal Login.

10. Select OK and then OK again.
11. Make any additional changes to the control (Example: change displayed text from "Button" to

"Login").
12. Save the changes.

Add a Portal Login Command to a Menu

1. Open CSM Administrator and select Site Manager.
2. Right-click IT and select Edit.
3. In the left pane, select Menu.
4. In the middle pane, select Add Action > Add Command Action.
5. In the left pane, select System > Other.
6. In the right pane, select Portal Login.
7. Select OK.
8. Select Save.
9. Close the Site Manager.
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Add a Portal Login Command to a Form

1. Open CSM Administrator and select Create a New Blueprint.
2. In the Current view drop-down list, select Portal Default.
3. Select a Business Object (Example: Knowledge Article) and then select Edit form.
4. In the Controls pane, select and drag a Button or Link Label onto the form.
5. Right-click the Button or Link Label and select Control properties.
6. Select the Ellipses to the right of the Action field.
7. In the left pane, select Commands.
8. In the middle pane, select System > Other.
9. In the right pane, select Portal Login.

10. Select OK and then OK again.
11. Make any additional changes to the control (Example: change displayed text from "Button" to

"Login").
12. Save the changes.
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CSM Web Applications and Accessibility
To support Users with disabilities, many Browser Client and CSM Portal features are accessible using a
keyboard and screen reader.

For best results with keyboard navigation, use the Chrome web browser.

Good to Know

• While CSM OOTB content addresses specific accessibility requirements, it is the responsibility of
each administrator and developer to ensure customized content is configured and designed to meet
accessibility requirements.

• Cherwell® strives to ensure that its applications are accessible to users with visual and auditory
impairments. There are cases, however, where accessibility may be limited. For details about CSM
accessibility, see the Accessibility Conformance Report. You must be logged in to the
Documentation Portal with customer or partner credentials to view this content.

• The CSM Web Applications have been tested with the JAWS® (Job Access With Speech) for
Windows® screen reader. Other screen readers may provide full or partial capabilities with CSM.
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CSM Web Applications Keyboard Accessibility
Keyboard commands enabled users to navigate the Browser Client and CSM Portal without using a
mouse.

General Keyboard Commands

Key Action

Tab Move forward from one link or form control to the
next.

SHIFT+Tab Move backward through one link or form control.

Enter Activate the selected link or control.

Spacebar Select a record or option.

CTRL+Spacebar Clear the current selection. For multi-selections,
clears or selects while persisting previous selections.

Page Up and Page Down Scroll the page up or down.

Arrows Scroll through links and controls on a page.

ALT+Arrow-left Move to the previous page.

ALT+Arrow-right Move to the next page.

Form Keyboard Commands
Use the following keyboard commands when focus is on a record form or an element on that form.

Key Action

Enter Selects the highlighted item.

Home Selects the first item in a drop-down.

End Selects the last item in a drop-down.

Spacebar Selects a highlighted radio button or check box.

ALT+down arrow Opens a pop-up or a drop-down.

Esc or ALT+up arrow Closes a pop-up or drop-down.

Grid Toolbar and Header Keyboard Commands
Use the following keyboard commands when focus is on the Grid column header.

Key Action

Enter Sort the column.
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Key Action

Spacebar Select and clear items.

ALT+Down arrow Opens the filter menu.

Esc Closes the filter menu.

ALT+M Toggles the Multi-column Sort option.

Grid Item List Commands
Use the following commands when focus is on the Grid item list.

Key Action

ALT+W Applies focus to the Grid item list.

Enter Expand and collapse cells.

Space Select and clear cells.

CTRL+Spacebar Select cells, but persist previously selected cells.

Page Up and Page Down Navigate through multiple Grid pages.
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Multi-Tab Browsing Support
The Browser Client and Customer Portal allow you to operate in multiple web browser tabs, which
enables you to work on multiple pages within CSM. This allows technicians, system administrators, and
customers to work more efficiently.

Multi-tab browsing allows you to:

• Log in via the first tab and then load CSM in additional tabs without needing to log in again or
consume additional licenses.

• Work with multiple CSM features at the same time. For example, a technician might log an Incident
in one tab and view their default Dashboard in another.

• Use the Culture Selector to select a language and work in the tabs independently within the same
session. If a User has multiple tabs open in different languages and the session expires or the User
manually logs out, the User is logged out of all tabs. When the User logs back in to a tab, the
language for that tab is the last language that was selected before the User logged out.

Culture support for multi-tab browsing support works slightly differently in the CSM Browser Client
than the CSM Portal:

◦ CSM Browser Client: Multi-tab browsing support allows you to open tabs in multiple languages
and work in the tabs within the same session. If you have multiple tabs open and select a new
culture, only the tab you are selecting that culture from refreshes to display the newly chosen
culture. The other tabs remain in the previous culture.

◦ CSM Portal: Multi-tab browsing support allows you to work in multiple tabs of the same culture
within the same session. If you have multiple tabs open and select a new culture, all tabs
refresh to display the newly chosen culture. You can't have multiple tabs with different cultures
open.

Multiple features use a unique tab display name, which allows Users to easily identify what they are
working in each tab. Features that support tab names include:

• Forms: Major Business Objects (Incident, Problem, etc.) use the Public ID field to populate the tab
name. The Public ID is defined in the Business Object Properties window.

• Quick Search: Quick Search results use the phrase Quick Search Results and Business Object
Quick Search Results use the phrase <Business Object> Search Results in the tab name.

• Saved Searches: Searches use the phrase <Search Name> Search Results in the tab name.
Search names are defined using the Search Manager.

• Tools: Tool drop-down items (Contact Manager, Table Management, and CMDB) use the phrase
<Tool Name> Search Results to populate the tab name.

• Reports: Reports use the phrase <Report Name> in the tab name. Report names are defined using
the Report Manager.

• Dashboards: Dashboards (Global IT, Portal pages, etc.) use the phrase <Dashboard Name> as the
tab name. Dashboard names are defined in the Dashboard Properties window.
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• Calendars: Calendars use the phrase <Calendar Name> as the tab name. Calendar names are
defined in the Calendar properties window.

• Quick View: Quick View selections use the Public ID field to populate the tab name. The Public ID
is defined in the Business Object Properties window.

• Go to Item Functionality: Go To Item selections use the Public ID field to populate the tab name.
The Public ID is defined in the Business Object Properties window.

• Startup Items: Portal Site startup items use the phrase <Startup Item Name> as the tab name. The
startup item name is defined on the Display page of the Site Editor.

• Service Catalog: The Service Catalog in the Customer Portal uses the phrase <Service Catalog>
as the tab name. The tab name is defined in the Widget Properties window of the Service Catalog
Widget.

• HTML Pages: HTML Pages use the Name field to populate the tab name. The Name is defined in
the HTML Page Options window of the HTML Editor.

• Document Repository: The Documentation Repository in the Customer Portal uses the phrase
Document Repository as the tab name.

Multi-tab browsing support is powered by a Command called New Window, which can be found in the
Command Manager.
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Open a New Tab in the Browser Client
Use multi-tab browsing support to open a new tab in the Browser Client.

1. Open a web browser.
2. Navigate to the Browser Client (http://MyServer/CherwellClient).
3. Log in using the appropriate credentials.
4. Click the User Information section of the Application Bar and select New Browser Window.

A browser window opens in a new tab and displays the default Dashboard.

Note: If you open a browser window in a new tab outside of CSM, navigate to the configured
URL. Do not copy the URL from the address bar in one tab and use it in another.

5. (Optional) Open up to four additional tabs.
When the session expires or the User manually logs out, the User is logged out of all tabs. To log
back in, the User needs to open new tabs and close the old tabs.
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Open a New Tab in the Portal
Use multi-tab browsing support to open a new tab in the Portal.

1. Open a web browser.
2. Navigate to the Portal (http://MyServer/CherwellPortal/SiteName).
3. Log in using the appropriate credentials.
4. Click the User Information section of the Application Bar and select New Browser Window.

A browser window opens in a new tab and displays the default home page.

Note: If you open a browser window in a new tab outside of CSM, navigate to the configured
URL. Do not copy the URL from the address bar in one tab and use it in another.

5. (Optional) Open up to four additional tabs.
When the session expires or the User manually logs out, the User is logged out of all tabs. To log
back in, the User needs to open new tabs and close the old tabs.
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Add a New Window Command to the Browser
Client and Customer Portal

Use the New Window Command to add multi-tab browsing support to additional areas of the Browser
Client and Customer Portal.

When the Command is implemented, you can navigate to CSM in additional tabs without needing to log in
again or consume additional licenses (the new window opens the main Dashboard by default). Consider
creating a One-Step using the Execute a Command Action to add the functionality to even more areas of
your system.

You can add the Command to multiple areas of the Browser Client, including Forms and Dashboards.

For example:

• Add the Command (via a One-Step) to a Knowledge Article form using a Link Label Control so
Users can easily navigate to a new window while keeping Knowledge Article information open.

• Add the Command (via a One-Step) to the Global IT Dashboard so Users can easily navigate to a
record while simultaneously viewing their metrics.

You can also add the Command to areas of the Portal, including the menu bar and Forms.

For example:

• Add the Command (via a One-Step) to the menu bar so Users can easily navigate to a new window
from anywhere in the Portal.

• Add the Command (via a One-Step) to the read-only Knowledge Article form using a Link Label
Control so Customers can easily navigate to a new window while keeping Knowledge Article
information open.

Note: For a full list of areas where you can add Commands in CSM, refer to the One-Step
documentation.
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CSM Administrator
Cherwell® Service Management Administrator (CSM Administrator) is CSM's administrative tool, which is
used to configure, manage, secure, integrate, and automate your CSM system.
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About CSM Administrator
Use CSM Administrator features to configure and manage your CSM system.

Administrative features include:

• Automation Processes: Pause/resume the Automation Process Service, enable/disable
Automation Processes, manage automation rules, and define Business Hours.

• Blueprints: Configure and manage system definitions (example: Business Objects, Fields, Forms,
Grids, etc.) and CSM Items (example: Dashboards, Saved Searches, etc.), and to access definition-
driven tools/functionality (example: Directory Service settings, Schemas, etc.).

• Browser and Mobile Settings: Edit Browser and Mobile options (HTML Page Manager, Twitter
Account Manager, etc.).

• Database: Import and export data, and perform system maintenance.

• E-mail and Event Monitoring: Pause/resume the E-mail and Event Monitor Service, configure
Outlook® Integration, and configure/manage e-mail accounts and settings.

• Globalization: Translate text, referred to as "strings," into one or more single-byte languages so
Users can use a single CSM installation to view the same data in multiple languages.

• mApp Solutions: Transfer bundles of CSM functionality between CSM systems.

• Performance: Run the Health Check tool to monitor and optimize system configurations that impact
performance.

• Scheduling: Pause/resume the Scheduler Service and manage scheduled items.

• Web Applications: Build/manage Customer Portals, manage Browser Client settings, and manage
browser tools.

• Security: Use Security Groups, Roles, Teams/Workgroups, and User/Customer profiles to control
people, functionality, data, environment, and sharing.

• Settings: Configure Global System settings, such as General settings (example: Search, display,
etc.), User Interface settings (example: Task Pane, toolbar, etc.), Table Management settings, etc.

• Trusted Agents: Connect to the Trusted Agents Hub and create Trusted Agents service groups.
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Log in to the CSM Desktop Client or CSM
Administrator

To log in to the CSM Desktop Client:

1. Double-click the Cherwell Service Management icon  or CSM Administrator icon  on the
desktop, or click Start>All Programs>Cherwell Service Management or Cherwell Administrator.

Note: If the Automatically Use Connection Without Asking check box was previously
selected or if the system administrator already set up a permanent database connection, the
database connection window will not open.

2. Select a database connection:

Note: Typically, Users connect using an Application Server (3-tier connection), identified by

the Application Server icon .

a. Click the All Users tab to view database connections available to All Users or the User tab to
view database connections available to only to the User logging in.

b. Click a database connection.

Note: To create a database connection, click Add to launch the Connection Wizard. To modify
an existing database connection, click the database connection, then click Edit. To delete an
existing database connection, click the database connection, then click Delete.

c. Select the Automatically Use Connection Without Asking check box to automatically use
this database connection each time CSM is launched. Afterward, the prompt is no longer
available to select a connection.

d. Click OK.
3. Provide the CSM login credentials:

a. User ID: Provide the CSM login ID (this could be domain name/network Username or just
Username).

b. Password: Provide the CSM password. Passwords are case-sensitive.

Tip: By default, there is a User ID called CSDAdmin with a password of CSDAdmin in the
Demo and Starter databases.

c. Automatically Login Without Asking: Select this check box to automatically use the above
information at the next log in. This avoids a login prompt.

d. Click OK.

e. If a User is assigned to more than one CSM Role (and have not previously selected the
Automatically Use Selected Role check box), the Choose Role window opens.
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4. Select the login Role for the session:
a. Click the appropriate Role.

b. Always Use Selected Role: Select this check box to automatically use the selected Role at the
next log in. This avoids the Role prompt.
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Tour the CSM Administrator User Interface
The CSM Administrator User Interface (UI) is dynamic and changes to show helpful and appropriate
options for the administrative tasks being performed. Generally, the Main window shows the following
items:

• Menu bar: Access general administrative tasks.

• Task Pane: Access common administrative tasks, and administrative tasks organized by category.

• Main Pane: View data and to perform the majority of your administrative tasks.

When you first log in to CSM Administrator, the Main Pane displays a Getting Started page to help initially
configure the system. After initial configuration, the Main Pane automatically displays the Home page

, which lists the administrative task categories.

When working in a Blueprint, the entire UI (menu bar, Task Pane, and Main Pane) dramatically changes to
accommodate the Blueprint Editor, which is required to perform Blueprint operations.

Note: For more information about the Blueprints and the Blueprint Editor, see the Blueprint
documentation.

The following figure shows two sample Main windows:

• The Home view that appears when logging in to CSM Administrator (or click the Home button )
and includes categories of functionality.
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• The Blueprint Editor, which appears when creating a Blueprint. Notice that the Menu bar and Task
Pane change to accommodate whatever item is active in the Main Pane. A toolbar shows when the
Blueprint Editor is active.
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CSM Administrator Getting Started Page
By default, CSM Administrator opens a Getting Started page to help set up the CSM system.

Note: Also access the Getting Started page by selecting Help>Go to Getting Started Page.
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To use the Getting Started page, click the task to complete. Available options include:

• Organization Info: Edit the name, the logo, and a theme that represents the organization.

• E-mail: Select e-mail addresses to be used in Automation Processes and for various notifications.
Edit the e-mail signature in this location.

• Active Directory/LDAP: Edit the LDAP settings used to access information in a Directory Service
(a directory stored on a server).

• Escalations: Select which escalations and notification Automation Processes to enable or disable.

After you complete a task, a green check mark appears over the number of the task. When finished
setting up the CSM system and the Getting Started page is no longer needed, clear the check box at the
bottom of the window.

Note: The Menu bar is limited to File and Help and no toolbar exists. All options are accessed in
the panes.
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Desktop Scaling and CSM Administrator
Display settings for Microsoft Windows might affect the user experience of CSM Administrator.

CSM Administrator does not support:

• Microsoft Windows scaling levels above 125% (120 DPI).

For the best user experience when using CSM Administrator, Cherwell recommends the standard
desktop scaling of 100% (96 DPI). Configuring an increased display scaling is not recommended.

• Display configurations with different Microsoft Windows scaling settings on different monitors.

In such situations, you might experience display issues when moving CSM Administrator windows
from one monitor to another. Consequently, Cherwell recommends using the same Microsoft
Windows scaling settings on all monitors.
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